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Important Notice 
© 2010-2016 MyHeritage. All Rights Reserved. 

All intellectual property rights in this publication are owned by MyHeritage and 

protected by United States copyright laws, other applicable copyright laws and 

international treaty provisions. MyHeritage retains all rights not expressly 

granted. No part of this publication may be reproduced in any form whatsoever or 

used to make any derivative work without prior written approval by MyHeritage. 

No representation of warranties for fitness for any purpose other than what is 

specifically stated in this guide is made either by Family Tree Builder or by its 

agents. 

MyHeritage reserves the right to revise this publication, and/or make 

improvements or changes in the product(s) and/or the program(s) described in 

this documentation at any time without prior notice. 

Any software on removable media described in this publication is furnished 

under a license agreement included with the product as a separate document. If 

you are unable to locate a copy, please contact MyHeritage and a copy will be 

forwarded to you. 

MyHeritage is a registered trademark. 

Other product and company names mentioned herein may be the trademarks of 

their respective owners. 
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About This Guide 
This user guide is intended for first-time and experienced users of 

MyHeritage Family Tree Builder. It will familiarize you with its 

interface, describe its workflow and can serve as a reference for all 

the options that appear in its windows, menu bar and toolbar. 

This guide contains the following chapters: 

 Chapter 1, Introduction, introduces the features and benefits of using Family 

Tree Builder to build your family tree, describes genealogy in general and 

provides a guideline for doing your research. 

 Chapter 2, Quick Tour, provides a quick tour through the various options in 

the Family Tree Builder interface. 

 Chapter 3, Getting Started, suggests a workflow for getting started with 

Family Tree Builder and describes how to start adding people to your family 

tree.  

 Chapter 4, Premium Membership, introduces Family Tree Builder’s Premium 

Membership features, and describes their benefits and how to obtain 

membership. 

 Chapter 5, Handling Photos and Other Media, describes how to add, view, 

annotate and automatically mark faces in photos and how to use documents 

and video/audio files to enrich your family tree. 

 Chapter 6, Smart Matches, describes the option for finding out if any of the 

people in your family tree appear in family trees that have been synced by 

other people anywhere in the world using MyHeritage.com. 

 Chapter 7, Maps, describes how to manage place-related information for your 

project, as well as how to view this information on an interactive map. 

 Chapter 8, Research Tools, describes how to add and search for genealogical 

information for the people in your family tree, based on information found in 

MyHeritage’s powerful SuperSearch engine. 

 Chapter 9, Charts, describes the types of charts that Family Tree Builder 

provides and how to create and customize them. 
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 Chapter 10, Reports, describes the variety of reports that Family Tree Builder 

provides. 

 Chapter 11, Syncing Your Family Tree, describes how to synchronize (sync) 

your family tree using Family Tree Builder to MyHeritage.com, so that it is 

available for viewing on the Web to anyone that you invite. 

 Chapter 12, Languages and Translation, describes the various language and 

translation features that are provided by Family Tree Builder. 

 Chapter 13, Advanced Tools, describes additional options for configuring the 

behavior of your family tree. 
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Glossary 
The following describes some of the terms used in Family Tree Builder.  

Term Description 

GEDCOM An acronym for GEnealogical Data COMmunication, GEDCOM is 

a specification for exchanging genealogical data between 

different genealogy software. More information is provided in 

GEDCOM and Family Tree Builder. 

Genealogy The tracing of one’s roots. More information is provided in 

What is Genealogy? 

Media or Photo The term photo and media may be used interchangeably in this 

guide. Media may refer to a photo, document file or 

video/audio file. 

Personal Photo Family Tree Builder enables you to assign a single picture to 

each person in order to represent them wherever possible, 

such as in a report or thumbnail that is displayed when you 

hover over a person in a list, or when they are shown in Tree 

View. Typically, this photo should be a portrait of their face. 

You can mark the face of a person in a photo and use that 

marked area as the personal photo.  

Home Person Each family tree has one person, called the Home Person, to 

whom quick access is provided. This person is located in the 

center of the Tree View. 

A variety of options are provided to see the relationship of 

people in the family tree to this Home Person.  

 

http://en.wikipedia.org/wiki/Specification
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Contacting Us 
 

Technical Support   support@myheritage.com 

Sales   sales@myheritage.com 

Marketing   marketing@myheritage.com 

Business Development   bd@myheritage.com 

Public Relations   pr@myheritage.com 

Affiliate Program   affiliate@myheritage.com 
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Introduction 
About This Chapter: 

This chapter introduces the features and benefits of using Family Tree Builder to 

build your family tree, describes genealogy in general and provides a guideline 

for doing your research. It contains the following sections: 

 Introducing Family Tree Builder introduces the benefits of using Family Tree 

Builder to build and synchronize (sync) your family tree to your online family 

site. 

 What is Genealogy? describes the definitions and origins of genealogy. 

 Distributing Your Family Tree describes how to use Family Tree Builder and 

MyHeritage.com to build and sync your family tree to your online family site. 

 Doing Your Research provides a guideline for the process to gather 

information to fill your family tree. 
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Introducing Family Tree Builder 

Creating a family tree was once only possible using a pen and paper and was very 

difficult to maintain. Family Tree Builder enables you to create family trees easily 

and beautifully. In handwritten family trees, it was a major task to add a newly 

discovered family branch. Using Family Tree Builder, your computer helps you do 

the research and immediately produces a variety of printouts, charts and reports. 

These can be easily distributed to anyone and can be viewed on the Internet in a 

simple and intuitive interface. 

Documenting your history for future generations is like writing a detective story, 

where you are both the author and the hero. You are trying to unravel mysteries of 

the past, sometimes starting with very little information. You put together a 

puzzle and unravel the previously undiscovered history of your family. 

Gathering, designing and building your family tree is not just about collecting 

names and dry facts. We recommend that you try to bring the family tree to life by 

interviewing as many family members as possible and gathering all the photos, 

documents and video/audio files that you can. Compiling and saving all your 

information opens up more questions and typically encourages relatives to share 

previously unknown facts. This is why genealogy is appealing to tens of millions 

of people. 

In addition, Family Tree Builder enables you to sync your family tree to an online 

family site on MyHeritage.com. 

A MyHeritage family site provides an ideal location for showcasing your family 

tree. Here are some of the benefits of owning a family site: 

 Free: Family sites are free using MyHeritage. There are Premium subscription 

plans for huge family trees or photo collections, but these are optional. 

 Sharing: Sharing your family tree with family members and friends in a 

beautiful, interactive display will extend your personal connections and bring 

you closer to all involved. 

 Functionality: Family Tree Builder provides your family site with a rich variety 

of features and functions that were previously unavailable or that had only 

been available using expensive genealogy applications. 
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 Privacy: Your data is only visible to you and to the people that you invite to 

view it. Information regarding deceased ancestors can be made available to 

guests so that relatives can find you on the Internet, but this is optional. 

 Backup: Your data is automatically backed up online each time you 

synchronize it, and it can be restored to an earlier version at any time. This 

protects your family tree and photos from any catastrophe or computer 

failure. 
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What is Genealogy? 

Definition of Genealogy 

ge·ne·al·o·gy (jē-nē-ŏl’ә-jē) 

noun. pl. ge·ne·al·o·gies  

1 Lineage or pedigree.  

2 The study or investigation of ancestry and family histories. 

3 A record or table of the descent of a person, family or group from an ancestor 

or ancestors; a family tree. 

The Rise of Genealogy 

Genealogy, or the tracing of one's roots, has enjoyed a massive worldwide surge 

in popularity over the past few years. In recognition of this, the United States 

Congress has officially designated October as National Family History Month by 

unanimously passing a Senate resolution in 2001. 

"Experts say that in the United States, genealogy is now the second most popular 

hobby next to gardening,"1 said US Senator Orrin Hatch, who co-sponsored the 

resolution, along with 83 others. 

"It is only natural that we want to find out more about our ancestors, and what 

better way to bring families closer together than by discovering more about the 

story of your own family?" 

This resolution celebrates the fact that millions of people are actively searching 

for information about their ancestors and also encourages others to begin their 

search. 

 

 

1 Source: United States Senate Committee on the Judiciary, June 26, 2003. 

http://judiciary.senate.gov/member_statement.cfm?id=834&wit_id=51  
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In the eyes of many, genealogy is educational and deeply personal. It brings 

people closer to their roots and closer to each other; it strengthens bonds inside 

the family as well as between families, and it bridges gaps between generations, 

cultures and traditions. 

Why has genealogy boomed in recent years? This is to a great extent due to the 

proliferation of the Internet, which has proven to be an invaluable aid in 

genealogy. The Internet allows you to search archives, libraries and databases 

from your home, to communicate easily with people across the globe and to share 

information. As more and more people go online, and an increasing number of 

databases become accessible online, genealogy is dramatically gaining 

popularity. It is no wonder, therefore, that the Internet is home to hundreds of 

thousands of personal genealogy websites, and searching for genealogy in 

Google yields over 33 Million hits2. 

 

 

2 Source: Google, June 18, 2007. There are also several million additional hits for translations of 

genealogy into other languages, such as 'genealogie' (11,900,000 hits) 
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Distributing Your Family Tree 
Any member of MyHeritage can build a family tree. This family tree is built and 

stored on your computer until you decide to synchronize (sync) it to your online 

family site. After syncing, this site is available to all your family, friends and 

anyone else you invite. Synchronizing your family tree was called publishing in 

Family Tree Builder prior to version 7. As of version 7, any changes made in the 

online site are synchronized back to your computer. Hence, the term synchronize. 

You have the option of defining multiple projects. Each project contains one 

family tree, and each family tree describes numerous people. You can sync the 

entire family tree to only one family site, 

You can create a family site that is private and secure, or make it public and share 

it with the rest of the world. You are in complete control. Photos uploaded to your 

family site can utilize our face recognition technology and allows you and your 

family to quickly identify people in your photos. 

NOTE A site can contain multiple family trees. 
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The following shows the flow for building and syncing your family site in order to 

make it available for viewing by whomever you choose to invite: 

 

4 Build your family tree on your computer using Family Tree Builder. This 

process includes a variety of tasks described in this guide, such as: entering 

information about people, defining relationships, adding photos, marking 

faces, designing the look and feel of reports and charts and so on. 

5 Synchronize the family tree to your family site on MyHeritage.com. 

6 Invite family members to view the family site. 

You and invited family members can now visit the family site on the web, as 

well as using tablets and smartphones. Note that invited family members can 

modify information only if you allow it. 
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Doing Your Research 

The following advice may help you through the process of tracing your ancestry 

and family history. 

Choosing Your Goal 

Before you begin your family history research, it is a good idea to focus on what 

you want to achieve. Do you wish to pursue the paternal (male) line with its 

continuity of surname, or the maternal (female) line, or perhaps even verify a 

family legend? You may find that the decision is made for you, if the research 

proves difficult. If, however, you decide to pursue more than one line, be sure to 

keep your research organized and file the results separately to avoid confusion. 

Family History Begins at Home 

The golden rule in family history research is to try to work backwards from what 

you already know. As such, family history truly does begin at home and you may 

be surprised at how much you already know or have access to within your own 

extended family. It is not necessary to have a lot of detail to start, but it makes 

sense to log whatever information is readily available and to seek out further 

details from relatives. 

Best Starting Point: You 

Begin by recording your own details, such as: date and place of birth, marriage, 

spouse, children, and then the details of your parents, grandparents and so on, 

as you recall them. 
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Next Step: Your Relatives 

Information from relatives can increase your knowledge of the family, but a 

patient and tactful approach is required. Family anecdotes can become distorted 

with the passage of time, but should still be noted for later verification. Be sure to 

interview your relatives, especially the older ones, as they may have information 

about your ancestors that you will not find in any database. Write everything 

down for future reference. Getting in touch with your relatives may often prove to 

be a rewarding and enriching experience. 

Achieving Success 

How successful you are in researching your family history is determined by a 

number of factors, many of which are beyond your control. Your success can 

depend on the survival of records, how common your surname was, your family's 

social status and level of literacy and the possibility of transcription errors. 

However, success can also depend on your own tenacity, keeping an open mind 

and not taking anything for granted, being methodical, approaching a problem 

from more than one angle and corroborating any evidence you may find. In spite 

of the occasional brick wall, you may find that the genealogy hunt itself is almost 

as exciting as the thrill of discovery. 

Documents and Photographs 

Most families possess old documents or photographs, which can be of use to the 

family historian. Examples of documents you might find, which can significantly 

aid your research, are: birth, marriage and death certificates; obituaries; family 

Bibles; school and university graduation certificates and awards; military service 

records; business papers; immigration and travel documents; diaries; address 

books; birthday books; letters; postcards; newspaper cuttings and memoirs – in 

short, anything! 

Go through old family photographs and see how many people you recognize. 

Show the photos to older relatives to help jog their memory. Try to ask them to 

identify as many faces as possible, so that this information is preserved. 

Any information that can be gathered from within the family can help establish a 

foundation on which to build your family history. 
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Read Up on Family History: Join a Society 

Libraries and bookshops stock a range of material on family history. You may 

want to consider joining a family history society in your area. For a small annual 

fee you will receive all the benefits of membership (magazine, research facilities, 

well-stocked libraries, research services and ready advice) and meet like-minded 

individuals. Consider also joining a society in the area in which you are 

conducting research. You can also turn to the Internet for an active genealogy 

community. You can find forums in which to post questions, read answers, hear 

about others' successes and failures and find additional resources. 

Pick the Right Tools 

The family tree is the nucleus of any family history research and putting it 

together is often an exciting journey that can play out like a detective story. 

Maintaining the family tree information that you store using paper records may 

quickly get out of hand, so use genealogy software to help you keep track of the 

various individuals in your family tree and the relationships between them. Family 

Tree Builder is a good choice for this. It is free, supports multiple languages, 

offers a very easy interface to enter and review data, and allows you to organize 

your entire photo collection according to the relatives pictured. 

SuperSearch is MyHeritage’s dedicated genealogy search engine, which provides 

the best place to start your research. It is also well integrated into Family Tree 

Builder, making it easy to find search results about your family.  

Share and Enjoy 

Once you have put together your family tree, collected some interesting old 

photos of your family and gathered family legends, stories and anecdotes, do not 

keep this treasure to yourself! Synchronize it to your online family site on 

MyHeritage.com for your family and friends to enjoy. They will be able to 

contribute more to your research and perhaps help you fill in missing information. 

Distant relatives can also find you this way so that long-lost cousins can reunite 

as a result of your efforts. Use MyHeritage.com to create a family site and share 

your family tree and family history gems, including photos, documents, stories, 

historical records and more. Invite your relatives to become members in your site 

and open some areas of your site to guests. Share and enjoy! 

 

http://www.myheritage.com/FP/Company/family-tree-builder.php
http://www.myheritage.com/FP/Company/family-tree-builder.php
http://www.myheritage.com/FP/Company/family-pages.php
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Quick Tour 
About This Chapter: 

This chapter provides a quick tour through the various tools in the Family Tree 

Builder interface. It contains the following sections: 

 Family Tree Builder Main Window describes the areas of the main window 

and what they do. 

 People List Panel describes how Family Tree Builder displays the people in 

the family tree and the tools associated with that display.  

 Tree View describes how to view and manage people in your family tree. This 

is the main view of Family Tree Builder. 

 Photos View describes how to view, search for and add photos to people in 

your family tree. 

 Smart Matches View describes how to match people in your family tree to 

people in other trees in MyHeritage.com using Smart Matches. 

 Charts View describes how you can display the members of your family tree in 

various charts. 

 Reports View describes how you can create various reports for the members 

of your family tree. 

 Maps View describes how to map your entire family tree, any portion of it or 

just one individual on an interactive world map. 

 Menu Bar describes the functions in the menu bar. 

 Toolbar describes the functions in the toolbar. 
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Family Tree Builder Main Window 
 

 

The Family Tree Builder main window is composed of the following: 

 Menu Bar: Provides access to a variety of Family Tree Builder functions (see 

Menu Bar). 

 Toolbar: Provides quick access to the most frequently used Family Tree 

Builder functions (see Toolbar). 

 People List Panel: Lists all the people that you have already defined in your 

tree in Family Tree Builder and enables easy access to them. The panel can 

also be displayed or hidden. 

Work Area 

Toolbar 

Menu Bar 

People List  

Panel 

Status Bar  

User Email Address 
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 Work Area: The information and functionality of the Work Area changes 

according to the selected view, as follows: 

▪   Tree View (see Tree View) 

▪   Photos View (see Photos View) 

▪  Smart Matches View (see Smart Matches View) 

▪   Charts View (see Charts View) 

▪  Reports View (see Reports View) 

▪  Maps View (see Maps View) 

 Status Bar: indicates how many people, families and photos have been 

added to this family tree, plus various other status messages. 

The Family Tree Builder main window shows the user’s email address in the 

window title bar. This email address is the one used to register with MyHeritage. 
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People List Panel 
The People List Panel displays all the people that you have defined in your 

project, enables quick access to any person and performs almost all the essential 

Family Tree Builder functions on that person. 

You can choose to minimize the People List Panel. To minimize the panel, click 

the  icon in the upper-right corner. 

 

NOTE In Matches View and Maps View, the Family Tree Panel is minimized by 

default. 

To display a minimized panel click the  icon. 
 

You can double-click any person in the People List Panel to display that person’s 

information, or right-click any person to display a menu of options (see Right-click 

Menu in the People List). 
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Quick Find 

The Quick Find area appears at the top of the panel and enables you to quickly 

find a person by entering his/her first or last name. As you type letters into the 

First Name or the Last Name field, the people whose name starts with the same 

letters will appear at the top of the list. 

Hovering with the mouse over the name of a person in this list displays the 

person’s information and photo, if added. An example is shown below: 
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People List 

In the People List display, each row describes a single person.  

Double-click a person in the list to display the relevant information of this person 

according to the selected view. For example, while in Tree View, you will see their 

Tree View card on the right (see Tree View). 
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The following describes the columns in this list, which provide a different type of 

information about each person. 

NOTE Use the horizontal scroll bar to scroll through the columns. 

Use the vertical scroll bar to scroll through the list. 
 

 Icon: The icon in each row indicates whether the person is male or female, 

living or deceased (deceased individuals are grayed out) and whether there 

are photos for that person or not. 

   

Male Female Living People  

(colored icon) 

   

Deceased People 

(gray icon) 

With Photos  

(with a picture frame 

behind their head) 

Without Photos  

(no picture frame) 

 ID: A unique ID is automatically assigned to each person that you add to 

Family Tree Builder in the order that you added them. You can choose to 

display or hide this ID using the Options window. 

 First Name/Last Name: When searching for a person, it is easiest to find them 

by typing in all or part of their name in the Quick Find area at the top of the 

People List. 

 Birth Date/Death Date: These dates only appear for the people for whom you 

have entered birth and/or death dates. 

 Relation: Specifies the distance of the relationship between this person and 

the Home Person. The number 1 specifies that this person is immediate 

family, such as father, mother, spouse, son or daughter. The number 2 

specifies a more distant relationship, with two steps between this person and 

the Home Person, such as grandmother or grandchild. This number will go as 

high as your family tree is large. 

 Last modified: Specifies the most recent date where information was added 

or modified for this person. 
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Finding People in the People List 

A number of options are provided for finding people in the people list, as follows: 

 Quick Find 

 Sorting the List 

 Searching for People 

 Filtering the List 

 Using the Find and Replace Function 

Quick Find 

For details about how to use the Quick Find area, see Quick Find. 

Sorting the List 

By default, the list is in the order that people were entered into Family Tree 

Builder. To resort the list, simply click the title of the column by which the list 

should be sorted. For example, the following shows that clicking the Last Name 

column title sorts the People List by their last name:  

 

Click here to sort the list 
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Searching for People 

To search for people in the People List: 

1 Click the Search icon  to display the following window: 

 

2 You can enter all or part of the First and/or Last Name of the people to be 

included in the search results. You can select which option to use for the First 

and Last name, including the two options that look for names that sound like 

the name you enter. 

3 If you want to search for all people based on a specific fact, enter the type of 

the fact and then select the condition and the parameters of the condition, 

including the date, place description and cause of death. 

4 You can choose the gender of the people to be included in the search result. 
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5 To save this search for future use, click the Save button. 

6 Click the Search button to filter the People List. 

NOTE You can save this search condition by clicking the Save button and 

providing a name for the search. Later, you can click the Manage 

Saved Searches button in the window shown above to display 

another window in which you can rename, delete or select a Saved 

Search. 

 

Advanced Search 

If you would like to add more specific details to a search, click the Advanced tab, 

as shown below, and fill out the information in the same manner: 

 



Quick Tour 

Family Tree Builder User’s Guide 
 

- 38 - 

Filtering the List 

A dropdown menu appears above the People List. It enables you to specify 

whether you would like to view all the people in the list by selecting All People, or 

a list of certain people by implementing a Saved Search, which filters lists 

according to your definitions. The following shows a Saved Search that was 

defined to show all people for whom a cause of death was entered: 
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Using the Find and Replace Function 

The Find and Replace function enables you to search for a text string in your data 

and replace it with other text. This feature is useful when you determine that a 

name is misspelled that affects several individuals. Using this feature, you can 

search for incorrect name and then change all the people with that incorrectly 

spelled name to the correct spelling. 

You can use this function to affect text, such as names of people and places. 

To find and replace text: 

1 In the Edit menu, select the Find and Replace option. The following window is 

displayed: 

 

2 In the Find field, enter the text you want to find. 

3 In the Replace with field, enter the replacement text. 
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4 In the Find in field, click the Select button to open the following window in 

which you specify the scope for the search operation: 

 

This window lists the types of information that will be searched. For example, 

you can select first names, last names, places, notes, citations and so on. All 

information types are selected by default. Simply check the checkbox(es) to 

be included in the search operation and then click OK. 

5 In the Find options dropdown list, select one of the following options: 

▪ Match entire text: When you select this option, all text in the text strings 

being searched must match that specified in the Find field.  
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▪ Match any word in text: When you select this option, the text in the Find 

field must match any word of the text strings being searched. Use this 

option the text to be search contains multiple words, as shown in the 

example below: 

 

▪ Match any part of text: When you select this option, the text in the Find 

field must match any part of the text strings being searched. 

6 [Optional] Check the Match case checkbox for the search operation to be case 

sensitive. 

7 Click the  button. The results of the search are presented in a table 

at the bottom of the window.  

 

The results list shows the type of result, such as Name, Nickname and so on, 

the current value and the replacement value. Check the checkbox for each row 

whose value you want replaced. All result rows are checked by default. 

8 Click the Replace button. A confirmation message is displayed after 

completing the replace operation, which indicates the number of items 

replaced. 
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Right-click Menu in the People List 

When you right-click a person in the People List, a menu of options is displayed 

as shown below: 

 

 Display in Family Tree: Displays the selected family in Tree View. Selecting 

this option is the same as double-clicking the person in the list. 

 Manage Photos: Displays the Photo View, showing all the photos defined for 

the selected person. 

 Charts: Enables you to generate a variety of graphical charts about the 

selected person. See Charts. 

 Reports: Enables you to generate a variety of reports. See Reports. 

 Profile Page: Displays the full profile page from the family site for the selected 

person. 

 Research on SuperSearch: Provides you with full access to SuperSearch 

genealogy research, which can use to research families and/or specific 

people in your family tree. See SuperSearch. 

 Relation to Home Person: Displays a window that describes the relationship 

between the selected person and the Home Person in the tree. 



Quick Tour 

Family Tree Builder User’s Guide 
 

- 43 - 

 Relation To: Displays a window in which you can select a person, in order to 

see the relationship between this person and the person selected in the 

People List. 
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Tree View 
In Tree View, you can view and manage people in your family tree. 

NOTE Display this view whenever you want to see your family tree. 

 

The Tree View is displayed by default when you launch Family Tree Builder. You 

can also display the Tree View by clicking the  button in the toolbar, as shown 

below:  

 

In Tree View the work area contains the following:  

 Person Card: Provides a graphical representation showing a person’s photo 

and vital information in the family tree and enables access to all the 

information and functions provided by Family Tree Builder for this person. 

NOTE Information about a marriage is shown immediately under the 

husband and wife cards. 
 

 Generations View: Enables you to control how many generations are displayed 

in a Tree View. Slide the bar to select the number of generations you want to 

see. The default is three, and you have the option to select five or seven. 

People List 

Person Card 

Work Area in 

Tree View 

Generations  

View Control 
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 Add Person Button: Enables you to add a new person to the family tree. 

 Search Button: Enables you to search for a person and displays that person in 

the Work Area. 

 Styles Button: Displays the Options window, where you can configure various 

aspects of the appearance and behavior of Family Tree Builder. 

Person Card 

Family trees are created and edited in Family Tree Builder using an intuitive user 

interface that is simple to use. Our philosophy is to keep things highly visual and 

effortless, enabling you to create and branch-out a family tree just as one would 

do using a pen and paper. 

A person’s card allows you quick, intuitive access to a person's genealogy 

information. All the functions related to adding or changing information for a 

person can be accessed from here. You can also see an individual's information 

at a quick glance, such as birth date, place of birth, spouses, siblings, and so on. 

In Tree View, each person in the tree is represented by a card. 

 

You can navigate to any person and make that person the focus by clicking their 

name on their card, or by double-clicking their name in the list of people on the 

left. 

Person Card 
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Family Tree Builder enables you to assign a single picture or Personal Photo to each 

person in order to represent them wherever possible, such as in a report or in a 

thumbnail that is displayed when that person is shown in Tree View. Typically, this 

photo should be a portrait of their face. 

NOTE The husband and wife displayed in the center of Tree View have larger 

cards that display additional information, with tabs that may be clicked 

to view this additional information. 
 

Tabs that have information in them are denoted using a small green indicator, for 

example: 

  

The descendants and ancestors in this view have smaller cards showing less 

information. 

 

The Main tab , shown below, shows genealogical information.  
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Clicking the Info tab  shows additional information: 

 

Clicking the Contact tab  shows contact information: 
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Clicking the Notes tab  shows notes added to the person card: 

 

To edit information about this person, double-click the card or click the Edit 

button in their card and then select the Edit Details option from the menu. Both 

actions open the Edit window showing their current information, which enables 

you to modify their details. 

To update the photos, documents or video/audio files about this person, click the 

Photos button in their card to open the view showing the photos that are currently 

associated with them. This enables you to add photos and edit information about 

existing photos. 
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Each person card contains two links: a Profile link and a Research link. Click the 

Profile link to display the full profile page from the family site for that person, as 

shown below: 

 

Click the Research link to open SuperSearch, in order to research the selected 

person. 
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Generations Control 

By default, three generations are shown in Tree View, as shown below: 

 

In the window above, John and Jacqueline are the husband and wife, their parents 

are shown above them and their children are shown below them. 

The option to view three generations (the default and the most clutter-free mode), 

five generations or seven generations is enabled by the Generations slider 

 that appears at the top of the Tree View. 
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Photos View 
Photos View provides a variety of options for viewing photos, adding information 

about photos and associating photos with people and facts. For detailed 

information of the Photos View tools see Viewing and Managing Photos. 

You can click the  button in the toolbar to display the Photos View: 

 

In Photos View, the Work Area contains the following: 

 People List: Lists all the people in your project and enables easy access to 

their photos. 

 Photos tab: Lists photos according to your request. It may show all the photos 

defined in your project, all the photos that are associated with a particular 

person or any other filtered list of photos that you specify by indicating in 

what or in whom you are interested. You can control how photos are 

displayed in this panel. You can also add photos, edit information, mark faces 

and view and delete photos. 

Search 

Options 

Quick 

Find 

Options 

People 

List 
Photos 

List 

Photo 

Handling 

Options  

Photo 

Display 

Options  
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Smart Matches View 
In Smart Matches View, you can match people in your family tree to people in 

other family trees. For detailed information of the Matches View tools, see Smart 

Matches Window. 

You can click the  button in the toolbar to display the Smart Matches View. 

 

In Smart Matches View, the Work Area contains three tabs, as follows: 

 Overview Tab: Shows either a list of people in your family tree that have 

matches or a list of family trees in which those matches where found. 

 Matches Tab: Shows the matches for a specific person in your family tree. 

 Compare Tab: Graphically shows a person in your family tree compared 

side-by-side with that person in someone else’s family tree. 
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Charts View 
In Charts View, you can display people in your family tree in various chart formats. 

For detailed information on displaying charts, see Displaying a Chart. 

After you click the  button in the toolbar, you need to select the specific 

chart you want to display (ancestor, descendant and so on) and its orientation 

(horizontal or vertical). You can also choose the Chart Wizard option to help 

guide you through the process of creating a chart. 

 

In Charts View, the Work Area enables you to change the style and configuration 

of the chart, zoom in and out and save or print the chart. 
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Reports View 
In Reports View, you can create various reports for the members of your family 

tree. For detailed information on generating reports, see Generating a Report. 

After you click the  button in the toolbar, you need to select the specific report 

you want to display: 

 

In Reports View, the Work Area enables you to edit specific report options, zoom 

in and out of a report and save or print the report. 
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Maps View 
In Maps View, you can map your entire family tree, any portion of it or just one 

individual on an interactive world map. The Maps feature uses Google maps, in 

which you can pan, zoom in/out and so on for easy maneuverability. For detailed 

information about using the Maps feature, see Using Maps. 
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Menu Bar 
 

The following describes the options in the menu bar: 

NOTE The menus that are shown and the options that are available in each 

menu may change according to the view that you are in, such as: Tree 

View, Photos View, Smart Matches View or Smart Research View. 

Unavailable options appear grayed-out. 

The following is a comprehensive list. 

 

 File Menu 

 Edit Menu 

 View Menu 

 Person Menu 

 Family Menu 

 Charts Menu 

 Reports Menu 

 Favorites Menu 

 Research Menu 

 Sync (publishing) Menu 

 Family site Menu 

 Tools Menu 

 Help Menu 
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File Menu 

The following describes each of the options in the File menu: 

 

 New Project: Enables you to create a new project. 

 Open Project: Displays a window from which you can select a project to open. 

Only one project can be opened at a time. You are offered to save your current 

project, if one is already open. Click the Finish button to load the new project. 

A statistics window is then displayed, summarizing how many people, 

families, photos and so on are defined in the project that is currently open. 

 Save Project As: Saves the current project with the name that you specify in 

the window that is displayed. Use this option when you want to save a copy of 

the current project. 

 Close Project: Closes the current project. 

 Back up Project: Opens a wizard that walks you through the process of 

creating a backup of your entire project locally on your disk (see Backing Up a 

Project). 
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 Restore Project: Restores a project that was previously backed up on your 

computer (as described above) or that resides on your online family site at 

MyHeritage.com, and opens it in Family Tree Builder (see Restoring a Project). 

 Manage Projects: Opens a window in which you can rename, describe, delete 

and modify projects and import or export a Family Tree Builder project. 

 Import/Export GEDCOM: Opens a wizard that walks you through the process 

of importing from or exporting to GEDCOM (see GEDCOM and Family Tree 

Builder). 

 Quick-Start Wizard: Opens a wizard that walks you through the process of 

creating a new genealogy project, importing an existing project or opening an 

existing project. 

 Print/Print Preview/Print Setup: Enables you to print a project, preview a 

project you want to print, or set up a printer. 

 Exit: Exits and closes the Family Tree Builder application. 

Edit Menu 

The following describes each of the options in the Edit menu: 

 

 Cut/Copy/Paste: Enables you to cut, copy or paste information.  

 Search: Enables you to search for specific people. 

 Find and Replace: Finds text and replaces it with some other text (see Using 

the Find and Replace Function). 

 Export to Excel: Enables you to create CSV files from various lists. This file can 

be edited in Excel (see Importing/Exporting Family Tree Builder Data). 

 Import from Excel: Enables you to import the edited CSV back into FTB (see 

Importing/Exporting Family Tree Builder Data). 
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View Menu 

The following describes each of the options in the View menu:  

 

 Toggle Toolbar: Shows or hides the toolbar in Tree View. 

 Toggle Status Bar: Shows or hides the status bar in Family Tree Builder. 

 Navigate Back: Returns to the previously displayed window in Family Tree 

Builder. 

 Navigate Forward: Goes to the window that was displayed before you clicked 

the Back button in Family Tree Builder. 

 Navigate Home: Displays the Home Person as the central individual in the 

Tree View.  
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 Minimize selection view: Minimizes the People List on the display to give 

more room for the display of Tree View, Media View or Charts. The People List 

is described in People List. You can click the > button to enlarge the People 

List again.  

 

 Restore selection view: Redisplays the People List in its full size. The People 

List is described in People List Panel. 

 Full-screen: Displays Family Tree Builder window on the entire screen. To exit 

this mode, click the  button or press the Esc key. 

 Family Tree: Displays Tree View. 

 Photos and other media: Displays Photos View. 

 Smart Matches: Displays the Smart Matches window, where you can see the 

same person as he or she appears in a family tree of another member of 

MyHeritage (see Smart Matches). 

 Maps: Displays the Maps window, where you can map your entire family tree, 

any portion of it or just one individual on an interactive world map (see Using 

Maps).  

 Sources: Displays a window in which you can manage sources used in 

citations (see Managing Sources). 

 Repositories: Displays a window in which you can manage the repositories 

used in citations (see Managing Repositories). 

 Places: Displays an index of places with all the places used in the project (see 

Managing Places).  

 To-Do Tasks: Displays the Manage To-Do Tasks window in which you can 

manage tasks in your project (see To-Do Tasks).  
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Person Menu 

The following describes the options in the Person menu: 

 

These options are the same as those described in Person Menu Options. 

Family Menu 

The following describes the options in the Family menu: 

 

These options are the same as those described in Family Menu Options. 
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Charts Menu 

The Charts menu provides a variety of attractive and detailed charts representing 

your Family Tree. The following describes each of the options in the Charts menu 

(for details see Charts): 

 

 Chart Wizard: Opens a wizard for selecting the type and style of chart to display. 

 Ancestor Chart: Shows the selected person, his or her parents, grandparents 

and so on. 

 Descendant Chart: Shows the selected person, his or her spouse(s), their 

children, children’s spouse(s), grandchildren and so on. 

 Fan Chart: Shows the selected person and that person’s descendants or 

ancestors in a fan-shaped chart. 

 Close Family Chart: Shows the selected person and close relatives of that person. 

 Hourglass Chart: Shows the selected person, his ancestors and descendants.  

 Bowtie Chart: Shows the selected person and his or her spouse at the center, 

their ancestors on either side and their children below. 

 All-in-One Chart: Shows a chart of all people in the family.  

 Chart Options: Enables you to determine the content and appearance of a 

chart of your family tree. 

 Chart Styles: Select from predefined, attractive templates with chart options 

that define the look of the chart. 

 My Poster Orders: Shows all previous orders for printing posters of charts.  
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Reports Menu 

The following describes each of the options in the Reports menu (for details see 

Reports): 

 

 Book Report: Displays a simple wizard that walks you through the process of 

producing a report for a specific person. The report includes detailed 

information about the person and his or her family, and can be printed as a 

book. 

 Family Group Sheet: Generates a tabular report showing the details of the 

selected person and their immediate family. 

 Relationships: Generates a report showing all the relationships of the 

selected person to all the other people in the family. 

 Ancestors: Generates a report about a selected person and about each 

generation that precedes that person, such as parents, grandparents and so 

on. 

 Descendants: Generates a report about a selected person and about each 

generation that follows that person, such as children, grandchildren and so 

on. 

 Timeline: Generates a list showing major events of the family of the selected 

person in chronological order, such as birth, marriage and death. 

 Descendant Summary: Generates a hierarchical tree showing the 

descendants of the selected person. 
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 Addresses: Generates an alphabetical list (in the order of each person’s 

name) of the addresses of all the people in the family tree.  

 Export custom report: Creates an Excel report that contains only those people 

whose information you want to see.  

 Reports Options: Displays the Reports Options window in which you can 

specify what information to show in the report and how to show it. 

 Open Reports Folder: Displays the list of files in the folder into which reports 

are saved. 

Favorites Menu 

The following describes each of the options in the Favorites menu: 

 

 Remove [Person] from Favorites: Enables you to remove a person from this 

menu. 

 Organize Favorites: Enables you to determine the order in which people 

appear in this menu.  

 People’s Names: Lists the favorite people that you have added so that when 

you select a person’s name from this menu, that person is displayed in the 

center of the Tree View. 
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Research Menu 

The following describes each of the options in the Research menu. 

 

 Go to MyHeritage SuperSearch: Provides you with full access to the 

MyHeritage.com SuperSearch genealogical research tool. This powerful 

search engine lets you research your family history in billions of historical 

records. 

 Research [Person] on SuperSearch: Launches the MyHeritage.com 

SuperSearch genealogy research engine and automatically starts researching 

the selected person. 

 View Record Matches for [Person]: Opens the MyHeritage.com website, 

displaying matches to historical records for the selected person. See Record 

Matches. 

 Refresh Record Matches: Refreshes the record match counts in Family Tree 

Builder immediately. 

Sync (publishing) Menu 

The following describes the options in the Sync (publishing) menu (for details, 

see Syncing Your Family Tree): 

 

 Sync Now: Starts synchronizing changes in the family tree between Family 

Tree Builder and the online family site connected with this project. 
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 Sync Settings: Displays the Sync Settings window, which enables you to 

configure sync settings (see Sync Settings). 

 User Permissions: Displays a window where you can edit the user 

permissions, and control who can download your tree from the family site, 

and who can edit it online. 

 My Sites: Displays a window showing a list of the family sites that you have 

created on MyHeritage.com and enables you to invite members or visit these 

sites (see Managing Your Family Sites). 

 

Family site Menu 

The following describes the options in the Family site menu (for details see Using 

the Family Site Menu): 

 

 Family Statistics: Displays various statistics about the family. 

 Upcoming Events: Displays all upcoming family events, such as birthdays and 

anniversaries, in a list or monthly view. 

 Profile Page: Displays the full profile page from the family site for the selected 

person. 

 Record Matches: Displays all the historical records that match the family tree 

in one centralized dashboard (see Record Matches). 

 Visit Site: Opens the family site’s home page. 
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Tools Menu 

The following describes each of the options in the Tools menu: 

 

 Upgrade to Premium: If you are not a Premium member, enables you to upgrade 

to Family Tree Builder Premium membership (see Premium Membership). 

 Languages: Enables you to select the language used in Family Tree Builder 

(see Supporting Multiple Languages). 

 Translation Wizard: Displays the Family Tree Builder Translation Wizard, 

which walks you through the process of translating all or some of the data in 

your current project (see Translating in Family Tree Builder). 

 Author Information: Displays a window in which you can enter information 

about the author of this family tree. This information will be used if you export 

this family tree into GEDCOM format. 

 Advanced Privacy Settings: Defines privacy settings for this project (see 

Privacy Settings). 

 Check for Deceased People: Enables you to check your project for people who 

are deceased, but who are not marked as such in the project (see Checking 

for Deceased People). 

 Check for Duplicates: Finds potential duplications in your family tree (see 

Finding Duplicates in the Family Tree). 

 Tree Consistency Checker: Checks for consistency issues in your data (see 

Performing Data Consistency Checks). 

 Options: Describes additional options for configuring the behavior of your 

family tree (see Configuring Family Tree Builder). 
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Help Menu 

The following describes each of the options in the Help menu: 

 

 User’s Guide: Opens this document. This document is periodically updated 

on MyHeritage.com, and it will be offered to you whenever a new version 

becomes available. 

 Frequently Asked Questions: Opens the Family Tree Builder FAQ section on 

the MyHeritage.com web site.  

 What’s New in Version 7.0: Displays information about new and improved 

features in the latest version of Family Tree Builder. 

 Check for Updates: Checks whether a newer version of Family Tree Builder is 

available to download. 

NOTE By default, FTB checks for updates automatically, so you do not 

need to check for updates manually. Use the manual update option 

only if the automatic update configuration option was turned off, or 

if you do not want to wait for the next scheduled check. 

 

 About Family Tree Builder: Displays information about the current version of 

Family Tree Builder. 
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Toolbar 
The following describes the Toolbar that appears at the top of the Family Tree 

Builder window, which gives you quick access a variety of options: 

 

Icon Name Description 

 
New Enables you to create a new project (see Step 4: 

Creating Your First Project). This option is shown only 

when there is no project currently open in Family Tree 

Builder. 

 
Open Displays a window from which you can select a project 

to be opened. Only one project can be opened at a time, 

so it will offer to save your current project, if one is 

open.  

 
Back Returns to the previously displayed view in Family Tree 

Builder. 

 
Forward Goes to the view that was displayed before you clicked 

the Back button in Family Tree Builder. 

 
Home Displays the Home Person as the focus of the Tree View, 

meaning the husband or wife appears in the center of 

the Tree View. For a description of how to define a Home 

Person, see Set as Home Person. 

 

Tree Displays the Tree View. See Tree View. 

 
Photos Displays the Photos View. See Photos View. 

 
Matches Displays the Smart Matches View. See Smart Matches 

View. 

 
Charts Enables you to display various graphical charts of your 

family tree. See Charts View. 

 

Reports Enables you to generate various reports describing your 

family tree. See Reports View. 
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Icon Name Description 

 
Maps Displays your family on the map. See Maps View and 

Using Maps. 

 
Sync Syncs your family tree to and from your family site on 

MyHeritage.com. See Syncing Your Family Tree. 

 

Family site View various pages in your family site. Clicking this 

button opens a dropdown list containing the same 

options as the Family Site Menu. 

 

Research Research your family on MyHeritage.com. Clicking this 

button opens a dropdown list containing the same 

options as the Research Menu. 

 

Premium Enables you to upgrade to Family Tree Premium 

membership. See Premium Membership. 

 
Language Enables you to select the language used in Family Tree 

Builder. See Languages and Translation. 

 
Help Opens this User Guide. If the user guide has updates, 

clicking this button offers to download a new version. 

 

 



 

 CHAPTER 3 

Getting Started 
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Getting Started 
About This Chapter: 

This chapter suggests a workflow for getting started with Family Tree Builder and 

describes how to start adding people to your family tree. It contains the following 

sections: 

 Using Family Tree Builder describes a basic workflow for building a family 

tree using Family Tree Builder. 

 Creating Your First Project describes how to create a project. 

 Adding a Family describes how to define a family. 

 Describing a Person describes how to define a person. 

 Expanding the Family describes how to extend the family tree by defining 

family members as they are related to the people that you have already 

defined. 

 Editing Information describes how to edit families and people after they have 

been defined. 

 GEDCOM and Family Tree Builder describes how to import your data from a 

GEDCOM file. 

 Entering Dates describes the variety of options available for entering dates or 

ranges of dates in Family Tree Builder. 

 Citations describes how to identify the sources and repositories that you used 

for your research. 

 To-Do Tasks describes how to manage the various tasks that you want to 

handle in your project. 
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Using Family Tree Builder 
The following is a simple workflow that you may use when building a family tree 

using Family Tree Builder: 

 

Downloading Family Tree Builder 

Launching Family Tree Builder 

Registering as a Member of 

MyHeritage 

Creating Your First Project 

Defining Your First Family 

Editing People in Your Family 

Adding People to Your Family 

Publishing and Inviting Visitors 

Finding Matching People 

Generating Charts and Reports 

Step 1 

Step 2 

Step 3 

Step 4 

Step 5 

Step 6 

Step 7 

Step 8 

Step 9 

Step 10 
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Step 1: Downloading Family Tree Builder 

Family Tree Builder is available free of charge from MyHeritage.com. Simply 

navigate to the site and follow the instructions that describe how to install it on 

your computer. 

After it is installed, the following icon appears on the desktop: 

 

Step 2: Launching Family Tree Builder 

You can launch MyHeritage Family Tree Builder by double-clicking its desktop 

icon, or by starting it by selecting Start, then selecting All Programs:  

 

Step 3: Registering as a Member of MyHeritage 

In order to use the Family Tree Builder application, you need to be a registered 

member of MyHeritage. Registration is simple, quick, and free. 

If you have not yet registered as a member of MyHeritage, then do so now. If you 

are already a registered member, login with your username and password. 

Step 4: Creating Your First Project 

Each project in Family Tree Builder represents a family tree. You can have as many 

projects as you like. Typically, each project represents a family tree comprised of 

many related families.  

The process of creating a project offers you the option to create a family site on 

MyHeritage.com. You can create a site even if you have not yet filled out your 

family tree. This will be your own personal family website, where your family tree 

will be published and then continually synchronized. You can then invite family 

members and share information about your family. 

http://www.myheritage.com/
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Step 5: Defining Your First Family 

After you define a project, you are offered the option to create your first family: a 

husband, a wife and their children. Simply click the Add Family button. This 

option is displayed after you create your new project. For instructions for defining 

your first family see Adding a Family.  

 

Step 6: Editing People in Your Family 

Double-click the card of any person in this view to display a window in which you 

can describe them by adding their details: names, facts, notes, citations and 

more. 
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Step 7: Adding People to Your Family 

To add more people to the family, click the empty Add father, Add mother, Add 

spouse, Add son and Add daughter cards. 

 

To add a child for a couple who already have a child, click the Add son or Add 

daughter links in the family card. 

To add a spouse to someone who already has a spouse, right-click this person 

and select the Spouses menu. Then, select the Add Spouse option in the 

submenu. 

Step 8: Publishing and Inviting Visitors 

Publish your family tree to your family site on MyHeritage.com and invite people 

to come and see it! Any later change in the family tree will be synchronized to the 

family site. 
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Step 9: Finding Matching People 

Family Tree Builder enables you to find matches for the people that you have 

defined in your family tree. They are matched with people in all the other family 

trees on MyHeritage.com that were created by other members. This enables you 

to see the information that was entered about this same person in order to enrich 

your family tree and/or to create a link to that person in the other tree. 

Step 10: Generating Charts and Reports 

Family Tree Builder enables you to generate a rich variety of charts and reports 

that represent your family tree. See Charts and Reports. 
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Creating Your First Project 

Each project in Family Tree Builder represents a family tree. You can have as many 

projects as you like. Typically, each project describes a family tree that contains 

numerous related families. 

You may also decide to back up different versions of a family tree in different 

projects in case you would like to return to information that you had already 

changed. You can do this by saving different versions of your family tree in 

different projects. In addition, all your projects are backed up on MyHeritage 

servers after you synchronize them to your online family site. 

When you create your first project, you are offered the option of enabling 

automatic syncing, which provides online backup of projects. This protects your 

family tree and photos from any catastrophe or computer damage. You can also 

enable syncing for a specific project. 

When you create a new project, you are asked to specify its name and its 

language. You can also specify a secondary language if your family tree contains 

names in two languages. 

The initial project that is created is empty. You can fill the project with 

information about your family tree as described throughout this guide or you may 

import data that was stored in a GEDCOM or other format. You may also import a 

project that was created in Family Tree Builder, Family Tree Legends, Family Tree 

Maker, Personal Ancestral File, Legacy or The Master Genealogist. The Import 

function is described in GEDCOM and Family Tree Builder. 

After you import a project from a GEDCOM file, you are prompted to identify who 

you are in the family tree. See Identifying Yourself in the Family Tree for more 

details. 
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To create a new project: 

1  From the File menu, select New Project or click the  icon on the toolbar. 

The following window appears: 

 

2  Enter the name of your project in the Project Name field. It must be entered in 

English letters, but it may also include spaces and basic characters. The 

project name must be a legal file name. 
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3 Click Next. The following window appears: 

 

4 To sync the project, check Sync Project to a family site on MyHeritage.com. If 

you have more than one family site, you can select which one to sync to from 

the dropdown list. 
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5 Click the Next button to display the following window: 

 

6  Select the Primary Language, which will determine the language that is 

shown in the Family Tree Builder user interface and the language of the data 

that you will enter. 

If you would like to enter data in an additional language, select this language 

in the Secondary Language field. 

NOTE Family Tree Builder provides a dual-language mode, which enables 

you to enter and view data in two languages.  
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7  Click the Next button to display the following window:  

 

This window indicates that your project has been created successfully. 

NOTE Your project is not stored on MyHeritage.com and it is not available 

to be viewed by anyone through the Internet until you sync it to your 

family site. 
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8  Click the Finish button to display the following window: 

 

You can now add your first family by clicking the  button. 
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Identifying Yourself in the Family Tree 

When you open a project that you created or import one from a GEDCOM file, 

Family Tree Builder attempts to automatically locate you in the family tree, based 

on the email address you specified when registering with MyHeritage. If you 

cannot be located in the project based on this email address, you are asked to 

identify who you are in the family tree. Identifying yourself in the family tree 

provides several advantages, as follows: 

 The family tree indicates all the other people related to you, and indicates 

their relationship to you in related people’s cards and in other places 

throughout the application, as shown below: 

 

 When you sync to a site, the synced family tree identifies you and specifies 

this fact there too. Thus, the family tree shows relationships from your 

perspective, as they relate to you. 
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To identify yourself in the family tree: 

1 If Family Tree Builder cannot locate you in the family tree based on your email 

address, the following window is displayed: 
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2 Click the Select button to open the following window: 
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3 Select your name in the list and then click Select. The following window is 

redisplayed. 

 

4 Specify the Home Person for the project by selecting the applicable radio 

button. See Set as Home Person for more information. 

5 Click OK to save the settings. 
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Adding a Family 
Family trees are created and edited in Family Tree Builder using an intuitive 

graphical user interface that is simple to use. It is highly visual, making the 

process almost effortless. This enables you to create and branch-out a family tree 

just as one would do using a pen and paper. 

NOTE Family Tree Builder is installed with a sample project of the Kennedy 

family to serve as an example for you. 
 

 

TIP You can also add a family by using the Add Unrelated Family option in 

the Family menu. 
 

For as long as your project is empty, Family Tree Builder will invite you to build the 

first family from which descendants and ancestors can be defined graphically. 

A variety of ways are available to help you get started building your first family 

and to fill out and enrich the information that describes members of that family. 

The following describes one simple option for doing this. 

Click the Add Family  button to get started. The following 

window is displayed: 
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Defining the Husband and Wife 

Fill out the details of the husband and the wife of this family. 

Entering the maiden name of a woman (meaning her surname before her 

marriage) enables Family Tree Builder to enrich the connections in your family 

tree. 

To enter a date, either type it into the field or click the Date icon  that 

appears on the right of each date field. Family Tree Builder provides a rich variety 

of options for entering dates or ranges of dates. 

After completing this window and clicking OK you are prompted to add children to 

the family, as shown below: 

 

Click the Add Son or the Add Daughter button to display the following window: 
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Fill in the details describing this child. You can then click the More details button 

to define a variety of details about this child, or you can click OK to return to the 

Add Children window shown on the previous page. You can then add more 

children in the same way as described above until you click Done. After you click 

Done, the Tree View is then redisplayed showing the husband, wife and children. 

NOTE Family Tree Builder automatically detects when you attempt to add a 

person who is similar to another person who is already in the family 

tree. When this occurs, a warning is displayed. 
 



Getting Started 

Family Tree Builder User’s Guide 
 

- 91 - 

Describing a Person 
A simple way to start describing a person in your family tree is to double-click 

their card or an empty Add Father, Add Mother, Add Spouse, Add Son or Add 

Daughter box. 

 

 

 

Whether you are adding a mother, father, spouse or child to an existing person, or 

adding a person unrelated to all the others, the Add Person wizard is shown. 

Double-click  

here to describe 

 this father 

Double-click  

here to describe  

this person 

Double-click  

here to describe 

this family 

Double-click here to describe  

a son or a daughter 
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The easiest way to edit the details of a person in Family Tree Builder is to 

double-click their card in the Family Tree View. The following window is displayed, 

enabling you to enter a variety of information for this person: 

 

This window contains the following tabs for describing this person:  

 Main Tab 

 Info Tab 

 Contact Tab 

 Citations Tab 

 Notes Tab 

 Facts Tab 

 More Tab 
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Main Tab – Describing a Person 

The Main tab enables you to define basic information about a person, such as 

their name, gender and information about their birth. If the person is deceased, 

check the Deceased checkbox to add information about their death and burial. 

 



Getting Started 

Family Tree Builder User’s Guide 
 

- 94 - 

Click the Names button to display a window in which you can add additional 

names of this person and/or various suffixes and prefixes to their name, as 

shown below: 

 

The name that you entered in the Main tab appears in the window above. In this 

case, you can add additional information about that name in this window. If you 

would like to add another name, then click the Add Additional Name button. 

The top of the window indicates how many names were assigned to this person. 

You can click the right or left arrow, shown below, to browse between the various 

pages of name information. 

 

To add citation information about this name, click the Name Citations button (see 

Citations). 
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To add a note about this name, click the Name Notes button (see Notes Tab – 

Describing a Person). 

You can click the Photos button to view and add photos of this person using the 

Manage photos window: 

 

This window enables you to view or add photos of this person. The window 

operates in two modes, which is determined by the buttons at the top-left corner, 

in the Select area. The Select options are: 

 Browse Associated Photos 

 Associate Photos 
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Browse Associated Photos 

This window appears as shown above when the Browse associated photos option 

is selected in the Select area at the top-left corner. This is the default option when 

the person already has photos. Otherwise, the Associate Photos option is 

selected. 

This option enables you to easily browse through all the photos associated with 

this person. 

You can double-click a photo to display it in more detail in the Image Viewer. 

The viewing options provided here are the same as those described in Viewing 

Options below. 

Associate Photos 

The window appears as shown above when the Associate photos option is 

selected in the top-left corner in the Select area. It enables you to associate a 

photo with this person 
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To associate a photo with this person: 

1  Browse to the list of photos in the area on the right. In the field above the 

photos, you can show all photos or only photos of this person that are not yet 

associated with this person. 

2  Click a photo in the area on the right. 

3  Click the Associate button to move this photo into the area on the left called 

Associated Photos. All the photos listed in this area are associated with this 

person. This means that they are displayed when you view this person. 

Viewing Options 

This window provides a variety of options for viewing the photos that have not yet 

been associated, making it easy for you to select and associate them with this 

person. 

Format 

You can select the Table button in the Format area to display the photos in the 

form of a table, or the Thumbnails button to display the photos only as 

thumbnails. 

You can adjust the size of the thumbnails using the slider on the top right of the 

window. Moving it towards the XXL (Extra-Extra Large) on the right side makes the 

thumbnails larger and moving it towards the S (Small) on the left side makes the 

thumbnails smaller. 

View 

In the View area, you can click the Photos box to specify that only photos are 

displayed, or the Documents box to specify that only documents are displayed or 

the Video/Audio box to specify that only video or audio files are displayed. 
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New 

You can add new photos, documents and video and audio files to this person and 

to your family tree. 

To add one or more media, click the New button to add a photo, or on the arrow 

on the right of the New button to display a dropdown menu. This enables you to 

select which type of media you would like to add to this person. 

 

See Handling Photos and Other Media. 
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Info Tab – Describing a Person 

The Info tab enables you to enter information about the occupation, education 

and identification of this person. 
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You can enter information in any of the areas in the window and then press the 

 button to display a window in which you can add more detail about this 

information, such as the date, place, fact citations, fact notes and fact photos, as 

shown below: 

 

 Fact Citations: For a description of what a citation is and instructions on how 

to enter a citation, see Citations. 

 Fact Notes: See Notes Tab – Describing a Person for a description of what a 

note is and instructions on how to enter a note. 

 Fact Photos: See Fact Photos. 

Check the Current Education (or Current Occupation) checkbox to specify that 

this is the current education or occupation (latest information) for this person. 

Check the This fact is privatize (do not sync to family site) checkbox for the 

information entered if you do not want this fact synced to a family site. See 

Privacy Settings for more information. 
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Fact Photos 

Click the Fact Photos button to view and add photos associated with this fact. For 

example, for the immigration of a person, you can add a photo of the ship of the 

voyage, for an education fact you can add a photo of the school, for a burial fact 

you can add a photo of the tombstone and so on. 

Contact Tab – Describing a Person 

The Contact tab enables you to enter contact and residence details for this 

person, as shown below: 

 

In the Date field, you can add the period during which the person lived at that 

address. 

Check the Current Address checkbox if this is this person’s current address. 
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One or more additional addresses may be entered by clicking the Add Additional 

Address button. 

The number of addresses that have been added is indicated at the top of the 

window as shown below: 

 

TIP Family Tree Builder provides a report listing all the addresses in your 

family tree. 
 

Click the More contact info button to add and manage additional phone numbers, 

email addresses and web contacts. 
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Citations Tab – Describing a Person 

Citations enable you to track and identify the source of your research.  

The Citations tab enables you to enter citation information, as shown below: 

 

See Citations for more information about citations and how to use them. 
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Notes Tab – Describing a Person 

The Notes tab enables you to type in any information that describes this person in 

free text, as shown below: 

 

Refer to Notes Tab – Defining Notes for more information about notes and how to 

use them. 

TIP Before entering a note, check if Family Tree Builder provides a fact type 

that suits the kind of information that you want to enter. The reason is 

that Family Tree Builder displays these facts in many of its windows, 

charts and reports. 
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Facts Tab – Describing a Person 

The Facts tab enables you to enter facts about this person. Each type of fact 

provides a list of fields for you to enter. Family Tree Builder displays these facts in 

many of its windows, charts and reports. 

The most common facts about a person, such as birth, death, occupation, 

education and so on, can also be edited in the Main and Info tabs. However, they 

also appear in the Facts tab, which shows a consolidated list of all facts about 

this person. 

 

The top of the window shows a list of all facts about this person. Each time you 

click a row, more details about this fact are shown at the bottom of the window. 

You can also double-click a fact to show the details in a separate window. 

The middle of the window provides all the details about the selected fact and 

enables you to edit it. 
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The bottom of the window provides the following buttons: 

Button Description 

 Displays and adds citations for this fact.  

 
Displays and adds notes about this fact. For more details 

about notes, see Notes Tab – Describing a Person. 

 Displays and adds photos for this fact.  

 
Displays a window in which you can define a new fact 

about this person. 

 
Displays a window in which you can edit the facts about 

this person. 

 Deletes the selected fact. 

 Sorts the facts in chronological order.  

To define a new fact: 

1  Click the New Fact button to display the following window: 
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2  Select a category of facts from the list on the left to display a list of facts of 

that type on the right. 

3  Select a fact from the list on the right or type in the name of a new type of fact 

in the field on the bottom of the window and click OK. The new row is then 

created in the facts table, ready for you to enter more information about this 

fact, such as date, place and description. 

NOTE If the fact that you want to add is not one of the standard facts that 

is provided by Family Tree Builder, you type the name of this fact in 

the Or, enter a custom type field at the bottom of the window. 
 

More Tab – Describing a Person 

The More tab enables you to enter information about the physical attributes, 

status, and privacy of a person, as shown below: 
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Click the  button to view and enter details about the 

physical description of this person. See Adding a Physical Description for a 

Person. 

Click the  button to view and enter genetic DNA information 

for this person. See Adding DNA Markers for a Person. 

Click the  button to view and enter tasks for this person. 

See To-Do Tasks. 

To indicate that all research has been completed for the person, check the 

Research is complete for this person checkbox. When you select this checkbox, 

the person’s card shows a green checkmark  indication. Click this icon to 

display a tooltip indicating that all research is complete for the person. Click the 

Click to view research status link to open the Tasks window for this person. 

 

 

Check the checkbox in the Privatization area if you do not want the information 

about this person to be synced to a family site, so that it is not displayed there. 

See Privacy Settings for more details. 
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Adding a Physical Description for a Person 

To add physical information for a person: 

1 Click the  button to display the following window: 

 

2 Enter the physical details for the person and click OK. 
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Adding DNA Markers for a Person 

Various companies supply kits that can be used to perform DNA testing. The 

information obtained from such testing can be stored for a person in Family Tree 

Builder. 

NOTE DNA-related information is stored encrypted in the Family Tree Builder 

database. Such information is never published to a family site, nor is it 

contained in an exported GEDCOM file. 
 

To add DNA information for a person: 

1 Click the  button to display the following window: 
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2 Select the DNA testing company whose testing kit was used to collect 

DNA-related information, and then click OK. 

The following window is displayed: 

 

3 Select the applicable testing company and test in the Select a test dropdown 

list. 

4 Enter the DNA results in the relevant boxes. Note that field in the window vary, 

depending on the specific DNA company and test that you selected in step 3. 

5 Enter the Haplogroup (a major branch on the human family tree) based on 

this test, if available. 

6 Enter SNPs (single nuclide polymorphism) based on this test, if available. 

7 After entering all test results, click OK. 
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Expanding the Family 
After you have defined information about your first family, you can start defining 

information about other people in the family. To extend the family tree, add 

people to the family group you just created. You can branch out in any direction 

by adding parents, grandparents, brothers, sisters, children, grandchildren and 

so on. 

A variety of options are provided for adding members to your family tree, 

including the following: 

 Double-clicking an Empty Family Card 

 Right-clicking a Person’s Card 

 Using the Add Person Button 

 Defining New Children in the Family Tree 

 Adding an Existing Child to a Family 

 Adding a Spouse to a Person 

 Adding Another Spouse to a Person 
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Double-clicking an Empty Family Card 

When you define a new family, a card is automatically created for a husband, wife 

and a child. You can add a member to this family by double-clicking an empty 

card that represents the relevant relation to the people displayed, as shown 

below: 

 

For example, you can click the  links to display a window 

that walks you through the process of defining a child of these parents. More 

details are provided regarding defining a child in Defining New Children in the 

Family Tree. 

The same goes for adding a mother or father for either the husband or the wife 

displayed in this window, and for adding a spouse to a person who does not have 

a spouse in the family tree. 

TIP To add a brother or sister to either the husband or the wife, simply 

double-click on one of their parents. That husband or wife then 

becomes a child of those parents and you can define additional children 

for that parent, who are, of course, their siblings. 
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Right-clicking a Person’s Card 

You can right-click a person’s card to display numerous options that enable you 

to add parents, siblings, spouses and other relations to this person.  

Using one of the options that starts with the word Attach, you can connect a 

person that already exists in your family tree as a relative in another place of the 

tree. For example, use the Attach option when two cousins marry, when someone 

was adopted by an uncle or aunt or when two brothers marry two sisters. 

 

Using the Add Person Button 

Click the small arrow to the right of the Add Person button to display a dropdown 

list that enables you to add various relations to the people currently displayed in 

the tree, as shown below: 

 

NOTE Family Tree Builder automatically detects when you attempt to add a 

person who is similar to another person who is already in the family 

tree. When this occurs, a warning is displayed. 
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Defining New Children in the Family Tree 

The visual aspects of the main Family Tree Builder window make it easy to define 

children and parents. This section describes how to define a child in a family. You 

can add parents in a similar manner. 

TIP To add a brother or sister, define them as the children of the same 

parent. 
 

 

Family details always appear under the husband and wife cards. It shows details 

of their marriage and indicates the number of children they have. It also provides 

an Add Son/Add Daughter option. 

TIP You can also add children in the Edit Family window. 

 

Adding a Son 

or a Daughter 
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To add a child: 

1  Click the Add Son or Add Daughter buttons, or double-click in the white box at 

the bottom of the tree that contains the text Add Son/Add Daughter, to 

display the following window: 

 

2  Fill in the fields of this window as you wish. You may click the More Details 

button to open a window in which you can enter a rich variety of information 

describing this person. 
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Adding an Existing Child to a Family 

If you have already defined a person in Family Tree Builder that is the child of the 

parents, then it is quite easy to drag and drop that person from the People List 

into the family tree of his or her parents, as shown below: 

 

To add an existing child: 

1  Select the child's name in the People List on the left. 

2  Drag the child into the white Add Son/Add Daughter box at the bottom of the 

window. 

There are several other ways to add an existing child to a family: 

 Right-click a family box (or click its Edit button). The Edit family menu opens. 

From the Children menu, select Attach Existing Child and then select the 

child from the list of people in the tree. 

 Double-click the family. The Edit Family window opens. Go to the Children tab, 

click the Attach Child button and then select the child from the list of people 

in the tree. 

Select the 

Child 

Drag the 

child to 

here 
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Adding a Spouse to a Person  

You can add a spouse to a person in the tree by clicking the Add Spouse card next 

to this person. 

 

Fill in the fields of this window as you want. You may click the More Details 

button to open a window in which you can enter a rich variety of information 

describing this person and the relationship between the spouses. 
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Adding Another Spouse to a Person 

Many times, a person already has a spouse in the family tree and you want to add 

another spouse for another marriage of that person. 

To achieve this, click the Edit button at the bottom of the person's card, select the 

Spouses option and then the Add Spouse option. A window similar to the one 

above for adding the first spouse of a person appears, in which you can add the 

details for the additional spouse. 
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Editing Information 
Family Tree Builder is quite flexible and will enable you to edit any information 

that you have entered at any time. In this section, you can find out about: 

 Editing a Person 

 Person Menu Options 

 Editing a Family 

 Family Menu Options 

 Editing a Photo 

Editing a Person 

You can reach the detailed information entry page of a specific person in several 

ways: 

 Click the More Details button in the Add Person wizard. 

 Double-click the person’s card in Tree View. 

 Click the Edit button on a person card. 

 Right-click a person’s card and select Edit Details. 

 

A window opens in  

which you can enter  

or modify information  

and photos about  

this person. 

Double-click a  

Person’s Card  

to edit  its information. 
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Person Menu Options 

The following describes the options that are available to you when you click the 

Edit button at the bottom of a card or right-click a person’s card, as shown below: 

 

When you right-click a person’s card in Tree View, the menu enables you to 

change the status of that person. 

At a glance, this menu provides information about how many parents, children, 

spouses and photos have been defined for this person. For example, John has 

eight siblings, one spouse, four children and 8 photos, as shown above. 

Edit Details 

This option opens the Edit Details window, which enables you to modify or add 

information about the person. 
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Person 

The following options are available for changing the status of the currently 

selected person: 

 

Go to Person 

This option displays the current person as the focus of the Tree View, meaning 

that this person’s card now appears in the center of the Tree View. 

This option is inactive if the current person is already in focus. 

Add to Favorites 

This option adds the selected person to the Favorites menu. The Favorites menu 

provides a quick means of centering your family tree on a person. An example of 

the Favorites menu is shown below. This one contains two favorite people: 
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Set as Home Person 

This option defines the currently selected person as the Home Person. Each 

family tree has one Home Person around whom the family tree is centered. The 

Home Person is influential for several reasons, as follows: 

 Clicking the Home  button brings this person into focus, meaning that it 

displays this person in the center of the Tree View. 

 When you display information about a person, such as by hovering over that 

person in the People List, the relationship between that person and the Home 

Person is displayed as shown below: 

 

 When you right-click a person and select the Relation option, then this 

person’s relationship to the Home Person is displayed. 

You can change a Home Person at any time by selecting the option Set as Home 

Person. 

Tasks 

Adds and edits tasks related to this person. Click this option to add and remove 

tasks related to this person. 

Show in List 

Highlights the selected person in the People List. 

Delete Person 

This deletes the selected person. You can delete a person at any time. If deleting 

this person will break relationships in the tree, a warning is displayed. 

Profile Page 

Displays the complete profile page for the selected person. See page 66. 
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Parents 

The Parents menu shows how many sets of parents a person has, their names 

and the type of parents they are, such as natural or adoptive. Simply select one of 

the Parents in the menu to show their cards in the Tree View. 

The following options are available for defining parents: 

 

Add Parents 

An additional set of parents can be added to a person at any time. For example, 

both adoptive parents and natural parents may be added. 

The Add Parents window is displayed in which you can define how to add a new 

set of parents. 

Attach Parents 

This option enables you to connect a person to a set of parents that have already 

been defined in Family Tree Builder. A window is displayed in which you can 

select parents.  

Detach Parents 

This option enables you to detach parents from their child. The parents will still 

be defined as parents in Family Tree Builder, but not as the parents of the 

selected person. 

Replace Parents 

This option enables you to replace the current parents of a person with a different 

set of parents. 
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Manage Parents 

This option opens a window that shows you a list of the current parents of a 

person, where you can add, attach, replace and detach parents. You can also 

define the type of parent they are, such as adoptive or natural. 

List of Parents 

This option lists all the parents defined for this person and indicates their type, 

such as adoptive or natural. 

Siblings 

When you right-click a Person’s Card in Tree View, the menu shows the number of 

brothers and sisters of this person and their names. Simply select one of the 

siblings in the menu to show their card in Tree View. 

The following options are available for defining siblings: 

 

Add New Brother/Add New Sister 

This option enables you to add a brother/sister to the selected person. A window 

is displayed in which you can define a brother/sister in the same way that you 

define any person in the Family Tree Builder. 
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Attach Existing Sibling 

This option enables you to attach a person who has already been added to the 

tree as a sibling to the selected person. A window is displayed in which you can 

select the person. 

Spouses 

When you right-click a person’s card in Tree View, the menu shows the number of 

spouses defined for this person and their names. Simply select one of the 

spouses in the menu to show their card in Tree View. 

The following options are available for defining spouses: 

 

Add Spouse 

This option enables you to add an additional spouse to the selected person. A 

window is displayed in which you can define a spouse in the same way that you 

define any person in Family Tree Builder. 

Attach Spouse 

This option enables you to create a spousal relationship between two persons 

already existing in your family tree. For example, if two cousins who were already 

added to the tree are actually married, you can attach one as the spouse of the 

other. A list of people in the family tree is displayed from which you can select the 

spouse to attach. 
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Detach From Spouse 

This option enables you to disconnect a spouse from a person. The person will 

still be defined in the tree, but he or she will no longer be defined as the spouse 

of this specific person. 

TIP Do not use this option if the two people are divorced. Rather, mark them 

as divorced. Use this option only if the two people were mistakenly 

marked as spouses of each other. 
 

Manage Spouses 

Use this option when a person has more than one spouse. It enables you to 

define more information about their relationship. The order of the spouses is 

particularly important. The first spouse in the list is the spouse that is shown next 

to the person in the tree view, by default. Another field of interest is the marriage 

status, which specifies if a spouse is married, divorced, separated and so on. The 

following window is displayed: 
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The top of the window lists the spouse and a brief summary of their information. 

The middle of the window provides all the details about the selected spouse and 

enables you to edit them. 

The bottom of the window provides the following buttons: 

 Displays a window in which you can define a new person as a 

spouse. 

 Displays a list of family members from which you can select 

the spouse to attach.  

 Detaches the selected spouse. 

 Moves the selected spouse up or down in the list. 

 Click this button to sort the spouses in chronological order. 

Photos 

When you right-click a Person’s Card in Tree View, the Photos menu shows the 

number of photos for this person. 

 

For more details about the Photos menu options, see Handling Photos and Other 

Media. 
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Research 

When you right-click a Person’s Card in Tree View, the Research menu provides 

access to various research options for that person. 

 

For more details about the Research menu options, see Research Menu. 

Relation 

This option enables you to define the selected person as the Home Person. It also 

allows you to see information about the relationship of this person to other 

people in the family tree. 

The following options are available in this menu: 

 

Set [Selected Person] as Home Person 

This option defines the selected person as the Home Person. Each family tree has 

one Home Person who is given special treatment in Family Tree Builder. 
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Relation to Home Person 

This option displays the relationship of the selected person to the Home Person.  

Relation To… 

This option enables you to define the relationship of the selected person to anyone 

in the family tree. A window is displayed listing all the people in the family tree. 

Select the other person to see the relationship between the two people. 

Charts 

This option enables you to display charts about the selected person. See Charts. 
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Reports 

This option enables you to generate reports about the selected person. See 

Reports. 
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Editing a Family 

The simple-to-use interface provided by Family Tree Builder enables you to 

double-click the small  box situated between the husband and wife of a family, 

in order to edit any information about this family. 

 

The Edit Family window comprises various tabs, each of which enables you to 

enter different kinds of information about the family as a unit. The tabs are: 

 Main Tab 

 Children Tab 

 Citations Tab 

 Notes Tab 

 Facts Tab 

Double-click here  

to edit the family’s 

information 

A window opens in 

which you can enter or 

modify information and 

photos about this 

family. 
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Main Tab 

The Main tab enables you to describe the husband and wife who represent the 

center of this family and to enter details of their marriage. Entering the maiden 

name of a woman (meaning her surname before her marriage) enables Family 

Tree Builder to enrich the connections in your family tree. 

To enter a date, either type it into the field or click the Date icon  that 

appears to the right of each date field. Family Tree Builder provides a rich variety 

of options for entering dates or ranges of dates. 

Click the Photos button to view and add photos of this family. 

Children Tab 

The Children tab enables you to define the children of this primary husband and 

wife. The top of the window lists the children that have already been defined and 

provides a brief summary of their information. 
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The middle of the window provides all the details about the selected child and 

enables you to edit him/her. The Relationship field may be of particular interest 

in the case of adopted or foster children. 

If you only know the number of children in this family, but do not know anything 

about these children, there are two ways to proceed. You can either add these 

children without any information about them, or alternatively, you may check the 

Known number of children checkbox and enter the number of children in this 

family. 

The bottom of the window provides the following buttons: 

Button Description 

 

Displays a window in which you can define a new person 

who will be a child of these parents. 

 

Displays a list of family members to which you can attach 

the selected child.  

 
Detaches the selected child. 

 

Select the row of a child and click the Up or Down arrow 

button to move the child up or down the list.  

 Click this button to sort the children in chronological order. 
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Citations Tab – Defining Citations 

Citations enable you to track and identify the sources and repositories that you 

used in your research. The Citations tab enables you to enter citation information, 

as shown below: 

 

For a description of citations and their use, see Citations. 
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Notes Tab – Defining Notes 

The Notes feature in Family Tree Builder enables you to enter free text that is 

displayed about this family. You can type in the text or copy and paste it from any 

source into the Notes window, which is shown below: 

 

The top of the window indicates how many notes were assigned to this family. 

You can click the right or left arrow shown below, to browse between the various 

pages of notes information. 

 

The toolbar in the Notes window enables you to format the actual note text. 

To clear the note, click the Clear Note button. 

To add another note, click the Add Additional Note button. 

To add a citation for this note, click the Note Citations button (see Citations). 

If you want the note to be private and not synced to your family site, check the 

This note is private (do not sync to family site) checkbox. 



Getting Started 

Family Tree Builder User’s Guide 
 

- 137 - 

Facts Tab – Defining Facts 

The Facts tab enables you to enter various facts about this family. A variety of 

categories of facts are provided, and each fact has different fields, enabling you 

to enter information that is relevant to the selected fact, as shown below: 

 

The procedure for entering a fact about a family is similar to entering a fact about 

a person, as described in Facts Tab - Describing a Person. 
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Family Menu Options 

The following family-related menu options are available: 

 Edit Details: See Editing a Family. 

 Family: See Editing a Family. 

 Children: See Children Tab. 

 Photos: See Handling Photos and Other Media. 

 Research: See SuperSearch. 

 Add Unrelated Family: See Adding a Spouse to a Person. 
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GEDCOM and Family Tree Builder 
GEDCOM, an acronym for GEnealogical Data COMmunication, is a specification for 

exchanging genealogical data between different genealogy software. 

MyHeritage provides a rich variety of visual interface features, media handling 

features, information authoring and display options that represent a significant 

improvement over the GEDCOM’s specification. 

You can start your new genealogy project with Family Tree Builder in the following 

ways: 

 Create a new project. 

 Import a project from an existing GEDCOM file. Typically, this will be a 

GEDCOM file that you have exported from other genealogy software. 

 Import a project from another genealogy program, such as Family Tree 

Legends, Family Tree Maker, Personal Ancestral File, Legacy or The Master 

Genealogist. When importing from one of these applications, the imported 

data is automatically converted to GEDCOM format for use in Family Tree 

Builder. 

NOTE In Family Tree Builder, the main storage unit for your work is a 

Project. A Project is equivalent to a single GEDCOM file, plus all 

related photos, documents and files. 
 

 

TIP Alternatively, you can use the Quick-Start Wizard option in the File 

menu to import, export or load a GEDCOM project. 
 

Importing an Existing GEDCOM File  

It is possible to start working on your genealogy project with Family Tree Builder 

by importing your data. You can import a GEDCOM file from another genealogy 

program (to start a new project, or merge its contents into a current project. 

http://en.wikipedia.org/wiki/Specification
http://en.wikipedia.org/wiki/Genealogy
http://en.wikipedia.org/wiki/Data
http://en.wikipedia.org/wiki/Genealogy_software
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To import your data to Family Tree Builder: 

1 From the File menu, select Import GEDCOM. The following window is 

displayed: 
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2 Browse and choose the file that you want to import and click Next. 

Alternatively, you can click the Scan button to automatically scan your 

computer to locate genealogy files, from which you can select the specific file 

to import.  

After you select the file to import, the following window is displayed: 
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3 Click Next. The following window is displayed: 

 

4 In the Project name box, type the project name and click Next. 

NOTE It is recommended that you leave the GEDCOM configuration 

parameters unchanged. 
 

When importing a GEDCOM file, the following window is displayed: 
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When importing a file from another genealogy program in a non-GEDCOM 

format (for example, a Family Tree Legends *.FTL file or a Personal Ancestral 

File *.PAF file), the file is first converted to GEDCOM format before being 

imported to Family Tree Builder. At the end of this conversion process, the 

following window is displayed: 
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5 For a GEDCOM file import, click Finish. 

 

6 For a non-GEDCOM file import, click Next and then Finish. Your FTB project 

has been created. 

The GEDCOM Import feature has been tested thousands of family trees. This was 

done because many genealogy products do not adhere precisely to the GEDCOM 

format, or suffer from inconsistencies that exist within the format itself. We do our 

utmost to recover your data as faithfully as possible, and we believe that we have 

developed the most accurate GEDCOM import application available. However, 

there are always new issues found with this capability, so if you notice errors or 

deficiencies that occurred in the import procedure, send us the details so that we 

may further improve the import process. 

If any issues were discovered during the import of the GEDCOM file, you can click 

the View Issues button to see them. 

TIP We support the importing of media files and documents referenced by a 

GEDCOM file, including photos. However, some genealogy products 

reference them using proprietary non-GEDCOM tags. If your photos are 

not imported correctly, please send us your GEDCOM file for us to fix 

this. 
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TIP Advanced users may view a report produced at the end of the import, 

showing which unexpected tags were found in your file and how they 

were handled. 
 

 

TIP We support a GEDCOM import from Dorotree, even of bilingual family 

trees (for example English and Hebrew). 
 

 

TIP The ability to merge a GEDCOM file into a current project is done only 

partially. Currently the merge will not be done in full. There is still no 

application to compare, side by side, your existing family tree and the 

one in the imported GEDCOM, where you are asked to pick which 

specific records you wish to import and which ones to reject. This 

application is planned for a future release. 
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Entering Dates 
Family Tree Builder provides a rich variety of options for entering dates or ranges 

of dates. Many features will provide automated benefits if you enter dates, such 

as the ability to see a list of people sorted by their birth date or to list the events 

of a person’s life chronologically. 

To enter a date, either type it into the field using any format that you like (free 

text) or click the Date icon  that appears on the right of each date field. 

 

The following window is displayed: 

 

If you would like to enter an exact date, simply make your selection from the 

Month and Day fields and type the year in the Year field. 

You can also use the visual calendar in the top right of the window to click the 

date of your choice. The date you select will also be shown in the Month, Day and 

Year fields. 
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Date Field 

The date that you specify can be quite flexible. It can be the exact date as 

described above, or an approximation. If you are not sure of the exact date select 

from the Before, After, About, Estimated or Calculated options to indicate 

approximately when the event took place.  

 

The Estimated option is an indication that you are not sure when the event 

happened. 

The Calculated option is an indication that you calculated this date. For example 

by saying that your grandmother was 70 years old when she died in 1985 and 

therefore may have been born in 1916.  

The Period options: Period (start to end), Period (start) and Period (end) are 

typically used to specify an event that took place over a period of time such as 

university studies.  

The options for entering a date in this window change according to the selection 

that you make in the field, as shown below: 
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Single Date 

 

Date Within Range 

 

Period (Start to End) 

 

Period (Start) 
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Period (End) 

 

Date in Free Text 

 

You may check the After Sunset checkbox to indicate that this is when the event 

occurred. This option is relevant when entering dates using the Hebrew Calendar. 

Hebrew and French Revolution Calendars 

This window also enables you to click the Hebrew Calendar button or the French 

Revolution Calendar button at the bottom of the window in order to display the 

required calendar. You can then make your selections in this calendar in this the 

same way as in the Standard Calendar. 

If you like, you can convert this date into the corresponding date in the standard 

calendar by clicking the Convert button. 
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Citations 
Citations enable you to identify the sources and repositories that you used for 

your research. 

Family trees are richest when they contain numerous citations, specifying the 

reference of the information in the family tree to a specific source document 

located in a repository, such as a library. A source can be a variety of entities, 

such as a book, newspaper clipping, legal document, tombstone photo, interview 

transcript, letter or web site. The citation is the reference to the specific place in 

that source that verifies the relevant information in the family tree. 

Family Tree Builder supports the full GEDCOM specification that pertains to 

sources, notes and citations. These elements are supported recursively, so that 

you can add a note to a person, associate that note with a citation that ties it to a 

source, add another note on that specific citation and so on. You can also assign 

notes to specific events in the person’s life, or to one of his/her names, instead of 

assigning them to the person as a whole. 
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To define a citation: 

1  When you click the Citation button in any of the Family Tree Builder windows, 

the Citation window is displayed, as shown below. It is also one of the tabs 

available when defining a person or family. The name of this button may differ 

between windows and may be called Citation Notes or Name Citations and so 

on.  

 

2 Select the source of this citation reference from the Source dropdown list. 

NOTE If the source you are looking for has not yet been defined in this 

project, click the New Source button to define it. You can also use 

the Edit Source button to modify it (see Managing Sources and 

Repositories). 

 

3 You can add the page of the citation in the source or the URL if the source is a 

web site.  

4 Select the level of confidence in the Confidence dropdown list, add a date to 

the citation and add the specific citation text. 
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5 Click Citation Notes to add notes for this citation. See Notes Tab – Defining 

Notes for details about adding notes. 

6 When you finish defining the citation, click OK to close the Citations window. 

To add a source: 

1 Click the New Source button to create a new source for your project.  

 

2 Enter information describing the source in this window. 

3 Click Source Photos to add photos for this source.  

4 Click Source Notes to add notes for this source. 



Getting Started 

Family Tree Builder User’s Guide 
 

- 153 - 

5 You can also define the repository (such as the name of the library or 

database) in which the source is located, if required. If the repository already 

exists, you can select it in the Repository field. You can click the 

 button to display the following window in which you can 

define a new repository. 

 

6 Add notes to this repository by clicking the Repository Notes button. 

7 You can view a list of all sources and all repositories in your project by going 

to the View menu and clicking the Sources and Repositories options, 

respectively. 
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To-Do Tasks 
Family Tree Builder’s Tasks feature enables you to manage the various tasks that 

you want to perform in your project. In this context, tasks are like notes to 

yourself or a to-do list. Tasks are not synced to a family site, and are only 

available in Family Tree Builder. You can add, modify and remove tasks in Family 

Tree Builder. 

When you define a task that relates to a specific person, that person’s card 

displays the  icon to indicate that a task is associated with that person (see 

Viewing Tasks for a Person). 

To define a task:  

1 In the View menu, select To-Do Tasks to open the Manage To-Do Tasks 

window. 

 

2 In the Tasks for dropdown list, you can filter to view only tasks that are 

associated to a particular person or to view all tasks. 



Getting Started 

Family Tree Builder User’s Guide 
 

- 155 - 

3 Click the New Task button to create a new task. The Add New Task window is 

displayed: 

 

4 In the Title field, enter a name for the task. 

5 [Optional] In the Description field, enter a description of the task. 

6 In the Priority dropdown list, select one of the following options to set the 

priority of the task: 

▪ Low 

▪ Normal 

▪ High 

The Priority affects the order of the tasks in the list. You can sort tasks by 

priority in the list of tasks.  

7 [Optional] In the Location field, enter the physical where the task will be 

performed, for example, a library or cemetery. 
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8 In the Status dropdown list, select one of the following options to indicate the 

current status of the task: 

▪ Not started 

▪ In progress 

▪ Complete 

▪ Postponed 

▪ Cancelled 

NOTE Tasks with a Cancelled status are shown last in the list and are 

grayed out. 
 

9 [Optional] Click the Add button to open the following window in which you 

associate a specific person with the task. 

 

Select the applicable person in the list and then click the Select button.  
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The chosen person is shown in the pane at the bottom of the window. 

 

10 Click the OK button to save the task. The task is shown in the list of tasks in 

the Manage To-Do Tasks window. 

 

Click a column heading to sort the table’s contents by that column, in 

descending order. 

11 Click the Done button to exit the window. 

TIP Clicking Abort Syncing aborts the syncing process. 
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You can also perform the following additional actions on tasks using the buttons 

on the right side of this window: 

 Edit Task: Select a task in the window and click the Edit Task button to edit 

that task. 

 Delete Task: Select a task in the window and click the Delete Task button to 

delete the task. 

 Save to File: Save a list of tasks to an Excel file. 

Viewing Tasks for a Person 

When you add a person as a reference to a task, that person’s card displays the 

 icon, which indicates that a task is associated with that person. 

To view tasks associated with a specific person: 

 Click the  icon in a person’s card to open the following window: 

 

NOTE You can also view a list of tasks associated with a given person by 

accessing the person’s card and clicking the More tab in the card. 
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Note that this window is very similar to the Manage To-Do Tasks window, 

except that it only includes those tasks associated with the given person 

whose information you are viewing, since the selected person is selected in 

the Tasks for menu. 
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Premium Membership 
About This Chapter: 

This chapter introduces Family Tree Builder’s Premium Membership features, and 

describes their benefits and how to obtain a Premium membership. It contains 

the following sections:  

 Overview describes Family Tree Builder’s Premium Membership features. 

 Getting Premium Membership describes how to obtain Premium 

Membership. 
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Overview 
Family Tree Builder is available free of charge from MyHeritage.com. Simply 

navigate to the site and follow the instructions that describe how to install it on 

your computer. 

In addition, optional Premium subscription plans are provided for very large 

family trees or photo collections. This Premium membership also provides access 

to some nice added features, as described in this section. 

The MyHeritage.com website enables you to upgrade to a Premium membership 

and describes the added benefits that it provides: 

 Basic membership is free. 

 Premium membership provides the option to add many more people to your 

family tree and many more photos to your collection in addition to added 

functionality. 

 Premium Plus membership provides the option to add an unlimited number 

of people to your family tree and an unlimited number photos to your 

collection in addition to added functionality. 

The following describes the additional features that you get with a Premium 

membership in Family Tree Builder. 

Merging of Smart Matches 

Smart Matches help millions of users on MyHeritage.com discover new relatives 

by finding connections between family trees. Now, with the new Smart Match 

Merge features, you can easily merge information from any matched family tree 

into your own family tree. 

An intelligent wizard guides you through the merging of names, dates, places, 

notes, photos and any other fact of any matched person. 

And, there is more. You can merge additional information about the parents, 

spouses, brothers, sisters and children of this person too! 

In order to use Smart Match Merge, you must upgrade to a Premium account on 

MyHeritage.com. 

http://www.myheritage.com/
http://www.myheritage.com/
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All-in-One Charts 

The All-in-One Chart is a great tool for seeing the big picture in your family tree. 

This is a chart that contains ALL relatives of any given person. You can print is as 

a poster of the entire family tree or email it to your family. 

In order to create All-in-One Charts, you must upgrade to a Premium account. 

Full Map Support 

Maps are a great feature for viewing your family history on an interactive world 

map. Using our maps, you can explore your family’s origins and gain better 

knowledge of your family. 

The free version of Family Tree Builder shows only some of the places mentioned 

in your family tree on the map. To see all of the places in your family tree on the 

map, you must upgrade to a Premium account. 

Search MyHeritage Trees 

A Premium Plus membership enables you to use MyHeritage’s SuperSearch 

online research engine to search all MyHeritage family trees that were created by 

other MyHeritage users. Basic users and those with a Premium membership must 

purchase a Data Subscription to use SuperSearch. 



Premium Membership 

Family Tree Builder User’s Guide 
 

- 164 - 

Getting Premium Membership 
A variety of options are provided in the Family Tree Builder interface for accessing 

the option to upgrade to Premium membership, as follows:  

 Click the icon in the toolbar in the top left of the Family Tree Builder 

window. 

 Click the Upgrade me to Premium button in the following window that is 

displayed when you launch Family Tree Builder and when you try to access a 

premium feature:  
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The following window is then displayed if you already have more than one family 

site in MyHeritage.com. 

 

This window enables you to select the site that will be upgraded to a Premium 

membership.  

NOTE You only have to pay once in a lifetime for a Premium membership in 

order to get all the Premium features of Family Tree Builder. The 

Premium membership also gives you an upgraded Premium family site. 

The family site subscription is automatically renewed each year, but you 

can cancel it at any time via the My purchases page, which is accessible 

from the account dropdown in your family site. Even if you cancel the 

Premium subscription for your family site, Family Tree Builder’s 

Premium features will still be available to you. 

 

If you do not have any sites, then you can enter the name of your new site. 

Select the plan you want to upgrade to (Premium or Premium Plus) and the 

number of years. After payment is made, your Family Tree Builder program will 

unlock Premium features. 
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A web page then displays, enabling you to pay and upgrade your Family Tree 

Builder. 

  

 

 

 



 

 CHAPTER 5 

Handling Photos 

and Other Media 

 
 



Handling Photos and 

Other Media 

Family Tree Builder User’s Guide 
 

- 168 - 

Handling Photos and 

Other Media 
About This Chapter: 

This chapter describes how to add, annotate and automatically mark faces in 

photos and how to use documents and video/audio files to enrich your family 

tree. It contains the following sections:  

 Overview describes Family Tree Builder’s powerful photo handling tool. 

 Media Types describes how to enter a variety of types of information and how 

to associate various types of media with this information. 

 Photos in Tree View describes how to edit a photo in the Tree View.  

 Viewing and Managing Photos describes a variety of options for viewing 

photos, associating photos with people and facts, and adding information 

about photos. 

 Photos People List lists the people that you have defined in Family Tree 

Builder. 

 Photos List shows all or some of the photos defined in Family Tree Builder, 

according to your specifications. 

 Adding New Photos enables you to add photos, documents and video and 

audio files to your family tree. 

 Editing a Photo enables you to benefit from the wonderful photo features 

provided by Family Tree Builder. 

 Photo Albums lists the photo albums that you have defined in Family Tree 

Builder. 

 Image Viewer Window displays a large view of the photo, its name, place and 

date it was taken, and provides a list of the people that are marked in it. 

 Photos Menu Bar describes the menu options that appear in Media View. 
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Overview 
Powerful photo handling is one of the strongest and most helpful features of 

Family Tree Builder. This special feature, created by MyHeritage, represents a 

significant improvement of GEDCOM’s specification for photos (for more 

information, see GEDCOM and Family Tree Builder). 

Photos are invaluable for genealogy research and help bring a family tree to life. 

By scanning old photos, adding them to your project on Family Tree Builder and 

properly annotating them, you will store the treasures of your family’s history. 

This enables your family, relatives and friends to enjoy these photos in more ways 

than you may have thought possible.  

Adding old photos will most likely also benefit your research, because they can 

often jog the memory of older relatives and lead to the discovery of information 

that cannot be found elsewhere.  

NOTE The term photo and media may be used interchangeably in this chapter. 

Media may refer to a photo, document or video/audio file. 
 

The Family Tree Builder photo handling tools enable you to: 

 Add a photo just once and then associate it with a variety of relevant entities 

in Family Tree Builder so that they are displayed together, such as elements in 

the family tree, a person, a family, personal facts, family facts, a source and 

more. 

 Browse photos according to level of interest, including tooltips that show a 

photo and a summary of relevant information. For each person, a Personal 

Photo is displayed if one was specified. Otherwise, an anonymous silhouette 

is shown. We found that it is much more intuitive to navigate inside a family 

tree when photos are displayed for each individual, especially if you are 

highly familiar with that family tree. This intuitive navigation is one of the 

most useful capabilities of Family Tree Builder. 

 Import large numbers of digital photos into your Family Tree project all at 

once. 
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 Tag photos. Mark where people's faces appear in photos in order to show who 

is who. This is particularly useful for group photos, which contain more than 

one person. This is much better than a textural description, such as, 

“Grandma is the 14th person on the right, on the sixth row from the bottom.” 

 Designate any marked face as a Personal Photo of a person, meaning that it 

will become the portrait photo representing that person, which appears in the 

Tree View and in various reports. This saves having to use or create a separate 

personal portrait photo. 

 

 This is an improvement over other genealogy products, which can only specify 

a specific person’s photo as primary and show it in reduced size. In these 

products, photos often include more than just the face, such as a full body 

shot, which when reduced, becomes an unidentifiable miniature. This is not 

the case in Family Tree Builder. 

 View both sides of a scanned photo as a single entity. Old photos often have 

important inscriptions and dedications on their reverse side. Family Tree 

Builder enables you to associate a scan of the reverse side with the front side 

of each photo, instead of treating them as separate photos. 

 Run powerful photo searches. For example, search for all of the photos taken 

with a relative, in a certain place (or a similar-sounding place, using 

Soundex), at a certain date, or all the photos of a person and their 

descendants. 
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Media Types 
Family Tree Builder enables you to enter a variety of types of information, as 

described throughout this manual, and to associate various types of media with 

this information: photos, documents (such as a Word file or a PDF of a scanned 

birth certificate) and multimedia (video/audio). Some examples of how media 

files may appear in Photos View are shown below: 

  
 

Document Photo Video/Audio 
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Photos in Tree View 
You can set a personal photo for each person in the tree, which represents this 

person in many places.  

 

An anonymous silhouette is shown for people who do not have a personal photo. 

 

To add a personal photo, click this person’s silhouette in the Tree View. A window 

opens that walks you through the process for adding a new photo and setting it 

as the personal photo of this person. 
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If a person already has a personal photo, you can double-click it in the Tree View 

to edit the photo's property. To replace the personal photo, right-click the photo 

in the Tree View and select Replace Personal Photo from the menu. 

 

Select Edit Personal Photo to change the information about the current personal 

photo. Select Clear Personal Photo to remove this person’s personal photo. 
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Viewing and Managing Photos 
The Photos View provides a variety of options for viewing photos, associating 

photos with people and facts and adding information about photos. 

To view and manage photos: 

 Click the  button in the toolbar. The Photos View window is displayed, 

as shown below: 

 

This window contains the following areas: 

 Photos People List lists all the people that you have already defined in Family 

Tree Builder and enables easy access to their photos.  

 Photos List lists photos according to your request. It may show all the photos 

defined in Family Tree Builder, all the photos that are associated with a 

person or any other filtered list of photos that you specify by indicating in 

what or in whom you are interested. 

 Photo Display Options enables you to control how photos are displayed in 

this window. 

Photo 

Handling 

Options 

Search 

Options Photo 

Display 

Options 

Photos 

List 

People  

List 

Quick Find 

Options 
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 Quick Find Options enables quick access to a photo according to a person’s 

name. 

 Photo Handling Options enables you to add photos, edit information, mark 

faces and view or delete photos. 

 Advanced Photo Search provides advanced options for searching for photos 

in your project. 
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Photos People List 
The People List in Photos View lists all the people that you have defined in Family 

Tree Builder. It behaves in the same way as the People List that appears in Tree 

View. 

 

To display all the photos associated with a specific person: 

 Double-click a person’s name in the People List to display all the photos that 

are associated with that person. Instructions for associating a photo with a 

person are provided in Associations Tab. 

NOTE When you are in the Photos View and you right-click a person in 

the People List, the menu that opens shows some additional 

options, in addition those that are available when you are in the 

Tree View. See People List. 
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The following shows the options available by right-clicking a person in the People 

List: 

 Display in Family Tree: Displays the person card for the selected person. 

 Manage Photos: Opens the Photos tab in the Photos View for the selected 

person. 

 Associate with Photo: Associates this person with the selected photo(s). 

 Associate Fact with Photo: Opens the Select Fact window, where you can 

select a fact of the selected person and associate it with the selected 

photo(s). 

 Charts: Enables you to create a chart for the selected person. See Charts. 

 Reports: Enables you to create a report for the selected person. See Reports. 

 Profile Page: Displays the full profile page for the selected person. See 

page 66. 

 Research [Person Name] on SuperSearch: Opens an external browser, 

displaying the record matches results list for the selected individual. 

 Relation to [Home Person]: Displays a window that describes the relationship 

between the selected person and the Home Person. 

 Relation to: Displays a window in which you can select another person to see 

the relationship between this person and the selected person. 
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Photos List 
The Photos List is displayed in Photos View when the Photos button is selected. It 

shows any of the following: 

 All the photos defined in Family Tree Builder. 

 Only photos relevant to the current person or family. 

 Only photos that match the options you have specified, such as in the View 

field. 

TIP Double-click a person in the People List to display all their photos. 

 

Photos are initially listed in a table in the order in which they were added to the 

project, starting with the first photo: 
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Photo Display Options 
The following describes the options that enable you to control how and which 

photos are displayed in Photos view:  

Photos View 

The View field enables you to select any of the values in the dropdown menu in 

order to specify which photos are displayed. 

 

The following types of options are available: 

 All: Shows all the photos in your family tree. 

  [Full Name]: Shows all the photos for the named person. 
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Photos Type Display 

This section enables you to define what types of media are listed in the list. 

To specify the media type display: 

 Under the View field, you can click the Photos checkbox to display photos, 

the Documents checkbox (Word, PDF and so on) to display documents and 

the Video/Audio checkbox to display video and audio files. 

 

Checkboxes 



Handling Photos and 

Other Media 

Family Tree Builder User’s Guide 
 

- 181 - 

Photos Format Display 

 

To specify the photos format display: 

 Select the Table radio button in the Format area to display the photos as a 

table. 

 

 The Table option then displays a thumbnail and the title of the item, its 

albums, its type, date and place. You can sort the list by any of these columns 

by clicking the column's header at the top of the list. 
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 Select the Thumbnails button to display only photo thumbnails, as shown 

below: 

 

 In this view, you can see more photos, but less information about each photo. 

To adjust the size of the thumbnails: 

 You can adjust the size of the thumbnails using the slider on the top right of 

the window. Moving it towards XXL (Extra-Extra Large) on the right side makes 

the thumbnails larger, and moving it towards S (Small) on the left side makes 

the thumbnails smaller. 
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To mark identified faces: 

 You can click the Show marked faces checkbox to mark the faces identified in 

each photo, as shown below. Each person has one Personal Photo that 

represents him/her in Family Tree Builder, such as in Tree View. By default, 

the photo that contains this Personal Photo marks the face in a blue 

rectangle. Other occurrences of that person’s face are marked by a red 

rectangle. Blue rectangles are used for people's personal photos (those that 

appear in people's cards in the Tree View) and red rectangles are used for 

other photos where people are tagged. 
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To display more information: 

1 You can hover over a photo to display a larger photo image and more textual 

information, as shown below: 

 

2 You can also double-click the Photo View and edit information about a photo. 

Sorting Photos 

You can click a column header to sort the photos according to that column. 
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Quick Find Options 
The Quick Find area above the People List enables quick access to a photo 

according to a person’s name. You may refer to Quick Find for a description of this 

feature, which is the same as in Tree View. 

The People List also enables you to sort this list by first name, last name, birthday 

date, death date, relationship and more. Click a person in the list to show their 

photos. 
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Photo Handling Options 
The following buttons enable you to add, edit, view or delete photos: 

 

 New: Opens a wizard that walks you through adding new photos or any other 

media to Family Tree Builder. 

 Edit: Opens the Edit Photo window, where you can define various 

characteristics of the photo. 

 View: Opens the Image Viewer, which provides various display options. 

 Delete: Removes the selected photo(s) from your project. 

You can also right-click a photo to display the following menu: 

 

This menu provides the following additional option: 

 Associations: Displays the people in this photo. You may select a person from 

this list to display them at the center of the Tree View (see Associations Tab 

for a description of how to define associations). You can then click the Back 

button in the toolbar to go back to the Photos List. 
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Adding New Photos 
Family Tree Builder enables you to add photos, documents and video and audio 

files to your family tree. 

Family Tree Builder provides a simple process for importing all your digital photos 

in a single process. These photos are then available for you to associate with the 

members of your family tree. 

To add one or more photos: 

1 Click the  button as shown below, and then select the type of 

media you want to add (Photos, Documents, Videos or Audios): 
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If you select to add photos, the following window is displayed (a slightly 

different version of this window is displayed if you select another media 

type): 
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2 Click the  button to display a Select Photo Files window: 

 

3 Select a file and click . You also have the option of selecting 

multiple photos using the Ctrl and Shift keys on your keyboard. When you 

have selected all the photos you want to add, click Next. 
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4 If you have set up albums in your project, the following window enables you 

to select the album of the photos you are adding (see Photo Albums): 
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5 Select the album to which you want to add the photo and click Next. The 

following window is displayed: 

 

6 The photo has now been added to you project. Click Finish to edit the photo 

details and add a title, date, place and identify people in this photo. After you 

add a photo, you can always enter more information about it by selecting the 

photo in the Photos List and then clicking the Edit button, or by 

double-clicking it. 
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Editing a Photo  

Editing a photo in Family Tree Builder enables you to benefit from many wonderful 

photo features. 

The Edit Photo window, shown below, is displayed: 

 Automatically after you finish adding a single photo. 

 When you double-click a photo in Photos View or Tree View. 

 When you select a photo and click the Edit button. 

 

 

The Edit Photo window provides a number of tabs that enable you to handle the 

photo and associate it with information. 

This window contains the following areas: 

 People List: Lists all the people that you have already defined in Family Tree 

Builder and enables you to easily select a person that appears in this photo. 

 Photo Information: Provides a number of tabs in which you can specify 

information about the photo. 

People List 

Status Bar 

Photo 

Information 

Marked 

Face 

Photo Zoom Tools 
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 Photo Zoom Tools: The following tools are provided for customizing the 

display of the photo, as follows: 

▪ Zoom In : Enlarges the view of this photo. 

▪ Zoom Out : Reduces the view of this photo. 

▪ Fit to Window : Resizes the display of the photo so that all of it is 

displayed in the current window size. If you enlarge the window, the photo 

will adjust its display size accordingly. 

 Status Bar: Shows the file type of the photo, its size in pixels and the 

percentage of its size at which it is displayed: 

 

Photo Information 

At the top of the Edit Photo window, tabs are provided for entering information 

about the photo. 

Info Tab 

The Info tab enables you to enter the title or name of the photo, which will appear 

next to it wherever it appears in Family Tree Builder. You can also enter the date it 

was taken and the place where it was taken (for details about entering dates, see 

Entering Dates). 
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Associations Tab 

The Associations tab enables you to identify the people in the photo or to 

associate this photo with a particular fact about a person or a photo. 

 

The list in the center shows the people, families or facts that have already been 

associated with the photo. The icon to the left of each description indicates what 

it is associated with, as follows: 

 : Indicates a person. 

 : Indicates a fact. 

 : Indicates the virtual cemetery. 

 : Indicates a family. 

 : Indicates a source. 
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To associate a person with a photo, do one of the following: 

 Right-click the relevant person(s) in the People List and select Associate with 

photo, as shown below: 

 

 Select the relevant person(s) in the People List and click the Associate button. 

 Click the arrow to the right of the Associate button and select Person. 

 Drag the person from the People List and drop it onto the photo. If a face was 

identified, you can drop it into the relevant green rectangle. 

 Click the Associate button and then select the person from the Associate 

Person with Photo window. 

NOTE Once a person is associated with a marked face, a red rectangle 

marks that person’s face. 
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Associating Other Information with a Photo 

In addition to people in a photo, you can also associate other information from 

the family tree with a photo by clicking the down arrow to the right of the 

Associate button, as shown below: 

 

  Person: Selecting this option opens a list of people who you can associate 

this photo. 

  Fact of Person: This option displays a list of people, which you can select. 

After selecting a person, the window below is displayed. In this window, you 

can select a fact about that person to associate with this media. You can also 

define a new fact for that person, if required.  

 

 For example, you can associate an immigration fact about a person with a 

photo of the ship used for the voyage, or an education fact with a photo of the 

school and so on. 
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  Family: Selecting this option displays the following window, where you 

can select a family to associate with this photo. 
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 Fact of Family: Selecting this option first displays a list of families for your 

selection. After selecting a family, the window below is displayed. In this 

window, you can select a fact of that family to associate with this photo. You 

can also define a new fact for that family, if required. 
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 Source: Selecting this option displays the list of sources for your selection. 
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Face Recognition - Marking a Face 

Family Tree Builder enables you to mark specific faces in a photo and to associate 

this marking with a specific person. This is very useful in group photos, like the 

one shown below. After a person’s face has been marked, that person’s name is 

automatically displayed when you hover over the photo. 

 

Family Tree Builder also provides a wonderful feature that automatically identifies 

faces in a photo. Faces that are automatically identified are marked by a green 

rectangle. This option is turned on by default, or it can be turned off/on in the 

Options tab. 
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You may click the  button on the bottom right of the Edit Photo window to 

display a legend reminding you that: 

  Automatically identified photos are highlighted by a green rectangle, 

as described above. 

  Manually marked faces in photos are highlighted by a red rectangle. 

  The face in a photo that you marked as the Personal Photo is 

highlighted by a blue rectangle.  

NOTE Personal Photos: Family Tree Builder enables you to assign a 

single picture to each person in order to represent them wherever 

possible, such as in a report, in a thumbnail that is displayed 

when you hover over a person, in a list or when they are shown in 

Tree View. Typically, this photo should be a portrait of their face. 

 

To mark a face:  

1 Select the name of the person in the Associations list. If that person does not 

exist in the list, then add him or her. 

2 Click the  button. The cursor becomes a crosshair. 

3 Click and drag to draw a box around the person’s face. 

4 You can then resize or move the box as necessary. 

NOTE The little white boxes on the Mark Face rectangle are called 

handles, and they indicate which box is selected. You can click on 

them and drag them to resize the box. 
 

5 Check the Personal Photo checkbox to specify that a specific photo is the 

Personal Photo, which will represent that person in various places in Family 

Tree Builder, such as Tree View. The box is then displayed in blue. The 

dimension of a Personal Photo always retains the height/width proportions of 

3x4 and thus will force the shape of the rectangle to these proportions. 
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Photos Notes Tab 

The Notes tab, shown below, enables you to enter notes describing the photo: 

 

Reverse Side Tab 

Old photos often have important inscriptions and dedications on their reverse 

side. Here is an example of the information that is displayed when you hover over 

a photo that has a reverse side: 

 

Family Tree Builder enables you to add a scan of the reverse side of a photo, 

instead of treating it as a separate photo. 
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To define a reverse side: 

1 In the Reverse Side tab, click the Select button. A file selection window is 

then displayed. 

2 Select the file of the reverse side and click Select. 

 

Once a reverse side is defined, you can click View to view it, or click the 

Delete button to remove this photo's reverse side. 
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Options Tab 

The Options tab provides the following options: 

 

 This image is a scanned document: Check this option when the media file is 

in a format that may be used for a photo, such as JPEG, even though it is a 

scanned document. 

 Turn off automatic face detection for all photos: Check this option to turn off 

automatic face detection for all photos. Automatic face detection marks faces 

that are found in photos in green. 

 Turn off automatic face detection for this photo: Check this option to turn off 

automatic face detection for this photo only, which marks faces that are found 

in the photo in green. 
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Photo Albums 
The Albums List in the Photos View lists all the photo albums that you have 

defined in your project. 

 

When handling photos in Family Tree Builder, you can choose whether to put 

them in one or more photo albums. You can add a photo to an album when you 

initially add the photo (see Adding New Photos), or at any future point in time. 

The Photos List contains a column that indicates the album(s) to which a given 

photo belongs. 
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When you sync your family tree to a family site, the album structure that you 

created in Family Tree Builder is reflected in the album structure of the photos in 

the family site, as shown in the example below: 
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To view the photos of a specific album, simply click the album name in the 

Albums List. 

 

To add an album: 

 In the Albums tab, click the New button, and then specify a name for the 

album. You can now add photos to this album. 
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To delete an album: 

 In the Albums tab, click the album that you want to remove, and then click the 

Delete button. Note that this action does not delete any photos from your 

project, but only the album. Any photo that is in this album will remain in your 

family tree. 

To add a photo to an album: 

 Click a photo in the Photos List and then drag it into an album in the Albums 

List. A photo may belong to more than one album. You can also add a photo 

to an album when you initially add the photo to your project, as described in 

Adding New Photos. 
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Image Viewer Window 
The Image Viewer is a tool for displaying a full version of a photo. Open it by 

performing one of the following actions: 

 Click the View button in the Photos View. 

 Right-click a photo and select View. 

This displays a large view of the photo including its name, and the place and date 

it was taken. It also provides a list of the people who are marked in the photo on 

the right, as shown below: 
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These tools enable you to browse through the images listed in Photos View and 

provide various display options, as follows: 

 : Goes to the first image listed in Photos View. 

 : Goes to the previous image listed in Photos View. 

 : Goes to the next image listed in Photos View. 

 : Goes to the last image listed in Photos View. 

 : Zooms out. The relative size of the image that is displayed in the window 

(for example 30%) is shown on the bottom right of the window. 

 : Zooms in. The relative size of the image that is displayed in the window 

(for example 150%) is shown on the bottom right of the window. 

 : Displays the image in its actual size, meaning 100%. 

 : Prints the image. 

 : Sets this image as the background for your desktop (also called 

wallpaper). 

 : Toggles on and off the display of the Image Information panel, which 

shows the image’s name, place and date it was taken, and provides a list of 

the people that are marked in it on the right. You can click the arrow to the 

right of this tool to specify that the image information be displayed on the 

top, bottom, right or left of the image, or if it should be a separate window. 

 : Opens the About MyHeritage Image Viewer window. 

The menu options provided in the Image Viewer perform the same functions as 

above with a few simple and clear additions. 
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Photos Menu Bar 
When Family Tree Builder displays the Photos View, some additional menu 

options are available from the main menu: 

 Photos Menu 

 Albums Menu 

Photos Menu 

The following describes each of the options in the Photos menu:  

 

 Edit: Opens the Edit Photo window, where you can define various 

characteristics of the media. (See Editing a Photo) 

 View: Opens the Image Viewer, which provides various display options. (See 

Image Viewer Window) 

 Delete: Removes the selected photo(s) from your project. 

 New: Opens a wizard that guides you through adding a new photo or any 

other media item to your project. (See Adding New Photos) 

 Restore photos from family site: Use this option if you do not have all of the 

photo files in your project. This may happen if the photo files were deleted 

from your computer or if you restored your project from a backup. If you have 

synced your project to a family site, you can restore the photos by copying 

them from the family site. 
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 Create Thumbnails: Generates thumbnails for photos. Use this option if you 

see that some of the photos in the Photo List show a placeholder camera for a 

photo. 

 Produce Report: Produces a photo album. 

Albums Menu 

The following describes each of the options in the Albums menu: 

 

 Show albums: Toggles to show or hide the Album List on the left side of the 

main window. 

 New album: Creates a new album and provides a name for it. 

 Delete album: Deletes the selected album in the Album List. 

 Rename album: Provides a new name for the selected album in the Album 

List. 

 Import Photos: Scans your computer for photos and selects which of them to 

add to your project.  
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Smart Matches 
About This Chapter: 

This chapter describes how to find out whether the people in your family tree 

match people in other family trees on MyHeritage.com. It contains the following 

sections: 

 Overview describes how to match people in your family tree with people in 

other family trees. 

 Matches in Tree View describes how a person who is a potential match with 

someone in your family tree appears in Tree View. 

 Smart Matches Window describes the functions provided by the Smart 

Matches window. 
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Overview 
Family Tree Builder enables you to match people that you have defined in your 

family tree with people in other trees that members all over the world have 

created on MyHeritage.com. Other people may have the same people in their 

family tree as you have in yours. This provides you with an opportunity to 

significantly expand your family tree by automatically finding links between your 

family and others through Family Tree Builder. Remember, if someone else has 

the same person in their family tree as in your family tree, then they may be your 

family too! 

When you use the Smart Matches feature, each person in your family tree is 

compared with all the people in all the other family trees on MyHeritage.com. You 

can then review the list of people that Family Tree Builder suggests may be a 

match. Afterwards, you can confirm or reject the match by reviewing the people’s 

personal information and photos. Confirming a match creates a link to that 

person in the other tree. You can also merge items (information, photos, notes) 

from their family tree into your own. 

When you create a new family tree, or when you add people to your tree, it is 

always recommended to sync the tree to MyHeritage.com in order to receive 

Smart Matches. The Smart Matches feature in Family Tree Builder makes syncing 

your family tree even more interesting. It opens the door for Family Tree Builder to 

enable others to check if the people in your tree are a match for theirs. This 

means that you may have new and previously unknown family members making 

contact with you very soon! 

NOTE In order to receive Smart Matches, your computer must be connected to 

the Internet. 
 

In Tree View, the Smart Matches application indicates that a potential match has 

been found for a person. It does so by showing an icon in that person’s card, as 

described on this page. The Smart Matches application also provides a window 

that reviews your entire family tree, compares all the people in your tree to those 

on MyHeritage.com and then shows you the Smart Matches. 
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Family Tree Builder uses the first and last names, birth and death dates and 

relationships with other people in the tree to find potential matches for the 

people in your family tree. These potential matches are presented to you with a 

percentage score, indicating how closely they match. You can then confirm or 

reject them as being the same person. 

Matches in Tree View 
The Smart Matches option indicates whether a potential match has been found 

for a person in Tree View by showing the  icon on that person’s card, as shown 

below: 

 

Each time you add a person or update the details of a person, Family Tree Builder 

rechecks if any matching people can be found in other family trees. While it is 

checking, the  icon appears gray. If one or more matches are found, this icon 

then turns green and blinks for a few seconds. If no matches are found, this icon 

disappears from that person’s card in Tree View. 

NOTE In order to receive Smart Matches, your computer must be connected to 

the Internet. 
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If the  icon is green, then you can hover over it to display the following: 

 

This popup indicates how many people are potential matches in other trees. In 

the window above, this number is 532.  

Clicking the  icon on that person’s card in Tree View opens the Matches tab in 

the Smart Matches window. 
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Smart Matches Window 
The Smart Matches window is displayed by doing one of the following: 

 Clicking the  button in the toolbar opens the Overview tab in the Smart 

Matches window. 

 Clicking the  icon in a person’s card in Tree View opens the Matches tab in 

the Smart Matches window. 

The Smart Matches window contains three tabs, as follows: 

 The Overview Tab shows either a list of people in your family tree that have 

matches or a list of other family trees in which those matches where found. 

 The Matches Tab shows the matches for a specific person in your family tree. 

 The Compare Tab graphically compares a person in your family tree to the 

potentially matching person in someone else’s family tree. This enables you 

to merge the information from the compared family tree into your own family 

tree. 
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Smart Matches and Syncing 

The Smart Matches feature finds matches to people in family trees of other 

MyHeritage users. Therefore, it is recommended that you also sync your family 

tree to a family site. If you have not already done so, the following window is 

displayed when you open the Smart Matches window: 

 

Click Yes to set up a family site if you have not already done so, and then sync 

this tree to the family site. 
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Overview Tab 

Clicking the  button in the toolbar opens the Overview tab in the Smart 

Matches window. 

The Overview tab shows a list of the people in your tree that match people in 

other family trees, as shown below: 

 

Family Tree Builder compares all the people in your family tree with all the other 

people in all other trees on MyHeritage.com, in order to identify those people that 

may match the people in your tree. It then displays each person in your tree that 

has a match in a row of the Smart Matches Table. 

View Smart 

Matches Area 

General Smart 

Matches 

Information 

Smart Matches 

Table 
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The following columns describe each person in this window. You can sort this list 

by clicking the column header: 

 Photo: Shows the personal photo of this person. 

 Matches: Specifies how many matches were found for this person in other 

trees. 

NOTE If no matches were found for a person in your tree, then that person 

does not appear as in this window. 
 

 Name: Specifies the name of this person in your tree. Click the name to 

display all of the person's matches. 

 Birth Date, Birth Place, Death Date: Specifies these details for the person in 

your family tree. 

View Smart Matches Area 

The top section of this tab enables you to select whether to display the matches 

By people or By trees: 

 Viewing this window By People shows which people in your tree have 

matches and how many matches they have, as described above. 

 Viewing this window By Trees shows the family trees in which you have 

matches and how many matches each has. This may help you identify other 

family trees that contain numerous people that match your family tree, thus 

enhancing the possibility that you have found new family members! 

The top section of this tab also shows general information about the Smart 

Matches shown in this window, such as how many people have been found in 

other trees on other sites that match the people in your tree. 

NOTE The Update Now button can be clicked to update and refresh the 

displayed data. 
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View Smart Matches by Trees 

To view a list of family trees that match people in your family tree, click the By 

trees option in the View Smart Matches area: 

 

The following columns describe each matching family tree in this window. You 

can sort this list by clicking a column header: 

 Matches: Specifies how many matches were found in this tree. 

 Tree name: Specifies the name of the family site and the name of the family 

tree in this site. Click the name to view all matches from this family tree. 

 Site address: Specifies the address of this family site. Click the address to 

view this family site in your web browser. 

 Site owner: Specifies the name of the manager of this site. Click the name to 

view more information about this member in your web browser. 
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Right-click Menu – Overview Tab 

You can right-click a row in the Smart Matches table to display the following 

menu: 

 

The following describes the options in this menu: 

 Display Smart Matches for [Person’s Name]: Displays this person in the 

Matches tab as described below. You can also click a person’s name or 

double-click a line to view the Matches tab. 

 Display in Family Tree: Displays the selected person in Tree View. 

 Edit Details: Opens the Edit Details window for the selected person, in which 

you can update information for that person. 

 Relation to Home Person: Displays a window that describes the relationship 

between the selected person and the Home Person. 

 Relation To: Displays a window in which you can select another person to see 

the relationship between this person and the selected person. 
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Matches Tab 

The Smart Matches icon  that appears on a person’s card in Tree View 

indicates that a potential match has been found for the person: 

 

Clicking the  icon opens the Matches tab in the Smart Matches window. 

NOTE 
You can also display the Matches tab by clicking the  button in the 

toolbar. This opens the Overview tab in the Smart Matches window. You 

can then click a person’s name to view this person's matches in the 

Matches tab. 

 

The Matches tab in the Smart Matches window lists the people in other family 

trees that match a specific person in your family tree, as shown below: 

 

General Smart  

Matches 

Information 

Smart Matches 

Table 
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General Smart Matches Information 

The top-left part of this tab shows general Smart Matches information, such as 

how many people in other trees have been matched to the selected person. The 

window above indicates that there are 532 potential matches.  

The Update Now button refreshes the displayed data from the MyHeritage.com 

database. 

NOTE Some matches may not be shown in this window because their names 

(or other information) are slightly different. You can customize the 

strictness of matches in the Options window. 
 

The Table of Potential Matches 

This window presents one row for each person in the Smart Matches table. The 

top row is highlighted in beige and represents the person in your tree for whom 

you are checking for matches. Each subsequent row represents a match to a 

person in another tree. These matches appear in the order of their Quality, 

meaning how accurate Family Tree Builder assesses the match to be. The higher 

the score, the greater the certainty that the match is accurate. The quality is 

higher as more of the data about the two people are the same. 

You can hover over the data in any column to display more information about this 

person. For example, the following is displayed when you hover over the Quality 

column of a person in this window: 
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The fields in this window are color-coded, as follows: 

 Green: These fields are identical or similar for these two people.  

 Red: These fields are different for these two people. 

 Black: These fields do not exist for either of these two people. 

The following describes the columns of this window. You can sort this list by 

clicking the column header. 

 Photo: Shows a photo of this person in the other tree. 

 Status: Specifies whether you have confirmed or rejected this match. This 

column may have one of the following values: 

▪ Empty: This is the starting status for a person who is a potential match. 

▪ Confirmed: This status indicates that you have confirmed that this is the 

same person. 

NOTE You can view the data of this other person and then enter it into 

your tree or create a link to it in the form of a citation.  
 

▪ Rejected: This status indicates that you do not think that this is the same 

person. Rejected people appear at the bottom of the list. 

 Quality: Shows a percentage score indicating how closely Family Tree Builder 

assesses that person is a match. The more details and relatives this person 

shares with the person in your tree, the higher the score. People with a higher 

score have more green fields showing in the popup that is displayed when 

you hover over this field. People with a lower score have more red or black 

fields showing. For example, people with the same name and birth date get a 

higher score than someone with the same name, but a different birth date. 

Also, someone with the same first name and the same parents may get a 

higher score. 

 Relatives: Specifies the number of direct relatives that the person in the other 

tree has. This is quite interesting, since this may indicate a family tree that is 

full of information. You may be very interested in looking at that tree in order 

to expand your family tree by adding these relatives to your tree. 

 Name: Specifies the name of the person in the matched tree. Click the name 

to open the Compare tab and compare the families of the person in your tree 

with the selected person in the other tree. 
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 Birth date, Birth place, Death date: Specifies this information for the person 

in the other tree. 

 Tree name: Provides a link to the tree of the matched person on the other 

family site. This tree is displayed in a separate browser window and the 

matched person is in focus in the tree.  

 Site owner: Provides a link to the personal information of the owner of the 

matched site. 

Right-click Menu – Matches Tab 

You can right-click a row in the Smart Matches Table to display the following 

menu: 

 

The following describes the options in this menu: 

 Compare this match: Displays this person in the Compare tab, which is a 

graphical representation of the tree compared with the person in the other 

tree. This behaves the same way as when you click a person's name that is 

displayed as a link. 

 Change status of this match: Enables you to confirm or reject whether this is 

the same person. The word Confirmed or Rejected then appears in the 

rightmost column of the table of this person’s row in the Matches tab. 

 Visit tree: Displays the entire tree of the matched person in a separate 

browser window. This behaves the same way as when you click a tree’s name 

that is displayed as a link. 

 Contact: Opens a window in which you can compose an email message to the 

site owner. 

 Visit profile of tree owner (site owner name): Provides a link to the personal 

information of the owner of the matched site. This behaves the same way as 

when you click an owner's name that is displayed as a link. 
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Change Status of the Match 

The Change the Status of this Smart Match window enables you to confirm or 

reject whether the matched person is the same person as in your tree. 

 

This window can be displayed by one of the following methods: 

 Right-clicking any row (excluding the first one) in the table shown in the 

Matches tab, and selecting the Change Status of this Match option in the 

menu that is displayed. 

 Selecting any row (excluding the first one) in the table shown in the Matches 

tab and clicking the Change Status… button. 

You can select one of the following options in the window and click OK: 

 Undetermined: This is the starting state for a person that is a potential match. 

This indicates that you have not yet confirmed or rejected this match. Use this 

option when you change your mind, after having confirmed or rejected the 

match in the past. 

 Rejected: This status indicates that you do not think that this is the same 

person. Rejected people appear at the bottom of the list in the Matches tab. 
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 Confirmed: This status indicates that you have confirmed that this is the same 

person. If you select this option, an additional field is displayed, enabling you 

to add a link from this person in your tree to the matched person in the form 

of a citation: 

 

 The window above shows an example of a citation that was added by 

confirming a Smart Match. The bottom of this window provides a link to the 

matched person in the other tree. 

Citation  

including a 

link 

to this 

person  

in another  

Link to this  

person in  

another tree 
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Accessing Additional Matches 

Some matches may not be shown in the Matches tab because their names (or 

other information) differ too much from the person in your family tree. 

If there are additional matches, a special indication appears above the list of 

matches. In the example below, the person has 532 matches, but the list only 

shows 529 matches. There are 3 additional matches that are hidden because 

they differ significantly from the person in your tree: 
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Two links are provided above the list of matches in the Matches tab that enable 

you to access more matches, as follows: 

 Show the additional Smart Matches: This link adds the people who were not 

shown in the list because of the strict definitions in the Options window. 

These people are displayed in gray. 

 Change Smart Matching Options: This link displays the Options window, 

where you can customize how strict the Smart Matching feature is when 

comparing similar information, as shown below: 

 

 This window contains the following parameters: 

▪ Auto Match: Specifies whether or not the automatic matching features 

that appear in a person’s card and that show a green  icon are 

activated. Selecting No deactivates the feature that automatically 

searches for matches whenever you add a person or edit a person's 

details. 

▪ Match Similar First Names: Determines whether to match people with a 

similar first name, for example, Robert and Bob. 
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▪ Match Similar Last Names: Specifies how strictly to compare last names 

during Smart Matching. Select one of the options from the dropdown list 

shown below: 

 

Compare Tab 

The Compare tab shows a visual comparison of the person in your family tree with 

the matched person in someone else’s tree, as shown below: 

 

Person in 

another family 

tree 

Status Area 

Person in your 

family tree 
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You can display the Compare tab of the Smart Matches window by performing one 

of the following: 

 Double-clicking any row (excluding the first) in the table shown under the 

Matches tab. 

 Clicking the name of the person in any row (excluding the first) in the table 

shown under the Matches tab. 

 Right-clicking any row (excluding the first) in the table shown under the 

Matches tab, and selecting Compare This Match from the menu that is 

displayed. 

 Selecting any row (excluding the first) in the table shown in the Matches tab 

and clicking the Compare button that appears in the top right part of the 

window. 

Compare Trees 

 

The top part of this window shows the person that is in your tree as the focus of 

his or her family. 

The bottom part of this window shows the matched person in the other tree as the 

focus of his or her family. 

Change 

tree link 
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The middle-right of this window provides a Change tree button that opens a menu 

from which you can view any of the trees where there is a match to this person in 

your tree. 

Each person’s card is color-coded, as follows: 

 Dark Blue: Indicates the selected person in each tree. When you select a 

person in one tree, his or her matching person in the other tree is selected 

automatically. 

 Green: Indicates a relative of the person in your tree for whom a match was 

also found in the other tree. 

 White: Indicates a relative for whom no match was found. 

The name of the matched site and tree, as well as the site owner, is displayed 

above the bottom tree. Clicking these opens a separate browser window to 

display the full tree or the site owner's details. 

Status Area 

 

The bottom part of this window indicates the status of this match, meaning 

whether this match was confirmed, rejected or undetermined. 

The bottom part of this window also shows the Change Status… button, which 

allows you to confirm or reject this match. (See Change Status of the Match) 
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The Quality of Match field shows a score indicating how well this person 

matched. The more details and relatives this person shares with the person in 

your tree, the higher the score. People with a higher score have more green fields 

showing in the window that is displayed when you click the Explanation link. 

People with a lower score have more red or black fields showing in the window. 

You can select Explanation to display the following window: 

This window shows the various types of information defined for this person in 

your tree and in the matching tree, and indicates whether they match in the 

Result field. These fields are color-coded, as follows: 

 Green: These fields are identical or similar for these two people.  

 Red: These fields are different for these two people. 

 Black: The field does not exist for at least one of these two people. 
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Personal Information Cards 

Personal information cards let you compare vital information about the matched 

people quickly and easily. They look like this: 

 

When you select a person in the My tree chart or in the Other tree chart, the 

selected people in the Personal Information cards are changed as well. The top 

card shows the details of the person in your tree and the bottom card shows the 

details of the matched person in the other tree. 

The information is color-coded in the following way: 

 Red: The information is different for these two people. 

 Blue: The information exists for the matched person, but not for the person in 

your tree. 

 Black: The information for the two people is the same. 
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Zooming in under the Compare Tab 

This slider controls the display size of the trees in the window. Slide it to the right 

to enlarge the view or to the left to shrink the view. 

 

To contact a family site owner:  

 Under the Compare tab, click the Contact button to send a MyHeritage 

message to the manager of the matching site. 

TIP The Compare tab enables you to compare your tree to any of the 

matched trees. However, any living people in the matched tree for 

whom you do not have a matching relative in your tree are 

considered private. You can contact the Family Site owner of the 

matched tree for permission to access this information. 

 

Smart Match Merge Utility 

After matching your family tree to trees on other sites, you can use the Smart 

Match Merge Utility to add details, notes and photos about the matched person 

and his/her relatives from the matched tree to your tree. 

NOTE The information for a deceased person is never private. 

 

Merging Information 

You can merge all information about the matching person and his or her relatives 

into your family tree. This can either be done automatically by accepting all the 

intelligently merged information, or performed manually, step by step, confirming 

each data merge separately. 

NOTE This feature is only available for Premium memberships. See Merging of 

Smart Matches for more details. 
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To merge compared tree information into your family tree: 

1 Click the Merge button under the Compare tab, which displays the Smart 

Match Merge Utility window: 

 

This window displays a list of all the people in your tree and in the compared 

tree. For all matched people, both the name of the person in your tree and in 

the compared tree are displayed, as well as their relation to the main person 

and an indication of whether or not new information is available in the 

matching tree. Living relatives of the compared person who you do not have in 

your family tree are considered private and only their last name will be shown. 

New relatives and people who have new information are selected by default. 

You can accept this selection or check and uncheck the people in the list to 

determine which people's information will be merged. 

2 You can now do one of the following: 

▪ Perform an automatic merge, where all items are intelligently merged 

automatically. 

▪ Perform a step-by-step merge, where you can confirm each merge. 
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To perform an automatic merge: 

NOTE This feature is only available for Premium memberships. See Merging of 

Smart Matches for more details. 
 

1 In the Smart Match Merge Utility window, click Automatic merge. The merge is 

performed automatically. This may take a few seconds, as the information is 

copied to your tree. At the end of the process, Family Tree Builder shows the 

following summary: 

 

The information from the compared family tree is merged into your tree and 

the status of each person in the Smart Match Merge Utility window is changed 

to Merged and marked in green. 

2 Click OK to close the window. 

To perform a step-by-step merge: 

NOTE This feature is only available for Premium memberships. See Merging of 

Smart Matches for more details. 
 

 Click Step-by-step merge. 

 The following information can be merged for each person selected in the 

Smart Match Merge Utility window: 

▪ Name 

▪ Birth details 

▪ Death details 

▪ Marriage 

▪ Facts 
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▪ Notes 

▪ Photos 

NOTE The specific merge steps depend on the information available in 

both trees. 
 

For each person who was selected in the list, the Smart Match Merge Utility shows 

a series of steps in a wizard format. Each of the steps in the wizard is described 

below. 

Overview Step 

If you are merging the main person who is compared, the following window is 

shown in the Overview step: 

 

A summary of the details of the person in your tree appears next to the details of 

the compared family tree. 
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Pick one of the following options: 

 Step-by-step intelligent merge of details: Merges the details in a step-by-

step wizard that assists you through the detailed merge procedure.  

 Automatic intelligent merge of all details: Accepts all the defaults of the 

merge wizard for merging the information about this person. 

 Replace all details: Replaces all details about the person in your tree with the 

information about this person in the matching tree. 

Click Skip this person if you do not want to merge information about this person 

and skip to the next person in the list. 

Click Next to display the next steps that show matching information. 

If you are merging information about a relative of the person that is being 

compared, the following window is displayed: 

 

Here, in addition to the options discussed above, you can select whether to merge 

this relative into a relative you already have for this person, or to add this person as 

a new relative in your tree. If this matched relative already matches a similar 

relative in your family tree, then Family Tree Builder will suggest to merge these 

people. Otherwise, you are prompted to create a new relative in your tree. 
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If you select to add a new relative to your tree, you are presented with the Add 

Person window, which includes information about this relative as it was copied 

from the matching family tree: 

 

You can click OK to confirm or add/change details, and click OK when you finish. 

NOTE Click More details to display the person’s card. 
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Name Details 

The Name Details step is displayed when there is new or conflicting information 

about the name of this person in the matching tree. 

 

The top section of the window displays two panels with name details. You can 

choose to keep your names, replace your details with the details from the other 

tree or merge the two intelligently. 

The lower area displays the results of your choice. 

When you are finished, click Next to display the next step. 
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Birth Details 

The Birth Details step is displayed when there is new or conflicting information 

about the birth of this person in the matching tree. 

 

The top section of the window displays two panels with birth details. You can 

choose to keep your birth details, replace your details with the details from the 

other tree (in which case you can choose to add your data as an alternative birth 

fact) or merge the two intelligently. 

The lower area displays the results of your choice. 

When you are finished, click Next to display the next step. 
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Death Details 

The Death Details step is displayed when there is new or conflicting information 

about the death of this person in the matching tree. 

 

The top section of the window displays two panels with death details. You can 

choose to keep your death details, replace your details with the details from the 

other tree (in which case you can choose to add your data as an alternative death 

fact) or merge the two intelligently. 

The lower area displays the results of your choice. 

When you are finished, click Next to display the next step. 
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Marriage Details 

The Marriage Details step is displayed when you are merging the spouse of the 

compared person. 

 

The top section of the window displays two panels with marriage details. You can 

choose to keep your marriage details, replace your details with the details from 

the other tree (in which case you can choose to add your data as an alternative 

marriage fact) or merge the two intelligently. 

The lower area displays the results of your choice. 

When you are finished, click Next to display the next step. 
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Fact Details 

The Fact Details step is displayed for each new fact about this person in the 

matching tree. 

 

The top section of the window displays two panels with fact details. You can 

choose to take this fact or not. 

The lower area displays the results of your choice. 

When you are finished, click Next to display the next step. 
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Notes Details 

The Notes Details step is displayed when there are notes about this person in the 

matching tree. 

 

The top section of the window displays two panels with note details. You can 

choose to take each of the new notes from the matching tree. 

The lower area displays the results of your choice. 

When you are finished, click Next to display the next step. 
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Photos Details 

The Photo Details step is displayed when the person has a personal photo in the 

matching tree: 

 

The upper area displays the person's personal photo in your tree (or a silhouette 

if not) and the personal photo in the other tree. 

You can elect to take the photo from the other tree, determine whether to use it as 

the person's personal photo and determine whether to take the photo from which 

this personal photo was cropped. 
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Smart Match Status 

This step allows you to confirm the match based on the merge. 

 

It is recommended to confirm the match, since you merged information from this 

match. (See Change Status of the Match) 
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Confirm Merge 

The last step of the wizard shows a summary of the merge. 

 

Click Finish to perform the merge and copy the information into your tree. 

A summary of the planned merge is displayed. Check the information and click 

Finish to perform the merge for this person and continue to perform the merge for 

the next person in the list. 
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Maps 
About This Chapter: 

This chapter describes how to manage information about places in your project, 

as well as how to view this information on an interactive map. It contains the 

following sections: 

 Overview introduces the concept of places in Family Tree Builder and how 

place-related information can be used in your project, as well as viewed on an 

interactive map. 

 Managing Places describes how to define and view information about places 

in your project. 

 Using Maps describes the functions provided by the Family Tree Builder Maps 

feature. 
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Overview 
Maps enable you to view your family history on an interactive world map. Using 

the Maps feature, you can explore your family’s origins, gain knowledge of your 

family and perform the following in Family Tree Builder: 

 Fix place names according to smart suggestions and improve your data. 

 Map your entire family tree, any portion of it or just a single place. 

 Map birth places, places of residence, other particular facts or all facts. 

 See all people, events and photos associated with any particular country or 

place. 

 See all places of importance in a person’s life. 

 Find any place on the map. 

The Maps feature works in conjunction with the place-related information defined 

in your project. 
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Managing Places 
The Family Tree Builder uses places in different contexts:  

 Facts about people or families include places, such as place of birth, marriage 

and death. 

 Photos include places where the photo was taken. 

 Contact information can include addresses, which are considered places as 

well. 

Family Tree Builder allows you to manage different places easily. You can make 

sure, for example, that the spelling of a place is consistent throughout your 

project even when information was obtained from different sources. 

You can view a list of all the places specified in the project as well as the number 

of times each is referenced and where. You can also view the location of places 

on a map using Google Maps. 
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To display places information: 

 From the View menu, choose Places to display the Index of places window: 

 

 You can sort this table alphabetically by place name by clicking the Place 

column heading (click again to alternate between ascending and descending 

order). You can also sort the table by clicking the References column heading, 

which sorts based on the number of times the place is referenced in your 

project. 
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 Use the Find box to search for a specific text string that is contained in the 

place name that you want to see. The places matching this string are 

displayed in the list as you type. Click the red  to clear the contents of the 

Find box. 
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To show a place on the map:  

1 Select a place from the list and click Show on map. A menu appears with two 

options: one for showing only this place and one for showing all places.  

2 Select the option to show only this place. Family Tree Builder opens a map 

using Google Maps and displays this place on it: 
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To show where a place is used: 

 To see where a place is used in the project, select the place from the list and 

click Where used to display the Place usage window: 
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 This window shows you the name of the place and the references to this place 

in your project. In this window, you can: 

▪ Click Edit in all references to edit the name of the place in all references to 

this place in your project. Use this option if want to change the way a 

place is spelled. In the Change to box, type in the new name or select one 

of the existing place names that are currently used in the project. 

 

When you finish, click OK to close the window. 

▪ Click Show on map to display the place on a map using Google Maps, as 

described above. 

▪ Click the Open record link for a reference in the Usage list to display the 

person, family or photo window where the place is used. 
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Unifying Place Names 

The Index of Places window may display different spellings of the same place, as 

in the example below: 

 

Using the Places tool, you can easily combine the different spellings. Just select 

the preferred spelling and edit all the others. 
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To unify place name spellings: 

1  From the View menu, choose Places to display the Index of Places window 

(see image above). 

2  Locate the different spellings of the place and choose the spelling you want 

for the name (in the example, we chose London, England over London, 

London England and London, UK). 

3  Select the spelling you want to change and click Where used. 

The Place usage window appears: 
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4  Click Edit. 

The Edit place window appears: 

 

5  Open the Change to dropdown list and select your preferred spelling: 

 

6  Click OK to close the window. 

7  In the Place usage window, click Done. 
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8  Continue to change all inconsistent spellings until only your chosen spelling 

is left. 
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Alternative Place Spelling Suggestions 

Family Tree Builder enables you to edit names of places in various windows, when 

entering places for facts and photos. When you enter a place name in a place 

field, Family Tree Builder searches this place on the map and determines whether 

an alternative spelling exists for this place. 

A special icon is shown in place-related fields that indicates the result of this 

search, as shown, for example, when entering an education-related place in the 

Edit Person, as shown in the window below: 
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The various possible icons are: 

 The light bulb icon indicates that alternative spelling suggestions for this 

place were found. Click the icon to view suggested spelling alternatives, 

which opens the following window: 

 

 You can select one of the suggestions as the name for this place. To do so, 

select the correct entry and click the OK button, or simply double-click the 

entry in the list. 

 Alternatively, if you are satisfied with the spelling that you have entered for 

this place, click the Keep as link at the bottom of the page. 

 After you confirm a place name in this fashion, its icon changes to a green 

checkmark in the Edit Details window (see below). 

 The green checkmark icon indicates that no alternative spelling was found for 

this place. This can happen if you entered the best spelling, if you confirmed 

this place name by picking it from the list or if you elected to keep this 

spelling as described above. 
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 The blue question mark icon indicates that Family Tree Builder has not yet 

retrieved suggestions for this place name. This icon indicates a temporary 

state and is displayed until the place name in this field is searched. You can 

click the icon to start a search. 

 This icon indicates that this place was not found by Family Tree Builder. 
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Using Maps 
Family Tree Builder’s Maps feature enables you to map your entire family tree, any 

portion of it or just one individual on an interactive world map. The Maps feature 

uses standard Google maps, in which you can pan, zoom in/out and so on for 

easy maneuverability. 

NOTE This is a premium feature that is limited by your membership type. 

Premium users can view all places on the map.  

Non-premium users can view only a portion of the places in their project 

on the map. 

You can upgrade to a premium membership when prompted, or click the 

No thanks, continue with free version link to continue with a standard 

membership. 

 

To access the Maps window, click the  tool in the toolbar or select Maps in 

the View menu. 

 

 

When you access the Maps window, Family Tree Builder searches for and loads all 

the places in your project on a world map. 

Filtering Area Display Option Buttons 

Navigator 

List of Places 

Panel 
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The Maps View displays an interactive world map, with pins indicating the places 

in your project. To avoid clutter on the map and to increase speed, when initially 

loading the Maps View, Family Tree Builder only displays one pin per country. For 

countries with multiple states or provinces, such as the USA and Canada, one pin 

is displayed per state/province. When you zoom in on the map, the map displays 

all pins for the selected zoom area. 

Filtering Area 

The Filtering area contains a series of checkboxes that enable you to limit the 

types of places that are displayed on the map. 

 

Simply check a checkbox to include that type of place information on the map. For 

example, check the Birth checkbox to view birth places and the Marriage 

checkbox to view marriage locations. The Other checkbox displays places that do 

not fall into one of the other defined categories (Birth, Death and Burial, 

Marriage, Residence and Photos), such as education. 

Note that many places may have several types, if the same place is used both as 

a birth place and as a marriage place in your project. 

Performing an Advanced Search 

The Advanced search option enables you to further limit the information 

displayed on the map. Click the Advanced search link to access additional 

options. You can filter to display information for a particular person, time period 

and/or language. 
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For example, select a particular person in the top dropdown list to display all the 

places associated with that person on the map. 

 

After making your selection in the dropdown list, the map displays all places 

where that person is referenced, along with that person’s photo and details in the 

right pane. 

 

Click the Show all link to clear the Filtering area. 
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You can choose to display information for only the selected person, or for 

ancestors, descendants and close family too. In this context, close family refers 

to the person’s spouse, siblings, parents and children. 

 

You can also filter by time period. 

 

You can also filter by language. 

 

When you specify filtering criteria in multiple dropdown lists simultaneously, an 

AND condition applies, which means that all specified conditions must be met. 
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Navigator 

The Navigator area contains an easy-to-use navigation wheel and slider for 

navigating the map. 

 

Click one of the arrowheads on the wheel to pan in that direction on the map. 

Click the hand icon in the middle of the wheel to return to the previous position 

on the map (before using one of the arrowheads on the wheel). 

The slider enables you to zoom in and out on the map. Drag the slider toward its 

plus end to zoom in and toward the minus end to zoom out. 

Alternatively, you can double-click the map to zoom in and right-double-click to 

zoom out. 

Display Option Buttons 

The Display Option Buttons area contains three buttons that control the way in 

which the map is displayed, as follows: 
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Map View 

Click the Map button to display the default map view. This view presents a 

standard street-map view of the world or selected area.  

 

You can zoom in to display country and state borders, as well as roads and place 

names. 

 



Maps 

Family Tree Builder User’s Guide 
 

- 276 - 

Satellite View 

Click the Satellite button to display a satellite imaging topographical map view. 

 

Hybrid View 

Click the Hybrid button to display a satellite imaging topographical view of the 

map, which also shows country and state borders, as well as roads and place 

names. 
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List of Places Pane 

The List of Places pane presents a list of all the places displayed on the map. You 

can sort the places list alphabetically, by country, by number of references or by 

date. In the By Country sort, shown below, information is also categorized by 

state/province for the USA and Canada. The default sort is by country. 

 

The By References sort arranges the places list based on the number of 

references this place has in your project. This option sorts the list in descending 

order, so that the more the place is used, the higher up it is in the list. 

The By Date sort arranges the places list according to date, from the oldest date 

to the most recent. 
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The List of Places pane displays those pins that are shown on the map in blue, 

and those pins not yet shown on the map in gray, as shown below: 

 

When you click a gray pin in this pane, it shows you the location of that pin on the 

map and then the pin turns blue. 

You can also click a country, state or province in the list to zoom in to it to show 

all the pins in that country, state or province. 

The Print button at the bottom of the List of Places pane enables you to print the 

current view of the map. 

Places that cannot be found on the map are shown at the bottom of the list. 

 

Not shown on map 
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If you click the link for a place that could not be located on the map, a callout 

opens in which you can edit the data for that place. 

 

Displaying Callouts 

Simply click a place in the List of Places pane to zoom in to that place on the map. 

This action also displays a callout from the relevant pin on the map. The callout 

contains actions and details about the selected place. 
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Callout Actions: 

 Click the  icon to zoom in to the respective place on the map. 

 Click the  link to change the place name to a suggested alternate name. This 

action appears if an alternate name was found for this place. 

 Click the  link to keep the place name with its current name. This action 

appears if an alternate name was found for this place, but you do not want to 

use it. 

 Click the  link to select from a list of suggested alternative place names. 

This action appears if the name that you entered for this place is ambiguous 

and can be located in several places on the map. For example, if you entered 

London as a place, you get the following suggestions: 

 

 When you use this option, suggested alternative places are shown both on 

the map (as gray pins) and in the pane on the right. Select the alternatives or 

click Back to keep your spelling of the place. 

 Another option is to manually enter the coordinates of the place on the map 

and then click OK. This option is useful when Family Tree Builder could not 

locate the exact location of your place on the map. 

 Alternatively, you can simply drag a pin on the map to change its location. 
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 Click the  link to edit the place name. You can perform inline editing directly 

from the callout to change the place name, as shown below: 

 

 Click the  link to remove the place from the map. You may need to remove a 

place from the map when its place name does not correspond to an actual 

physical place on the map. For example, you may want to do so with place 

names like Hospital, At home, At sea and so on, which do not indicate actual 

places on the map. 
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Research Tools 
About This Chapter: 

This chapter describes searching for and adding genealogical information to the 

people in your family tree based on information found using MyHeritage’s 

powerful SuperSearch engine. Family Tree Builder provides you with full access to 

the powerful research tools provided by MyHeritage.com. These tools enable you 

to research families and/or specific people in billions of records, such as birth, 

marriage, death, burial, census, military and immigration records, newspaper 

articles and more. It contains the following sections: 

 SuperSearch describes how to find research information in MyHeritage’s 

SuperSearch engine that matches information about people in your own tree. 

 Record Matches describes how to use the information automatically collected 

by Super Search to identify record matches, which are historical records that 

are highly likely to match your family tree. 
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SuperSearch 

Overview 

Family Tree Builder’s Research feature enables you to search for and add 

genealogical information to the people in your family tree. This feature uses 

MyHeritage’s SuperSearch genealogical search engine that looks for historical 

records, such birth, marriage and death records, as well as census data, military 

and immigration records, newspaper articles, grave records and more.  

You can start a search by entering information in a form on the SuperSearch 

website. Family Tree Builder also provides a built-in capability to search any 

specific person in your family tree. 

NOTE The Family Tree Builder Record Matches feature uses the information 

collected by SuperSearch to identify record matches. 
 

SuperSearch provides a relatively wide range of results, in contrast to the Record 

Matches feature, which provides only the highest-quality results for individuals in 

the tree. 

Research Menu and Toolbar Options 

The Research menu and Research on MyHeritage.com  toolbar button 

provide access to the following research-related options: 
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 Go to MyHeritage SuperSearch: Opens your browser to the SuperSearch 

window. 
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 Research [person’s full name] on SuperSearch, Research [person’s last 

name] on SuperSearch and Research [person’s spouse’s last name] on 

SuperSearch: Opens your browser, displaying the Record Matches results list 

for the selected individual or last name. 
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 View Record Matches for [person’s name]: Opens your browser, displaying all 

the Record Matches for the selected person. 

 

 Refresh Record Matches: Refreshes the record matches results list. 

Research-related functions can be accessed in the following ways: 

 Clicking the Research on MyHeritage.com  button on the toolbar. 

 Selecting one of the options from the Research menu. 

 Right-clicking a person in the People List and choosing Research [person's 

name] on SuperSearch. 

 Right-clicking a person’s card in the Tree View and choosing Research 

[person's name] on SuperSearch. 
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Record Matches 
The Family Tree Builder Record Matches feature uses the information collected by 

SuperSearch to identify record matches, which are historical records about 

someone in your family tree, for example, a document relevant to your family's 

history, such as a birth record of one of your ancestors, a tombstone photo of a 

relative in your family or a newspaper article describing how your 

great-grandfather met and fell in love with your great-grandmother.  

By default, Family Tree Builder checks for Record Matches automatically 

whenever you change information about people in your family tree that affects 

matches, such as names, birth dates and so on. 

TIP To disable automatic Recording Matching, select Options in the Tools 

menu. Then, select the General pane and set the Automatic Record 

Matching parameter to No. 
 

Family Tree Builder provides you with the number of Record Matches for each 

person. Viewing and managing (confirming and rejecting) the matches is done 

online on the MyHeritage.com website. 

NOTE Record matches for your entire family tree can only be viewed if you 

synchronize your tree and wait for the record matches to be calculated 

on the server. 
 

Accessing some of the records identified by the Record Matches feature are free, 

but most require a separate data subscription (see Data Subscriptions). 

Reviewing a Person’s Record Matches 

When records are matched in a MyHeritage SuperSearch for a person in your 

family tree, an icon or button is shown in that person’s card in the Tree view. You 

can then either approve or reject each record match that was found. 
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To view Record Matches for a person: 

1 In a person card, click the green X records  button, where X 

designates the number of records matched for that person that are either 

approved or pending ,but not rejected. The following window is displayed, 

showing the list of Record Matches for this person: 

 

Note that the results are displayed in an external browser. 

NOTE If Record Matches are found for a person, the Records button is 

shown whenever you open that person’s card, even if the family tree 

has not been synchronized (see Syncing Your Family Tree). 

However, if the specific person for whom you are viewing a record is 

not synchronized, then you can only view their Record Matches, but 

cannot confirm or reject them. 

 

2 At this point, you can review the list and click the green checkmark  to 

confirm a match, or click the red X  to reject it. 

Alternatively, you can drill down further to view even more detail for a specific 

Record Match by clicking its Review match button. Review the match and click 

the Confirm button to approve the match or the Reject button to delete it. 
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Reviewing Record Matches for the Entire Family 

Tree 

To review Record Matches for the entire family tree: 

1 In the Family Site menu, select Record Matches. A summary of all Record 

Matches to your family tree is displayed: 

 

This window shows the total number of Record Matches for the entire family 

tree at the top. 

The window contains two tabs: By collections and By people. The By 

collections tab presents the results list by record collections, such as by 

Newspaper Archive, Social Security Death Index and so on, as shown above. 
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The By people tab displays Record Matches by person for each person in the 

family tree, as shown below: 

 

The total number of Record Matches for each collection or person is shown, as 

well as the number of pending matches for that entry. 

For example, in the window below, Rose Kennedy has five record matches, all 

of which are pending. A pending record match means that the match has not 

yet been confirmed or rejected. 
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2 Click the View X matches button for the collection or person whose matches 

you want to view. Details for each Record Match are displayed: 

 

3 At this point, you can review the Record Matches results list and click the 

green checkmark  to confirm a match, or click the red X to reject it. 

Alternatively, you can drill down further to view even more detail for a specific 

Record Match by clicking its Review match button. The following window is 

displayed: 
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Review the Record Match and then click the Confirm button to approve the 

match or the Reject button to delete it. 

TIP After confirming or rejecting Record Matches, you can refresh the 

Record Match counts in Family Tree Builder immediately by selecting 

Refresh Record Matches in the Research menu. 
 

Data Subscriptions 

Some of the records identified by the SuperSearch and Record Matches features 

are free, but most require a separate data subscription. A data subscription plan 

can be purchased from My Heritage, and provides unlimited access to billions of 

historical records and unlimited Record Matches. For example, the following are 

some of the sources used to locate historical content of interest: 

 Birth, marriage and death records 

 Census, military, immigration and legal records 

 Newspapers, yearbooks, directories and guides 

 Family trees, photos, documents and maps 
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Note that all record matches appear in the Record Matches results list. However, 

for those records that require a data subscription, only basic information is 

presented for them and you can only drill down to view details if you have the 

required data subscription. Record Matches that are free have the word Free in 

green as part of their description. Those that require a data subscription do not. 

 

When you click a free Record Match, you are shown all of its information. If you 

click a Record Match that is not free, a window is displayed in which you can 

purchase a data subscription. 

NOTE A data subscription is not the same as a Premium or Premium Plus 

membership (see Premium Membership). 
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Charts 
About This Chapter: 

This chapter describes the types of charts that Family Tree Builder provides and 

how to create and customize them. It contains the following sections: 

 Displaying a Chart describes how to display a chart. 

 Configuring Chart Appearance describes options for defining the appearance 

of your charts. 

 Printing a Chart describes options for printing a chart from a standard 

desktop printer or as a poster. 

Family Tree Builder provides the following types of charts: 

 Ancestor Charts, which show the selected person, his or her parents, 

grandparents and so on. 

 Descendant Charts, which show the selected person, children, grandchildren 

and so on. It also includes the spouse(s) of the person and the descendants. 

 Fan Charts, which show the selected person and that person’s descendants 

or ancestors in a fan-shaped chart. 

 Close Family Charts, which show the selected person and close relatives of 

that person. 

 Hourglass Charts, which show the selected person and both ancestors and 

descendants. 

 Bowtie Charts, which show the selected person and his or her spouses, both 

of their ancestors and their children. 

 All-in-One Charts, which show the entire family tree. 
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Displaying a Chart 
You can easily display a chart, as described below. 

To display a chart: 

1  Do one of the following to display the Charts menu: 

▪ Click the Charts  button. 

▪ Select the Charts option in the toolbar. 

▪ Select a person in the Tree View, right-click its card and select the Charts 

sub-menu. 

The Charts menu is displayed, as shown below: 

 

2  You can now select the chart you want to display (and whether to create a 

horizontal or vertical chart).  

Alternatively, you can select the Chart Wizard option to display more 

information about chart types. This wizard is described in the next step. 
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3 In the Chart Wizard, select the respective radio button for the type of chart you 

want to display and click Next: 

 

4 Select the radio button to select the chart style. 

 



Charts 

Family Tree Builder User’s Guide 
 

- 300 - 

5 Click Create chart to create the chart that you selected. The chart is centered 

around the person who is currently selected in the Tree View. 

Examples of different types and styles of charts are presented below: 

Bowtie Chart 
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Vertical Ancestor Chart 
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Horizontal Descendants Chart 
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Ancestors Fan Chart 

 

6 To change the main person of the chart, double-click this person in the People 

List on the left. 
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7 You can right-click a person's box in the chart to open the following menu: 

 

The options in this menu are: 

▪ Display chart for this person: Makes the selected person the main person 

of the chart. 

▪ Edit Person Details: Edits the details of this person. 

▪ Display Person in Family Tree: Shows the Tree View for this person. 

▪ Manage Person's Photos: Shows the list of all photos of this person in the 

Photos View. 

▪ Chart Options: Changes the chart's options, as described below. 

8 You can click and drag any box in the chart to a new position, as required. The 

line connecting it to its family member adjusts accordingly. Hold down the Ctrl 

key while dragging the box if you want to move only this box. Otherwise, the 

box and its dependent boxes move together. 

9 Use the Chart toolbar, as needed. The following describes the other options 

that are available in the toolbar above the chart window: 

▪ Options: Enables you to configure the appearance and content of the 

chart. See Configuring Chart Appearance for more details. 

▪ Styles: Provides a variety of attractive styles for your selection and 

enables you to specify the type of facts that will appear in the boxes. Each 

style can then be further configured by clicking the Options button. 

▪ Print: Enables you to print the displayed chart to a standard printer or as a 

poster. See Printing a Chart for more details. 

▪ Save: Opens a wizard that enables you to save this chart as a PDF or JPEG 

file on your computer. 
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▪ Home  Icon: Moves the main person of the chart to the center of the 

chart. 

▪ Zoom: You can use the zoom slider to enlarge or reduce the display of the 

chart on the screen. 

NOTE PDF is a standard format provided by Adobe Acrobat. Its reader can 

be downloaded for free from various sites on the Internet. If you do 

not have Acrobat reader, simply download it and install it. You can 

then view and print the PDF files provided by Family Tree Builder or 

any other PDF file. 

 

Configuring Chart Appearance 
Family Tree Builder provides a wide variety of options for defining the appearance 

of your charts, as follows: 

 Chart Options 

 Fan Chart Options 

 Chart Styles 
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Chart Options 

To configure chart options: 

1 Display the chart of your choice (see Displaying a Chart above). The chart will 

be displayed in the main window. 

2 Select Chart Options to display the following window: 

 

NOTE For fan charts, the options window differs. See Fan Chart Options. 

 

3 Fill in or modify the information in the various tabs of this window, as 

described below, and click OK to display the chart. This new 

appearance remains until you change it. 

NOTE You can also click Apply to save the changes and still leave the 

window open for more changes. 
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The following tabs are provided to enable you to define the appearance of your 

family chart: 

 General Tab 

 Design Tab 

 Facts Tab 

 Background Tab 

 Lines Tab 

 Fonts Tab 

 Languages Tab 



Charts 

Family Tree Builder User’s Guide 
 

- 308 - 

General Tab 

The General tab allows you to customize the general appearance of the chart, as 

follows: 

 

The following describes the fields in this window: 

 Title: 

▪ Title: Specify a title for the chart. A title is automatically given to a chart by 

Family Tree Builder, based on the type of chart and the main person or 

couple of the chart. You can change this title as you want. 

▪ Decoration: Specify the decorative style for the title of the chart. To do so, 

open the dropdown list to see samples of the various decorations that are 

available. Select the first option in the list for no decoration. 
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 Generations: 

▪ Show all generations or specify the number of generations to appear in 

the chart. The more generations you specify, the more people will appear 

in the chart and the larger the chart will be. 

▪ Display children in a long thread: This option is available only for Bowtie 

charts. A Bowtie chart shows the children of a couple below the couple in 

the chart. Check this option to show the children in a vertical thread, one 

below the other. Do not check this option to show the children 

horizontally next to each other. 

▪ Closeness of relatives: This option is only available for Close Family 

charts and allows you to specify which relatives of the main person to 

include in the chart. 

▪ Include ancestors of spouse(s): This option is only available for Hourglass 

charts and allows you to specify whether or not to also include the 

spouse’s ancestors.  

 Personal Photos:  

▪ Show Personal Photos: Specify how Personal Photos are shown in the 

chart. If you select the Stylish design (see the Design tab), then this 

option is not available, as this design always shows personal photos). The 

available options are: 

 Only if Exists: Personal photos are shown in the chart only for people 

who have a personal photo. Otherwise, nothing is shown. 

 Always (show placeholder if missing): Personal photos are shown in 

the chart for people who have a personal photo and a silhouette 

placeholder is shown for people with no personal photo. 

 Never: Never show personal photos in the chart. 

▪ Personal photos size: Specify the size of the personal photos in the chart. 

Huge is 90 x 120 pixels, Large is 60 x 80 pixels and Small is 30 x 40 

pixels. 
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 Arrangement: 

▪ Orientation: Specifies whether the chart is displayed vertically or 

horizontally. 

▪ Arrange boxes closely to save pages: Positions chart boxes close 

together, reducing the space that they take up on paper. When this option 

is selected, the chart is smaller, and may be harder to read. 

▪ Arrange chart to fit printer pages: Check this option if you plan to print 

the chart on your home printer. When this option is selected, Family Tree 

Builder arranges the chart so that it fits nicely on multiple sheets of paper. 

Otherwise, the chart does not take into account the size of paper in your 

printer. 

▪ Select paper size: This button is available only if you selected the Arrange 

chart to fit printer pages option above. Selecting this option opens a 

standard Print Setup window to change the size and orientation of your 

printer paper. 

▪ Prevent boxes from crossing page boundaries: This option is only 

available when selecting the Arrange chart to fit printer pages option 

above. Check this option to prevent a box in the chart from spanning more 

than one printer page. When you check this option, the chart typically 

becomes much larger. 
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Design Tab 

The Design tab enables you to define the overall design of each box in the chart. 
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The following describes the fields in this tab: 

 Design:  

▪ Stylish: In Stylish design, each person's box includes a photo with a 

frame around it and text about the person appears below the photo. 
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▪ Traditional: In Traditional design, each person's box appears as a 

rectangle with the photo and text inside the box. 

 

 Photo frame: Select the type of frame to show around each photo in the chart. 

Select the last option in the dropdown if you do not want any frame around 

the photos. 

 Box Border: Select the type of border for each box in the chart. You can select 

a simple line border with your choice of width and color, or you can select 

from one of the available graphical borders. You can also select whether to 

show a shadow around each box. 

 Box Background Color: The inside of each box can have a background color. 

You can select whether to use a different color based on the gender of the 

person in the box. 
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Facts Tab 

The Facts tab enables you to define and customize the facts that appear in each 

box in the chart, as follows: 

 

Each chart box represents a person. An example of a box in a chart is shown 

below: 

 

1  

Select a category 

of facts 

2  

Select facts 

3  

Click Add to 

include these 

facts 

4  

The included  

facts are listed 

here 



Charts 

Family Tree Builder User’s Guide 
 

- 315 - 

To select the facts to be included: 

1 The left side of this window lists the various facts that are available to be 

shown in a chart profile. The facts that are shown in this list are determined 

by the selection in the category field that appears above it. Select a category 

of facts from this dropdown field. These are the facts from which you can 

choose to include. 

2  Click on the facts to be included in a chart box. A checkmark appears to the 

left of the fields that have already been selected. You may use the Ctrl and 

Shift keys on the keyboard to select more than one fact at a time. 

3  Click Add to include these facts on the list on the right. This list specifies the 

facts to include in the profile. You can also double-click the fact to add it. 

Click Remove to remove them from this list. 

4  Specify the order in which the facts appear on the profile. Select a fact on the 

right and move it up in the list by clicking Move Up, or move it down in the list 

by clicking Move Down. 

5 You can specify whether the name of facts in chart boxes have Full labels or 

Short labels. When Full labels is selected, a fact name might be Birth: for 

example, while with Short labels, its name might be b.. 

6  Select the Description, Date, Place and/or Cause of death checkboxes to 

indicate which information to show for each of the selected facts. 

7  Click Apply or OK to save your changes. 
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Background Tab 

The Background tab enables you to customize the background of the chart and 

the frame around it: 
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The following describes the fields available in this tab: 

 Background color: You can select a background color for the chart. If you are 

printing this chart on your home printer, you may want to set this color to 

white. 

 Background image: You can select a background image for the chart. Click the 

Select Image button to open the following menu: 

 

▪ From project photos: Select a photo that you have added to your project 

as the background image for your chart. 

▪ From tiled backgrounds: Select an image from a list of tiled images 

provided by Family Tree Builder. 

▪ From full backgrounds: Select an image from a list of background images 

provided by Family Tree Builder. 

▪ From file: Select your own image file as the background image for your 

chart. 

 Image fit: If you have selected a background image, specify how to fit this 

image by selecting one of the following options in the dropdown list: 

▪ Fit to page (no distortion): Enlarge or shrink the image to fit the page, but 

do not stretch and potentially distort it. 

▪ Fit to page (stretch): Enlarge or shrink the image and stretch the image to 

fit the exact size of the chart. 

▪ Tile image to fit chart: Tile the image across the chart. This option is 

automatically selected when you select one of the tiled backgrounds 

above. 

 Transparency: If you have selected a background image, you can control the 

transparency level of this image. The higher the percentage you select, the 

fainter the image appears. 

 Frame around chart: You can select a frame to display around the chart by 

checking the Frame around chart option and selecting one of the frames 

provided by Family Tree Builder. 
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Lines Tab 

The Lines tab enables you to customize the lines that link the boxes on a chart.  

 

The following fields are available in this tab: 

 Line type: Select the line type as either Straight or Diagonal. Straight lines 

are always vertical and have horizontal connectors with right angles. 

 Line width: Select the width and color of lines between parents and children. 

 Lines between spouses: Select the width and color of lines between two 

spouses. 

 Display terminated spouse relationships with a dashed line: Select whether 

to display dashed lines between divorced and separated spouses. 

 Lines between children and parents: Select whether to display dashed lines 

from parents to their adopted and foster children. 
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Fonts Tab 

The Fonts tab enables you to choose the font of the text of various elements on 

your chart 

 

Select the chart element on the left and then specify the font and the size of this 

element. You can also specify whether the text will be bold and/or italics and the 

color of the text. You can preview your selection in the Preview area. 

The text elements of the chart are: 

 Title: The title at the top of the chart. Select a large font for this element. You 

can also check the Automatic checkbox for Family Tree Builder to 

automatically determine the size based on the size of the chart. 

 Names: The names of people in the chart. 
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 Fact labels: The names of facts in the chart, such as Birth. 

NOTE Note that the Stylish design does not show fact labels, so this 

option does not appear in the design. 
 

 Fact text: Information about a fact in the chart, such as the date, place and 

description of this fact. 

 Footer: The footer text at the bottom of the chart. 

Languages Tab 

The Languages tab enables you to define the primary and secondary language. 

More details about the primary and secondary language are provided in Primary 

and Secondary Data Languages. 
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Fan Chart Options 

To configure fan chart options: 

1 Display the fan chart of your choice (see Displaying a Chart). The chart is 

displayed in the main window. 

2 Select Chart Options to display the following window: 

 

3 Fill in or modify the information in the various tabs of this window, as 

described below, and click OK to display the chart. This new appearance 

remains until you change it. 

NOTE You can also click Apply to save the changes and still leave the 

window open for more changes. 
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The following tabs are provided to enable you to define the appearance of 

your family chart: 

▪ General Tab 

▪ Boxes Tab 

▪ Fonts Tab 

▪ Background Tab 

▪ Languages Tab 

General Tab 

The General tab enables you to customize the general appearance of the chart, as 

follows: 
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The following describes the fields in this window: 

 Title: Specify a title for the chart. A title is automatically given to a chart by 

Family Tree Builder, based on the type of chart and the main person or couple 

of the chart. You can change this title as you want. 

 Generations: Show all generations or specify the number of generations to 

appear in the chart. The more generations you specify, the more people will 

appear in the chart and the larger the chart. 

 Include empty boxes of ancestors not in the family tree: This option is only 

available in Ancestor charts. Check this option to include empty boxes for all 

ancestors, even those who are not defined in the family tree. 

 Indicate duplicated people who appear more than once in the chart: Use this 

option to mark people who appear more than once in the tree with numbers, 

starting from [1], [2] and so on. This feature is useful if there are marriages 

within the family, for example a marriage between two cousins. 

 Hide ancestors / descendants of duplicated people: This option is useful if 

you have people who appear more than once in the chart, for example, 

married cousins. Use this option if you do not want ancestors (in an Ancestor 

Fan chart) or descendants (in a Descendants Fan chart) of these duplicated 

people to also be duplicated. 

 Arrange chart to fit printer pages: Check this option if you plan to print the 

chart on your home printer. When this option is selected, Family Tree Builder 

arranges the chart so that it fits nicely on multiple sheets of paper. Otherwise, 

the chart does not take into account the size of paper in your printer. 

 Select paper size: This button is available only when you select the Arrange 

chart to fit printer pages option above. Selecting this option opens a 

standard Print Setup window to change the size and orientation of your 

printer paper. 
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Boxes Tab 

The Boxes tab enables you to define the design of each box in the Fan chart. 

 

The following describes the fields in this tab: 

 Box Background Color: The inside of each box can have a background color. 

You can select whether to use a different color based on the gender of the 

person in the box. 

 Box Border: Select the width and color for each box in the chart. 

Fonts Tab 

The Fonts tab enables you to choose the font of the text of various elements on 

your chart. 

Select the chart element on the left and then specify the font and the size of this 

element. You can also specify whether the text is bold and/or italics and the color 

of the text. You can preview your selection in the Preview area. 
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The text elements of the chart are: 

 Title: The title at the top of the chart. Select a large font for this element. You 

can also check the Automatic checkbox for Family Tree Builder to 

automatically determine the size based on the size of the chart. 

 Names: The names of people in the chart. 

 Footer: The footer text at the bottom of the chart. 
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Background Tab 

The Background tab enables you to customize the background of the chart and 

the frame around it: 
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The following describes the fields available in this tab: 

 Background color: You can select a background color for the chart. If you are 

printing this chart on your home printer, you may want to set this color to 

white. 

 Background image: You can select a background image for the chart. Click the 

Select Image button to open the following menu: 

 

▪ From project photos: Select a photo that you have added to your project 

as the background image for your chart. 

▪ From tiled backgrounds: Select an image from a list of tiled images 

provided by Family Tree Builder. 

▪ From full backgrounds: Select an image from a list of background images 

provided by Family Tree Builder. 

▪ From file: Select your own image file as the background image for your 

chart. 

 Image fit: If you selected a background image, specify how to fit this image by 

selecting one of the following options in the dropdown list: 

▪ Fit to page (no distortion): Enlarge or shrink the image to fit the page, but 

do not stretch and potentially distort it. 

▪ Fit to page (stretch): Enlarge or shrink the image and stretch the image to 

fit the exact size of the chart. 

▪ Tile image to fit chart: Tile the image across the chart. This option is 

automatically selected when you select one of the tiled backgrounds 

above. 

 Transparency: When you select a background image, you can control the 

transparency level of that image. The higher the percentage you select, the 

fainter the image appears. 

 Frame around chart: You can select a frame to display around the chart by 

checking the Frame around chart option and selecting one of the frames 

provided by Family Tree Builder. 
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Languages Tab 

The Languages tab enables you to define the primary and secondary language. 

More details about the primary and secondary language are provided in Primary 

and Secondary Data Languages. 

 

Chart Styles 

This option enables you to customize the general appearance of a chart and the 

facts that will be included on it. The Preview area of this window enables you to 

see what your selection looks like before you apply it. A variety of attractive styles 

are provided. 
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To configure Chart styles: 

1 Display the chart of your choice (see Displaying a Chart above). The chart is 

displayed in the main window. 

NOTE Chart styles are not available for Fan charts. 

 

2 Select Chart Styles to display the following window: 

 

3 Select any of the listed styles on the left. 

4 Select one of the options in the Select facts field to determine the type and 

amount of detail to be included. An example of the type of information to be 

shown can be seen in the Preview area each time you select an option: 

 

5 Click Apply or OK to save your changes. 
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Printing a Chart 
Family Tree Builder enables you to print a chart in one of the following ways: 

 Printing a Chart from a Home Printer 

 Printing a Chart as a Poster 

Printing a Chart from a Home Printer 

This printing option enables you to print a chart on a standard home printer. 

To print a chart from a home printer: 

1 In the Chart View, click the Print button and select Print to home printer. 

  

A standard Print window opens in which you can specify the required print 

settings. 

2 Specify your print settings and click OK. The chart is printed in a tiled format. 
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Printing a Chart as a Poster 

The Print poster printing option enables you to print your family tree chart as a 

large, high-quality, full-color poster. The chart produced is created using 

professional plotters on large high-quality paper. Posters can be produced in 

various sizes and can be laminated for their protection. 

MyHeritage provides this printing option as a service to you. Simply specify the 

details for the poster (size, paper, lamination and so on) and then enter your 

shipping and payment details. The finished chart is then shipped to you by mail. 

To print a chart as a poster: 

1 In the Chart View, click the Print button and select Print poster to display the 

following window: 

 

This window describes the general process that will occur to create your 

poster. If you have not yet selected your country or if you want to ship the 

poster to a different country, select your country here. Selecting a country 

determines where MyHeritage will print this poster and the cost of shipping it. 
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2 Click Next to display the following window: 

 

In this window, you specify the paper size and paper quality for the poster. 

The area at the bottom of the window shows a preview of the chart, based on 

your specifications. The pricing area at the right shows the cost of preparing 

and shipping the poster, based on the options you select in the window. You 

can change from Inches to Metric units and choose the currency you want to 

use. 

3 Specify the paper size in the respective dropdown list. Family Tree Builder 

calculates several paper sizes based on your chart and the available paper 

sizes. 

4 Specify the type of paper to be used in the Paper quality field. 

5 Check the Add lamination checkbox if you want the chart to be laminated. 

This is recommended to preserve the poster. Note that some paper types 

cannot be laminated. 
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6 Specify the number of copies and click Next to display the following window: 

 

In this window, you specify your shipping details. 
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7 Specify your name and address information. You can choose express 

shipping and add special notes for the printer. Click Next to display the 

following window: 

  

In this step, your chart is sent to MyHeritage.com along with its order 

information. You are then directed to a payment screen in which you enter 

your payment details. 

After entering your payment information, a confirmation email is sent to you. 

Once ready, the poster is shipped to your address. 
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Reports 
About This Chapter: 

Family Tree Builder provides a variety of reports, as described in this chapter. It 

contains the following sections: 

 Generating a Report describes how to generate the reports provided by Family 

Tree Builder. 

 Book Report describes a simple wizard that walks you through the process of 

producing a Book Report for a specific person. 

 Family Group Sheet describes how to generate a report showing the details of 

the selected person and their immediate family. 

 Relationships Report describes how to generate a report showing all the 

relationships of the selected person to all the other people in your project. 

 Ancestors Report describes how to generate a report showing facts and 

personal details about a selected person and about each generation that 

precedes that person, such as parents, grandparents and so on. 

 Descendants Report describes how to generate a report showing facts and 

personal details about a selected person and about each generation that 

follows that person, such as children, grandchildren and so on. 

 Timeline Report describes how to generate a list showing major events of the 

family of the selected person in chronological order, such as birth, marriage 

and death. 

 Descendant Summary describes how to generate a hierarchical tree showing 

the descendants of the selected person. 

 Addresses Report describes how to generate an alphabetical list (in the order 

of each person’s name) of the addresses of all the people in the family tree. 

 Export Custom Report describes how to create a customized Excel report 

about the people in your project. 
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Generating a Report 
You can easily generate one of the reports provided by Family Tree Builder as 

described below. 

To generate a report: 

1  Click the Reports  button to display the Reports menu, as shown below: 

 

2  Select one of the reports displayed in this menu. This report will then either 

be generated automatically, or Family Tree Builder will walk you through a 

simple wizard in which you can specify the options that you would like to be 

generated in the report. Each report is different, as described in the 

subsequent sections: 

▪ Book Report 

▪ Family Group Sheet 

▪ Relationships Report 

▪ Ancestors Report 

▪ Descendants Report 

▪ Timeline Report 

▪ Descendant Summary 

▪ Addresses 

3 Apart from the Book Report, which triggers a wizard that eventually saves the 

report as a file, the report is shown in the Report View. 
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By default, the report is generated for the person selected in the Tree View. To 

change the main person, double-click any person in the People List to 

regenerate the report for that person. 

4  Use the Report toolbar, which is located above the report, as needed. This 

toolbar contains the following tools 

 

▪ Options: Displays a window in which you can choose the font for various 

aspects of this report. (see the respective Report Options section for each 

report type) 

▪ Save : Saves this file to the location that you specify. You can save 

reports in RTF, PDF or HTML formats. Each option is described in the 

window below: 

 

Reports are saved by default to the project's Reports folder. Select the 

Open Reports Folder option from the Reports menu to view reports that 

were previously saved to this folder. 

▪ Print : Prints the displayed report to a home printer. 

▪ Zoom: You can use the zoom slider to enlarge or reduce the display of the 

report on the screen. 
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Book Report 
A simple wizard walks you through the process of producing a Book Report for a 

specific person, as described below. 

To generate a Book Report: 

1  Click the Reports  button to display the Reports menu, and select Book 

Report to display the following window: 

 

This window enables you to select the primary person for this report. 

NOTE Family Tree Builder uses a third-party tool to generate this report. If 

you would like to learn more about this third-party tool, click the 

Learn More button. 
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2  Click Next to display the following window: 

 

In this window, select the type of information to be included in the report. You 

can select as many elements as you like. You can also select the type of 

printer paper to be used. 
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3  Click Next to start generating the report. A window is displayed showing the 

progress of this process. When this process is completed, the following 

window is displayed, specifying the location in which a PDF file of this report 

has been saved, as shown below: 

 

NOTE PDF is a standard format provided by Adobe Acrobat. A PDF reader 

can be downloaded for free from various sites on the Internet. If you 

do not have Acrobat reader, simply download it and install it and 

you will then be able to view and print the PDF files provided by 

Family Tree Builder or any other PDF file. 
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Family Group Sheet 
A Family Group Sheet is a report showing the details of the selected person and 

their immediate family. 

This report shows a rubric for the main person, spouse and children. This is a 

good report to print if you have missing information about a family. Take the 

report with you and fill out the missing information and then enter it into your 

project. 

To generate a Family Group Sheet: 

 Click the Reports  button to display the Reports menu and select Family 

Group Sheet, or select Family Group Sheet from the Reports menu on the 

menu bar. An example of the report that is automatically generated is shown 

below: 
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Family Group Sheet Report Options 

Click the Options button on the Report toolbar or from the Reports menu to open 

the Reports Window for this report. 

 

The following options are available for the Family Group Sheet report: 

 Format Tab:  

▪ Line color: The color of the lines in tables of the report 

▪ Include all events: Indicates whether to include all events (facts) about 

people in the report or only the important facts. 

▪ Show facts even if empty: Indicates whether to leave an empty rubric for 

facts that are empty. 

▪ Include page number on first page: Indicates whether to include page 

numbers for all pages or for all pages except the first one. 

▪ Include notes at the end of report: Indicates whether to include relevant 

notes in the report. 

▪ Only include facts in report language: This option is useful when your 

project includes information in more than one language. 
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▪ Include patrilineage: Shows the first names of male ancestors after the 

name of a person. For example, let’s say that you have a person in your 

family tree named Albert Smith, whose father is Bert, and Bert’s father is 

Charles. Turning this option on displays Albert Smith (Bert, Charles). 

▪ Show ID numbers of people: A convenient option that allows you to easily 

find the people in the report, when you want to enter information about 

them into the project. 

▪ Show personal photos: Indicates whether and how to show personal 

photos in the report. 

 Fonts Tab: The options in this tab control the various fonts to use in the 

report. Select the report element on the left and then enter its font and size, 

formatting (bold and italics) and color on the right. 
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 Sources Tab: Use this tab to include source citations in the report, and to 

specify where and in which format they should use. 
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Relationships Report 
A Relationships Report shows all the relationship of the selected person to all the 

other people in your project. This report shows the name of the family member, 

the relationship to the selected person and how many steps are between the two 

people. Relationship steps indicate how close the relation is to the selected 

person. For example, a mother, father, brother or sister is one step away, a 

grandparent or grandchild is two steps away and so on. 

To generate a Relationships Report: 

 Click the Reports  button to display the Reports menu and select 

Relationships, or select Relationships from the Reports menu on the menu 

bar. An example of the report that is automatically generated is shown below: 
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Relationships Report Options 

Click the Options button on the Report toolbar or from the Reports menu to open 

the Reports Window for this report. 

 

The following options are available for the Family Group Sheet report: 

 Fonts Tab: The options in this tab control the various fonts to use in the 

report. Select the report element on the left and then enter its font and size, 

formatting (bold and italics) and color on the right. 
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Ancestors Report 
An Ancestors Report shows facts and personal details about a selected person 

and each generation that preceded that person, such as parents, grandparents 

and so on. 

To generate an Ancestors Report: 

 Click the Reports  button to display the Reports menu and select 

Ancestors, or select Ancestors from the Reports menu on the menu bar. An 

example of the report that is automatically generated is shown below: 
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Ancestors Report Options 

Click the Options button on the Report toolbar or from the Reports menu to open 

the Reports Window for this report. 

The following options are available for the Family Group Sheet report: 

 General Tab: 

 

▪ Include patrilineage: Shows the first names of male ancestors after the 

name of a person. For example, let’s say that you have a person in your 

family tree named Albert Smith, whose father is Bert, and Bert’s father is 

Charles. Turning this option on displays Albert Smith (Bert, Charles). 

▪ Include notes at end of report: Indicates whether to include relevant notes 

in the report. 

▪ Only include facts in report language: This option is useful when your 

project includes information in more than one language. 

▪ Show ID numbers for people: A convenient option that allows you to 

easily find the people in the report when you want to enter information 

about them into the project. 

▪ Generations: Specifies how many generations to include in the report. 

▪ Show personal photos: Indicates whether and how to show personal 

photos in the report. 
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 Fonts Tab: The options in this tab control the various fonts to use in the 

report. Select the report element on the left and then enter its font and size, 

formatting (bold and italics) and color on the right. 
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 Sources Tab: Use this tab to include source citations in the report, and to 

specify where and in which format they should use. 

 



Reports 

Family Tree Builder User’s Guide 
 

- 353 - 

Descendants Report 
A Descendants Report shows facts and personal details about a selected person 

and each generation that follows that person, such as children, grandchildren 

and so on. 

To generate a Descendants Report: 

 Click the Reports  button to display the Reports menu and select 

Descendants, or select Descendants from the Reports menu on the menu bar. 

An example of the report that is automatically generated is shown below: 
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Descendants Report Options 

Click the Options button on the Report toolbar or from the Reports menu to open 

the Reports Window for this report. 

The following options are available for the Descendants report: 

 Contents Tab: 

 

▪ Include page number on first page: Indicates whether to include page 

numbers for all pages or for all pages except the first one. 

▪ Include notes at the end of report: Indicates whether to include relevant 

notes in the report. 

▪ Include notes for spouses at end of report: Indicates whether to include 

relevant notes about spouses in the report. 

▪ Include patrilineage: Shows the first names of male ancestors after the 

name of a person. For example, let’s say that you have a person in your 

family tree named Albert Smith, whose father is Bert, and Bert’s father is 

Charles. Turning this option on displays Albert Smith (Bert, Charles). 
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▪ Single gender only: Shows descendants of the same gender as the 

selected individual. This option is useful, for example, if you are planning 

a Y-chromosome DNA study, as it lets you see everyone who shares that Y 

chromosome. 

▪ Only include facts in report language: This option is useful when your 

project includes information in more than one language. 

▪ Show ID numbers of people: A convenient option that allows you to easily 

find the people in the report when you want to enter information about 

them into the project. 

▪ Include main entries for: Indicates whether to show a main entry for all 

descendants or only for descendants who have information in addition to 

birth and death, which is already shown in the entry about their parent. 

▪ Show personal photos: Indicates whether and how to show personal 

photos in the report. 

▪ Include facts: Enables you to select which facts to include in the report. 

 Format Tab:  

 

▪ Generations: Specifies how many generations to include in the report. 
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▪ Report numbering system: Specifies the system for numbering people in 

the report. Select one of the following numbering systems: 

 MyHeritage Standard 

 Register 

 NGS Quarterly 

 Henry 

 D’Aboville 

Let’s look at an example to see the differences between these numbering 

systems. In the following example for the Smith family, Albert is the father 

with children Bill, Cynthia and Doris. Bill has a child named Emily. Cynthia 

does not have a main entry, as there is no additional information beyond 

birth and death information for her, and you selected to include main 

entries only for descendants with additional information. 

 MyHeritage Standard: Each person that has a main entry in the report 

is numbered, starting with 1, 2, 3 and so on. Descendants that do not 

have a main entry are not numbered. Each child in a person’s main 

entry is preceded by a roman numeral, such as i, ii, iii and so on. 

 
 Register: Similar to the MyHeritage Standard system. The only 

difference is that the roman numerals are shown after the person’s 

number. 
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 NGS Quarterly: Similar to the MyHeritage Standard system. The 

differences are that people always get a reference number, regardless 

of whether they have a main entry, and children get a plus sign if they 

have their own main entry later in the report. 

 
 Henry: All people get a reference number, regardless of whether they 

have a main entry. However, the number for a child consists of the 

number of his/her parent and then the position of that child in the 

family. Therefore, if a parent’s number is 15, his/her third child is 

numbered 153. Roman literals are shown after the reference number. 

 
 D’Aboville: Similar to the Henry system, but numbers include periods 

(.). This is helpful when a person has more than nine children. 
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 Fonts Tab: The options in this tab control the various fonts to use in the 

report. Select the report element on the left and then enter its font and size, 

formatting (bold and italics) and color on the right. 
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 Sources Tab: Use this tab to include source citations in the report, and to 

specify where and in which format they should use. 
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Timeline Report 
A Timeline Report is a list showing major events of the family of the selected 

person in chronological order, such as birth, marriage and death. 

To generate a Timeline Report: 

 Click the Reports  button to display the Reports menu and select 

Timeline, or select Timeline from the Reports menu on the menu bar. An 

example of the report that is automatically generated is shown below: 
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Timeline Report Options 

Click the Options button on the Report toolbar or from the Reports menu to open 

the Reports Window for this report. 

The following options are available for the Timeline report: 

 Format Tab: 

 

▪ Include page number on first page: Indicates whether to include page 

numbers for all pages or for all pages except the first one. 

▪ Only include facts in report language: This option is useful when your 

project includes information in more than one language. 

▪ Include patrilineage: Shows the first names of male ancestors after the 

name of a person. For example, let’s say that you have a person in your 

family tree named Albert Smith, whose father is Bert, and Bert’s father is 

Charles. Turning this option on displays Albert Smith (Bert, Charles). 

▪ Show ID numbers of people: A convenient option that allows you to easily 

find the people in the report when you want to enter information about 

them into the project. 

▪ Include facts: Enables you to select which facts to include in the report. 

▪ Show personal photos: Indicates whether and how to show personal 

photos in the report. 
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 Fonts Tab: The options in this tab control the various fonts to use in the 

report. Select the report element on the left and then enter its font and size, 

formatting (bold and italics) and color on the right. 
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 Sources Tab: Use this tab to include source citations in the report, and to 

specify where and in which format they should use. 
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Descendant Summary 
A Descendant Summary report shows a hierarchical tree that includes the 

descendants of the selected person. 

To generate a Descendant Summary report: 

 Click the Reports  button to display the Reports menu and select 

Descendant Summary, or select Descendant Summary from the Reports menu 

on the menu bar. An example of the report that is automatically generated is 

shown below: 
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Descendant Summary Report Options 

Click the Options button on the Report toolbar or from the Reports menu to open 

the Reports Window for this report. 

The following options are available for the Descendant Summary report: 

 Format Tab: 

 

▪ Include page number on first page: Indicates whether to include page 

numbers for all pages or for all pages except the first one. 

▪ Indicate divorces: Indicates whether to add a special indication for 

divorced spouses. 

▪ Show full birth and death dates: Indicates whether to show full dates of 

birth and death or whether to include only their years. 

▪ Show ID numbers of people: A convenient option that allows you to easily 

find the people in the report when you want to enter information about 

them into the project. 

▪ Show personal photos: Indicates whether and how to show personal 

photos in the report. 
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▪ Generations: Specifies how many generations to include in the report. 

▪ Include generation number: Indicates whether to specify the generation 

number of people in the report, starting from 1 for the main person, 2 for 

children and so on. 

 Fonts Tab: The options in this tab control the various fonts to use in the 

report. Select the report element on the left and then enter its font and size, 

formatting (bold and italics) and color on the right. 
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Addresses Report 
The Addresses report is an alphabetical list (sorted by each person’s name) of the 

addresses of all the people in the family tree. 

To generate an Address report: 

 Click the Reports  button to display the Reports menu and then select 

Addresses, or select Addresses from the Reports menu on the menu bar. The 

options that are available in this window are the same as in all the other 

reports. 
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Export Custom Report 
The Export Custom report enables you create an Excel report that contains the 

people with information you want to see. 

To create an Export Custom report: 

1 Click the Reports button to display the Reports menu, and then select Export 

Custom Report to display the following window: 

 

Alternatively, you can access this window by selecting Export to Excel  

Export Custom Report in the Edit menu. 
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2 Select the people to be included in the report by selecting one of the following 

radio buttons: 

▪ All people: Includes all people in the report. 

▪ Selected people: Select the specific people (and optionally their 

ancestors, descendants and spouses). Click the adjacent Select button to 

select these people. 

▪ Search criteria: Select people that match your search criteria. Click the 

adjacent Select button to define your search criteria (see Searching for 

People for more details). 

 

3 Select the fields to be included in the report for those people you specified in 

step 2. Select one of the following radio buttons:  

▪ Standard fields: Includes common fields in the report. 

▪ Selected fields: Enables you to select the list of fields to include for each 

person in the report. Click the adjacent Select button to select these 

fields. 

4 Click OK and select the folder where you want to save the report. Microsoft 

Excel now opens and displays your report.  
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Syncing Your Family Tree 
About This Chapter: 

This chapter describes how to synchronize (sync) your family tree using Family 

Tree Builder to your family site on MyHeritage.com, so that it is available for 

viewing on the Internet to anyone that you invite. It contains the following 

sections: 

 Syncing Your Family Site describes the concept of syncing your family tree on 

your family site. 

 Sync Settings describes how to sync your family tree. 

 User Permissions describes how to set user permissions to control who can 

download your tree from the family site, and who can edit it online. 

 Managing Your Family Sites describes how to access and manage your family 

sites and to use the options in the Family Sites menu. 

 Family Tree Sync describes the Family Tree Sync application used to sync your 

family tree projects. 
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Syncing Your Family Site 

Syncing Overview 

The word syncing (synchronizing) refers to the process of uploading your family 

tree project to a family site under your account on MyHeritage.com, so that it is 

available for viewing online. Syncing in this manner provides bidirectional 

synchronization between your family tree project in Family Tree Builder and your 

family site. During syncing, two things happen: 

 Any changes made in your family site are first downloaded to your Family Tree 

Builder project family tree. 

 Then, any changes made in your family tree project are uploaded to your 

family tree. 

Once a family tree project has been synced, the creator of the tree (you) can also 

edit it online and on smartphones and tablet applications (see Editing a Family 

Tree Online). The changes made online are synced back to Family Tree Builder 

during the next sync cycle. 

Syncing a project also creates a backup of the project on your family site. This 

protects your family tree and photos from accidental damage or computer failure. 

Syncing your project copies the family tree, including its photos, to your family 

site.  

Your online family site is only available to whomever you invite, thereby ensuring 

that the information remains private. Some information about deceased people is 

also searchable on MyHeritage.com in SuperSearch for members who were not 

invited to your family site. If you want to completely block access to uninvited 

members, you can change the privacy level of your family site. In addition, you 

can mark specific information in your family tree as private (certain people, facts 

about people, notes and so on) so that it is never synced to your family site. 

The syncing itself, which includes transferring the data online, is performed by a 

Family Tree Builder utility (see Family Tree Sync), which runs in the background. 

This allows you to continue working while your project is being synced. 
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Your Family Site 

When you become a member of MyHeritage, you create your own user account. 

You are the administrator of your account. 

As a member of MyHeriitage.com, you can manage more than one family site, but 

for most members, it is recommended that you manage one family site for 

simplicity. 

When you sync a project, you create a connection between your family tree in 

Family Tree Builder, and your online family site on MyHeritage.com. You can sync 

a project to one family site. 

When you create a new project, you can choose the family site to which the 

project will be synced. You can change this setting at any time using the Sync 

Settings window. You can also choose which family site to sync to if you did not 

choose a site initially (see Sync Settings). 

NOTE If you want to sync a project and you do not have a family site, one will 

be created for you automatically. 
 

You can sync your family tree to your family site at any time. 

After your family tree has been synced, you can continue to work on the project 

and make changes. You can then re-sync the project so that any new information 

that you entered will also be available on your family site. 
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Automatic Syncing 
Family Tree Builder lets you sync your projects automatically. 

When you open Family Tree Builder for the first time, the following window 

appears: 

 

Click OK to enable automatic syncing. Doing so will automatically sync your 

projects once a day. 
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You can turn off automatic syncing at any time. To do so, from the Tools menu 

select Options, and under the Sync tab enter No in the parameter shown below: 

 

Syncing a Project 

Click the Sync  button in the toolbar at any time to sync your project. If 

automatic syncing is enabled, the project is automatically synced once a day. A 

project that has never been synced will not be synced during automatic syncing. 

You will be asked whether you want to save the current changes, if you have not 

done so already. 
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The Synchronizing project with family site window appears, enabling you to follow 

the progress of the syncing process (for details about this window, see Family 

Tree Sync). 

NOTE You can sync projects to your Family Site at any time by clicking the 

Sync button on the toolbar.  

 

NOTE Clicking Cancel aborts the syncing process. 

 
 

NOTE You can minimize the Synchronizing project with family site window and 

continue working by clicking the Continue working button in the 

window. When you click this button, syncing continues in the 

background, enabling you to carry on your work in Family Tree Builder. 

This is useful when syncing large projects. 

 

Editing a Family Tree Online 

After a family tree project has been synced, the creator of the tree (you) can edit it 

online as well. This applies both to family trees created in Family Tree Builder that 

are synced to a family site, as well as to those family trees created directly on 

MyHeritage.com. Whatever changes are made online are automatically synced 

back to Family Tree Builder during the next sync cycle. 
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NOTE Only the tree creator can edit a family site. Editing can be done online, 

on iOS or an android-based mobile device. 
 

When you open a project in Family Tree Builder that is synced with a family tree 

that has been edited online, you are prompted to first sync the project in Family 

Tree Builder with the online family tree, in order to maintain synchronization 

between the two. 

 

Sync Settings 
In order to sync a project, it must be linked with a family site. This link is set up 

using the sync settings of the project, which define to which family site to sync. A 

project can only be synced to a single family site. 

Defining the Sync Settings of a Project 

When a new project is created, Family Tree Builder offers you the option of 

enabling the syncing of this project, and lets you choose the family site to which 

to sync. 

If you choose not to sync your project, you can later enable syncing by defining its 

sync settings. 

You can change the sync settings for the project at any time. 
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To set sync settings for the first time: 

1 In the Sync (publishing) menu, select Sync Settings. The Sync Settings for 

[current project name] window is displayed: 

 

NOTE This window is also displayed if you click the Sync button on the 

main menu, if the project does not have any Sync Settings. 
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2 Select an existing family site or create a new family site. If you already 

manage one or more family sites on MyHeritage.com, you can now choose the 

site to which to sync. You can also create a new family site by entering a new 

name or selecting one of the suggested names, based on the name of the 

project and common family names in the project. 

3 Click OK to create the sync settings and close the window. 

To change sync settings: 

 In the Sync (publishing) menu, select Sync Settings. If this project already 

has sync settings, the Sync Settings window is displayed: 

 

 The window displays the sync settings of the current project. 

 The window shows the sync settings for the family site for this project.  

 You can perform any of the following actions from this window: 

▪ Sync Now: Syncs the current project based on the selected settings. 

▪ Advanced Settings: Enables you to perform advanced editing of the sync 

settings (see Advanced Sync Settings). 

▪ Remove Sync: Removes the selected sync settings. The project will no 

longer be synced to the family site. You can also temporarily disable the 

syncing from the Advanced Settings. 

▪ Sync with a Different site: Enables you to select another of your family 

sites or create a new site to sync this project to (see Sync with a Different 

Site). 
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Advanced Sync Settings 

The following describes the fields in the Advanced Sync Settings window: 

 

 Disable sync to [family site name]: Disconnects the link between the Family 

Tree Builder project and the online family site. This means that any changes 

made in Family Tree Builder are not synced to the family site, and any changes 

made in the family site are not synced to Family Tree Builder. This feature is 

useful when you have multiple projects for which you have enabled automatic 

syncing. It allows you to disable syncing to a specific project, without 

disrupting syncing to all the others. 
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 People to upload: Selects the people in the family tree that you want to be 

synced. This option is particularly useful when you have a large project that 

describes multiple families and you would like to create different family sites, 

with each describing a different family: 

▪ All people in Project: Specifies that all the people in your project will be 

synced to your family site. 

▪ Specific people selected below: Specifies that only the people who you 

select will be synced to the family tree on your site. When you click the 

Select People button, a window is displayed enabling you to select any 

combination of people in your project. This window also gives you the 

option to specify whether the ancestors, descendants and/or spouses of 

the people that you select are included. 
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Click Add to display the Add Person to Upload window, which lists people 

in your project who you can select. 

 

You can use the Quick Find area to locate a person according to first 

and/or last name. You can also filter the list to display only males, 

females and/or unknowns. 

NOTE Click a column header to sort the list according to this column 

in ascending order. 
 

When you finish, click Select. 

By default, a person is added with his/her descendants and spouses. You 

can add ancestors to the list or remove anyone. You can also change the 

selection altogether. In the Select People to Upload window, click Edit to 

display the Edit Selection in Sync Request window. 



Syncing Your Family Tree 

Family Tree Builder User’s Guide 
 

- 383 - 

Check any option to include it or click Select to display the Select Person 

in Request window, where you can select a different person for the 

syncing requests. 

 

When you finish, click OK to close the window. 

 Photos to upload: Select photos in the selected project to be synced to your 

family site, as follows: 

▪ All Photos: Syncs all the photos in your project to your family site. 

▪ No Photos: Syncs none of the photos in your project to your family site. 

▪ Photos associated with selected people: Syncs all photos for the people 

specified for syncing, regardless of the People to Upload setting. 
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▪ Specific photos selected below: Syncs only the photos that you select. 

Click the Select Photos button to pick which photos you want to sync. 

When you click the Select Photos button, the following window is 

displayed, enabling you to select photos in your project: 

 

The Select area in the Select Photos to Upload window contains two 

options, as follows: 

 Select photos: This option displays photos for your selection. You can 

use the dropdown menu above this box to display All photos, Photos 

not selected to be uploaded or the Home person's photos only. Once 

you have displayed the requested photos in this list box, you can click 

on them, and then press the Select button to move them to the 

Selected Photos area on the left. This list box indicates which photos 

will be synced to your site. 

 Browse selected photos: Select this option to browse the photos 

listed in the Selected Photos area on the left. You can use the arrow 

keys on your keyboard to move up and down the list. 

The Format and View areas enable you to specify how photos appear 

when you select the Browse selected photos option. The options in these 

areas are described in detail in Photos Display Options. 

Click OK after you have selected all the photos you want synced to your 

family site. 



Syncing Your Family Tree 

Family Tree Builder User’s Guide 
 

- 385 - 

Sync with a Different Site 

The default site for syncing a project is selected when you create a new project. 

You can set your project to be synced to a different site at any time. 

To sync with a different site: 

1 In the Sync Settings window, click Sync with a different site to display the 

Define Sync Settings window. 

 

2 Perform one of the following actions: 

▪ Select the Synchronize this Project with a new family site radio button to 

enter the name for the new family site or select a name from the dropdown 

list of suggestions. 

▪ Select the Synchronize this Project to one of your existing family sites 

radio button and then select one of the sites in the panel. 

▪ Click the Advanced Settings link to open the Advanced Sync Settings 

window and change the sync settings. 
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▪ Click the Family Sites Benefits link to learn about the benefits of syncing. 

This window describes all the Family Tree Builder features that work only 

when syncing a family tree project to a family site, as well as the benefits 

of having a family site. 

 

3 When you finish, click OK to close the window. 
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User Permissions 
Once you have synced your project to a family site, you can edit the user 

permissions, and control who can download your tree from the family site, and 

who can edit it online. 

You can change these settings at any time: 

 

To set user permissions: 

1 In the Sync (publishing) menu, select User Permissions. The Edit tree 

permissions window is displayed: 

 

2 Choose whether you want other site members to be allowed to download the 

tree file. 

3 Specify who can edit the tree online: all site members, all site managers or 

only you. 

4 Click the Save button to save changes. 
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Managing Your Family Sites 
As a MyHeritage member, you can create one or more family sites on 

MyHeritage.com. 

The process of creating a family site only allocates a name and a space for your 

family tree. The syncing process can be used later to upload your project to the 

family site. 

A member of MyHeritage is identified by an email address entered during the 

registration process. 

The My Sites window displays the details of the MyHeritage member name you 

used when signing up for membership, after you installed Family Tree Builder. 

You can sign in as a different member if you are registered under more than one 

email address or if you changed your email address in your member profile page 

in the MyHeritage.com website. 



Syncing Your Family Tree 

Family Tree Builder User’s Guide 
 

- 389 - 

To see your family sites: 

 Select the My Sites option in the Sync (publishing) menu to show your list of 

family sites, as shown below: 

 

 When you select a family site, its details are displayed at the bottom of the 

window. 
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To sign in as a different member: 

1 In the My Sites window, click Log In in as a different member to open the Log 

into MyHeritage.com window. 

2 Enter the email address and password you used when you registered with 

MyHeritage.com. 

 

3 Click Log in. The My Sites window now displays the sites for your new 

account. 

NOTE If you do not remember the password of your MyHeritage.com 

account, click Forgot password?. An email will be sent to your 

email account with instructions about how to reset your password. 
 

To visit a site: 

 You can visit a family site by clicking the Visit Site link in the My Sites 

window. 

 Anyone with an email address can be invited to be a member of your family 

site. Anyone who accepts your invitation automatically becomes a member of 

MyHeritage. 
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To invite people to visit your family site: 

 You can invite people to visit your family site by clicking the Invite members 

link in the My Sites window. This displays the following window: 

 

 The top panel includes a form for new family members who you want to invite 

to the family site. This panel displays all family people in your family tree for 

whom you already entered an email address in the Edit Person window, and 

who are not yet members of the family site. To add new family members, type 

in their first name, last name and email address. When you click the Send 

Invitations button, all the people listed in this panel are invited to your family 

site. 

 The bottom panel (which can be hidden or shown) displays current members 

of the family site. People you invited previously, but who have never visited 

the site, have a Re-invite Member link next to their email address. Click this 

link to add these people to the list at the top of the window. This is the list of 

people who will be invited when you click the Send Invitations button. 

NOTE If Your own name is shown in bold. 

 



Syncing Your Family Tree 

Family Tree Builder User’s Guide 
 

- 392 - 

Using the Family Site Menu 

Family Tree Builder is seamlessly integrated with your online family site. The 

Family site menu enables you to view parts of your online family site in Family 

Tree Builder, instead of in an external web browser. 

In order to use the options in the Family site menu, your project must be synced 

with your online family site. Once a project has been synced with your family site, 

the family tree in the project is both viewable and editable on your family site. 

Any changes made to the family tree on the family site are automatically reflected 

in the Family Tree Builder project, thereby ensuring and maintaining bidirectional 

synchronization between Family Tree Builder and the family site. 

An Internet connection is required to use the Family site menu options. 

NOTE Some Family site menu options are only available for Premium or 

Premium Plus memberships (see Premium Membership). 
 

The following options are available in the Family site menu: 

 Family Statistics: Displays statistics for the entire family tree. 
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 Upcoming Events: Displays all upcoming family events in a list or monthly 

view. You can order a personalized family calendar in a few clicks, delivered 

to your home. 

 

 Profile Page: Displays the full profile page from the family site for the selected 

person. When viewing a profile, double-click any person in the list on the left 

to view that person's profile instantly. 
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 Record Matches: Displays all the matching historical records for the family 

tree in one centralized list (see Record Matches). 

 

 Visit Site: Opens the family site’s home page. 
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Family Tree Sync 

One of the major advantages of Family Tree Builder is its ability to sync your 

family tree project to a family site for backup purposes and to enable others to 

view the family tree. The syncing process is performed by a special utility called 

Family Tree Sync. 

Family Tree Sync is a separate application that runs in parallel with Family Tree 

Builder. It can be accessed by clicking the Family Tree Sync icon  in your 

Windows icon tray and choosing Show Sync Progress: 

 

The Family Tree Sync window lists all your projects with their syncing details, 

where and when they were synced and their status. You can follow the progress of 

the current syncing in the progress bar of the window. You can also view a report 

of all syncing activities and link to MyHeritage.com. 
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The following options are available in this window: 

 Enable or disable automatic syncing (see Automatic Syncing). 

 View the progress of the syncing process. 

 Click Synch Now to start syncing the selected project. 

 Click Abort Syncing to stop the syncing process. 

 Click Visit Site to open your web browser to the family site where the selected 

project is synced. 

 Click View Report to see a log of all syncing activities. 

Closing the window does not interrupt the syncing process. 

You can right-click the icon on the Windows toolbar and choose Exit to close the 

Family Tree Sync application. 

  

When you exit Family Tree Builder, Family Tree Sync continues syncing if it is in 

the middle of a syncing process. It closes automatically when syncing is 

complete. 

You can right-click the icon on the Windows toolbar and select Enable or Disable 

Automatic Syncing (see Automatic Syncing). 
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Languages and Translation 
About This Chapter: 

This chapter describes the various language and translation features provided by 

Family Tree Builder. It contains the following sections: 

 Supporting Multiple Languages describes the languages that Family Tree 

Builder supports. 

 Unicode enables you to enter data in any supported language, regardless of 

the local language on your computer. 

 The Virtual Keyboard enables you to enter data in any of the numerous 

supported languages, even when your computer and its keyboard do not 

support or provide the letters of that language. 

 Changing the Display Language describes how to change the display 

language. 

 Primary and Secondary Data Languages describes options for changing the 

data language. 

 Changing the Language describes how to change the language data is 

entered in. 

 Translating in Family Tree Builder describes the various translation options in 

Family Tree Builder. 
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Supporting Multiple Languages 
Family Tree Builder supports 40 languages: Afrikaans, Albanian, Arabic, Bosnian, 

Bulgarian, Catalan, Chinese (Simplified and Traditional), Croatian, Czech, Danish, 

Dutch, English (US and UK), Estonian, Finnish, French, German, Greek, Hebrew, 

Hungarian, Indonesian, Italian, Japanese, Korean, Latvian, Lithuanian, 

Norwegian, Persian, Polish, Portuguese (Brazil), Portuguese (Portugal), 

Romanian, Russian, Serbian, Slovak, Slovenian, Spanish, Swedish, Turkish, 

Ukrainian and Yiddish. 

A list of the supported languages is shown below: 

 

Family Tree Builder supports these languages for the following: 

 Display Language 

 Data Language 
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Display Language 

The Display Language refers to the text that appears in all the menus, toolbars 

and windows in Family Tree Builder. You can select any one of the languages for 

the display and swap this language at any time without losing your data or 

closing the program. An example of the same window in English and in French is 

shown below. 

     

English      French 

Data Language 

The Data Language refers to the language in which the actual data in your project 

is entered and displayed. Family Tree Builder allows you to create a family tree in 

more than one Data Language. Specific facts must be entered in each language 

separately, such as the names of people and places, while the relationships 

between the individuals and the various dates need only be entered once. This is 

because relationships and dates do not depend on a language. 

Entering data in more than language is especially useful when these languages 

do not use the same alphabet, and therefore the data (names, places and so on) 

is different between the two languages. For example, if you have many Russian 

relatives or ancestors, it may be useful to also enter names in Russian. 

TIP The Display Language and the Data Language are independent and can 

be combined in almost any way you like. For example, you can view a 

family tree that was sent to you by a relative that contains all Russian 

data (meaning peoples' names and places), while the Family Tree 

Builder display (meaning menu and field names) is displayed in English. 
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NOTE The only limitation is that the display language and the data language 

must both be in the same direction (right-to-left or left-to right). 
 

 

TIP You can use any of the supported languages even without installing 

them on your PC, including even more obscure languages such as 

Greek. However, your Windows operating system must support a feature 

called Mirroring, which is available as a default in most recent versions 

of Windows, except the old Windows NT 4.0 and some older versions of 

Windows 98. 

 

 

TIP The Display Language and the Data Language are independent and can 

Multi-lingual family trees are great for family reunions! You can create 

and print multi-lingual charts that showcase the same family tree in 

more than one language. 
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Unicode 
Family Tree Builder supports Unicode, which is a computing industry standard for 

the consistent encoding, representation and handling of text expressed in most 

of the world's writing systems. Family Tree Builder’s Unicode support enables you 

to enter data in any of the application’s supported languages, regardless of the 

local language on your computer’s operating system. Such data can be saved and 

displayed in Family Tree Builder, including special characters and accents. 

The Virtual Keyboard 
Family Tree Builder provides a Virtual Keyboard that allows you to enter data in 

any supported language even when your computer and keyboard do not support 

or provide the letters of that language. 

To use the Virtual Keyboard: 

7 Launch the Virtual Keyboard by clicking the Keyboard  icon at the top of 

any page. The Virtual Keyboard of the current data language is displayed as a 

floating window, on top of the other windows. 

As an example, the Russian Virtual Keyboard is shown below: 

 

The Virtual Keyboard self-adjusts automatically, according to the current data 

language settings. 

8 Click a letter on the Virtual Keyboard to enter that letter in the current field in 

the window in which you are working. The letter or character will appear in the 

field in which you were typing. 
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Changing the Display Language 
This section describes how you can quickly change the Display Language of the 

text that appears in all the menus, toolbars and windows. 

To change the Display Language using the toolbar: 

1 Click the flag of the current language that appears on the toolbar. 
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The following window is displayed: 

 

2  Select your language in the window. Family Tree Builder changes the 

language of the program according to your selection. 

3 You can click Advanced language options to display the Languages window 

(see Changing the Language), where you can also set the Primary and 

Secondary Data Languages. 

NOTE If you select English as the display language, an additional option 

appears enabling you to select English (US) or English (UK) as the 

display language (see figure above). 
 

 

NOTE If you select Chinese as the display language, an additional option 

appears enabling you to select Simplified or Traditional. 
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Primary and Secondary Data 

Languages 
While the Family Tree Builder database supports multiple supported languages at 

any given time, you can only add data in one language (single-language mode) or 

two languages (dual-data language mode). Once you enter data in a specific 

language the data is saved in this language. 

NOTE When you open a project, the languages in which the data is saved in 

the database are listed in the Languages used field. 

 

 

When you create a new project, you can choose to work in single-data language 

mode or in dual-data language mode with two data languages: a primary data 

language and a secondary data language. The primary data language determines 

the default language for entering data. The secondary data language is your 

alternative data-entry language and is optional. 

NOTE You may change these settings at any time. However, it is recommended 

that you use English as one of the data entry languages, especially if 

you are publishing your project to a family site. 
 

At any time, you can change the display language as well as the Primary and 

Secondary Data Languages. The Primary Data Language is the language in which 

you want to enter data like names of people and places, notes and so on. If you 

define a Secondary Data Language, then Family Tree Builder works in dual-

language mode and data entry pages are bi-lingual. If you do not define a 

Secondary Data Language, then the program works in single-data language mode 

and all pages only accept data in the Primary Language. 
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The following shows an example of single-data language mode and dual-data 

language mode, where English is the primary data language and Spanish is the 

secondary data language: 

   

           Single Data Language Mode        Dual Data Language Mode 

By default, Family Tree Builder works in single-data language mode. If you want to 

work in dual-data language mode, select Languages from the Tools menu on the 

toolbar and check Use Secondary Language. 

TIP By default, Family Tree Builder is configured so that the Primary Data 

Language is the same as the Display Language. This means that upon 

changing the Display Language, you are also instructing the program to 

change the Data Language to match it. It is recommended that you open 

the Languages window and make sure that the languages you want are 

configured to your liking. 
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Changing the Language 
The following procedure describes how to change the Display Language and how 

to modify the Primary and Secondary Data Languages. 

To change the language settings: 

9 From the Tools menu on the toolbar, select Languages. The Languages 

window appears: 
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10 To change the Display Language, in the Display Language panel, click Change 

Language. The Select Display Language window appears: 

 

3 Select the display language. Note that if you select English, an additional 

selection enables you to choose between English (US) and English (UK). If 

you select Chinese, an additional selection enables you to choose between 

Simplified and Traditional. Click OK to confirm and close the window. 

4 If you want the Primary Data Language to be different from the Display 

Language, uncheck Same as Display Language, and in the Primary Data 

Language panel, click Change Language to select the primary data language. 

5 If you want to work in dual-language mode, check Use Secondary Language, 

and in the Secondary Data panel click Change Language to select the 

secondary data language. 

6 Click OK to confirm and close the window. 

TIP If you change the Primary Data Language of an existing project, then the 

words Unknown or Empty may appear in place of the data that you have 

already entered. 
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Translating in Family Tree Builder 
If you are working in dual-data language mode, you can enter data directly in both 

languages in the easy-to-use dual-language interface, which provides the fields in 

one language on the right and in the other language on the left, as shown in the 

example below: 

 

Family Tree Builder has a database of common translations of names. This 

enables automatic name translation for places and people in the various entry 

windows. Family Tree Builder also gathers information as you edit your project 

and accumulates all your manual translations into its database so that in the 

future it can translate these same words automatically, as described below. 
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Family Tree Builder enables you to translate: 

 All project data. 

 All the data in the current window. 

 The data in a specific field. 

Translating All Project Data 

By default, Family Tree Builder asks if you want to translate the data from the 

Primary Language to the Secondary Language. 

To translate all project data: 

11 In the Tools menu, select Translation Wizard. The following window is 

displayed: 

 

12 Under Translate from: (source language), click Change language and select 

the source language. Data will be translated from this language. 

3 Under Translate to: (target language), click Change language and select the 

language to which data will be translated. 
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4 When you are done, select the source and target languages (in the example 

above, from English to Spanish), and click OK. 

5 Check the Override existing translations checkbox it you want data that has 

already been entered in your project in the target language to be overwritten 

by translations of the data in the source language. 

6 Click Next to begin the translation. After the translation is complete, the 

following window is displayed: 

 

This window shows the number of first names, last names and place names 

that have been translated from the source to the target language and the 

number of fields that remain untranslated in the target language. You may 

click the Report button to store these translation results in a file for your 

review. 

7 Click Next to display a window that lists the names and places that have not 

been translated, which allows you to manually translate them. 

8 Click any field to type in the translation. 

9 Click Next to apply your manual translations to your project. 
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Translating the Current Window’s Data 

Family Tree Builder can translate all the data in the current window from the 

Primary Language to the Secondary Language, or vice versa. 

To translate all the data in the current window: 

 In the Dual Interface window, click the arrow button that is pointing to the 

language into which it should be translated. It appears between the two 

language headers, as shown below: 

 

 The arrow buttons are enabled when Family Tree Builder recognizes that it 

knows how to translate data in this window. If Family Tree Builder knows how 

to translate any data in this window, the arrow is disabled, meaning that it is 

gray and you cannot click it. After you manually translate untranslated 

fields, Family Tree Builder remembers your translation and can perform 

automatic translations in the future. 

NOTE The direction of the arrow button that you click determines the 

direction of the translation. 
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Translating a Specific Data Field 

Family Tree Builder can attempt to translate a specific field in the window that is 

currently displayed. 

To translate data in a specific field: 

 In the Dual Interface window, click the arrow button that is pointing to the 

language into which it should be translated. It appears between the two 

fields, as shown below: 

NOTE The direction of the arrow button that you click determines the 

direction of the translation. 
 

 

 This example shows how the name John has been translated into Spanish. 
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Advanced Tools 
About This Chapter: 

This chapter describes the advanced tools available in Family Tree Builder. It 

contains the following sections: 

 Configuring Family Tree Builder provides a variety of configurable options. 

 Managing Sources and Repositories describes the tools for managing 

genealogical sources and repositories. 

 Importing/Exporting Family Tree Builder Data describes importing and 

exporting data from Family Tree Builder to an Excel spreadsheet and back 

again. 

 Backing Up a Project describes how to create a backup copy of a Family Tree 

Builder project. 

 Restoring a Project describes various methods for restoring a project in 

Family Tree Builder. 

 Checking for Deceased People describes the Family Tree Builder tool that can 

search for deceased people in your project, who are not marked as such in the 

project. 

 Finding Duplicates in the Family Tree describes how to identify duplicated 

people in your family tree. 

 Privacy Settings describes how to privatize information in your project so that 

it is not synced to a family site. 
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Configuring Family Tree Builder 
Family Tree Builder provides a variety of configurable options. Each of these 

options is described in the window shown below. This section provides a general 

explanation of how to customize your settings. 

To configure Family Tree Builder: 

1 Click Options in the Tools menu to display the following window: 

 

 

 

2  Simply click an option in the list on the left to display a list of configurable 

options on the right. 

 



Advanced Tools 

Family Tree Builder User’s Guide 
 

- 419 - 

3  Each row on the right enables you to customize a different option. The left 

column is the name of the option and the right column is the setting. Clicking 

a row shows a description of the setting at the bottom of the window. It also 

may add a small icon to the right of the settings column, as shown in the 

examples below. See Configuration Options for more details about each of 

the options in the left column of the window. 

AutoRecovery 

You can customize how often your project is automatically saved. Select Save 

AutoRecovery information to display the  icon. Click the up arrow to save 

less often, or click the down arrow to save more often. You can also enter any 

number with your keyboard. 

 

Projects Directory 

When you click Projects directory, the Browser button  appears. Click it to 

open a window from which you can select a folder. This folder is where all of 

your projects are stored on your computer. 
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Program Startup 

When you click When program starts, a dropdown menu appears from which 

you can select an option. This enables you to choose what happens when you 

start Family Tree Builder. 

 

Configuration Options 

The following branches and their settings can be configured in the Options 

window: 

 General: Configures general options that affect the behavior of Family Tree 

Builder. 
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 Names: Configures various options for showing names in your project, as well 

as how to create and format new names for people in your project. 

 

 Display: Configures various options for the way that Family Tree Builder looks, 

such as colors, graphics and so on. 
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 Warnings: Configures different thresholds for warnings that are issued by 

Family Tree Builder when the threshold is violated. 

 

 Photos: Configures various options for handling photos in Family Tree Builder. 

 

 Dates: Configures various options for formatting dates in Family Tree Builder. 
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 Smart Matching: Configures various options for Smart Matching in Family Tree 

Builder. 

 

 Sync: Configures various options for syncing in Family Tree Builder. 

 

 Maps: Configures various options for handling maps in Family Tree Builder. 
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Managing Sources and 

Repositories 
Family Tree Builder supports the full GEDCOM specification relating to sources, 

repositories, notes and citations. A source is the initial or original material from 

which information was obtained. Sources can be a variety of entities, such as a 

Bible, a book, a newspaper clipping, a tombstone photo, a transcript of an 

interview, a letter and so on.  

A source can also be a specific family site on MyHeritage.com. The citation is the 

reference to the specific place in that source that verifies the relevant information 

in the family tree. Citations can include specific clarification notes that can be 

synced together with the information or not. 

Sources can be stored in repositories. A repository is an institution (library, 

private collection, database and so on) or person that has the specified source as 

part of their collection. Attributing a source to a repository tells you how to access 

the source that the original researcher used, or reminds you where you found a 

source. 

Managing Sources 

Through the Manage Sources window, you can view a list of all sources 

referenced in your project, add or remove sources from a project and edit source 

information. You can also add source notes that can be private or synced to your 

family site (see Notes Tab – Defining Notes). 
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To display the Manage Sources window: 

1 In the View menu, select Sources to display the Manage Sources window: 

 

2 Here, you can manage your sources, as described below. When you are 

finished, click Done to close the window. 

Adding a Source 

The first step when creating a new citation is to specify the source that this 

citation references. If the source has not yet been added to this project, you need 

to add the source. 
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To add a new source: 

1 In the Manage Sources window, click New Source to display the Add New 

Source window: 

 

2 In the Title box, type a name for the new source. 

3 In the other boxes, add relevant source information, such as the abbreviation, 

author, publisher and so on. 

4 Click Source Notes to add source notes, which can be synced or kept private 

(see Notes Tab – Defining Notes). 

5 Click Source Photos to open the Manage Photos of Source window in which 

you can define the photos and media for the source. 
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6 You can also add repository information. Select the relevant repository from 

the Repository dropdown list. If the repository you want to attribute the 

source to is not in the project, you need to add it (see Adding a Repository). 

Once you add a repository, you can also add a library call number for it. 

7 When you finish entering your information, click OK. 

8 Click Done to close the Manage Sources window. 

NOTE You can change the source information at any time by selecting the 

source in the Manage Sources window and clicking Edit Source. You can 

also click Delete Source to delete the source from the project. 
 

Viewing Source Usage 

You can view a list of all the citations that reference a specific source. 

To list citations that reference a specific source: 

1 In the Manage Sources window, select the source for which you want to list 

citations. 

2 Click Source Usage to display the Source Usage window, which lists all of the 

source citations: 
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3 Click View to display the citation. 

4 Click Done to close the window. 

You can also save the list of sources in your project as an Excel file by clicking 

Save to File. 

Managing Repositories 

When entering information describing a source, you can specify the repository 

(such as the name of a library or database) where the source is located. If the 

repository has not yet been added to this project, you need to add it. You can 

view a list of all the repositories in a project, add or remove repositories and edit 

repository information. 

To display the Manage Repositories window: 

1 In the View menu, select Repositories to display the Manage Repositories 

window: 

 

2 Make any necessary changes, and when you are finished, click Done to close 

the window. 
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Adding a Repository 

When adding a repository, you can add information such as addresses and 

contact information. You can also add notes that can be private or synced to your 

family site (see Notes Tab – Defining Notes). 

To add a new repository: 

1 In the Manage Repositories window, click New Repository to display the Add 

New Repository window: 

 

2 In the Name box, type a name for the new repository. 

3 Click Repository Notes to add repository notes, which can be synced or 

private (see Notes Tab – Defining Notes). 
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4 In the other boxes, add relevant repository information, such as addresses, 

contact information and so on. 

5 When you finish, click OK. 

NOTE You can change the repository information at any time by selecting the 

repository in the Manage Repositories window and clicking Edit 

Repository. You can also click Delete Repository to delete the 

repository from the project. 

 

Viewing Repository Usage 

You can see a list of all the sources of a specific repository in the project. 

To list the sources of a specific repository: 

1 In the Manage Repositories window, select the repository for which you want 

to list sources. 

2 Click Repository Usage to display the Repository Usage for [Repository Name] 

window, which lists all the sources for that repository: 

 

3 Click Done to close the window. 
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Importing/Exporting Family Tree 

Builder Data 
Family Tree Builder enables you to export specific data to an Excel spreadsheet. 

You can export the following lists: 

 A list of all people in the project. 

This includes the following information for each person (if available):  

Gender (male/female/unknown), first name, last name, married name, date of 

birth, place of birth, date of death (? if not known), place of death, cause of 

death, place of burial, occupation and notes. 

 A list of all families in the project. 

This includes the following information for each family (if available):  

Husband's ID, husband's first name, husband's last name, wife's ID, wife's 

first name, wife's maiden name, wife's married name, date of marriage, place 

of marriage, marriage status and notes. 

 A list of photos in the project. 

This includes the following information for each photo (if available): Title, 

date, place, file name and notes. 

 A list of sources in the project. 

This includes the following information for each source (if available): Title, 

abbreviation, author, publisher, agency and text. 

 A list of tasks in the project. 

This includes the following information for each task (if available): Title, 

description, priority, location and status. 

 A custom report. 

This includes selected people and information about these people to report. 

After you export the list, you can use Excel’s convenient table format to edit the 

information and import it back into your project. The new information overwrites 

the existing information. 
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To export to Excel: 

1 In the Edit menu, select Export to Excel. 

 

2 From the sub-menu, choose the list or item you want to export: 

▪ List of people: Exports personal information about the people in the 

project. 

▪ List of families: Exports information about families in the project. 

▪ List of photos: Exports the list of photos in the project. 

▪ List of sources: Exports the list of sources for the project. 

▪ List of tasks: Exports the list of tasks for the project. See To-Do Tasks. 

▪ Custom report: Exports a custom report about people in the project. See 

Export Custom Report. 

The Save window is displayed: 
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3 By default, the report is saved in the Reports folder of your project. If you want 

to change that, find the location where you want to save the file and click 

Save. A Family Tree Builder message window appears, notifying you that a 

CSV file has been created. 

4 Click OK to confirm. Microsoft Excel opens with the newly created file. 

5 You can now store the file for your records or make any required changes. 

When you edit the file, you may get a message that the file may contain 

features that are not compatible with CSV. Click Yes to keep the format. 

6 When you finish, save the CSV file. 

To import a CSV file to Family Tree Builder: 

NOTE You can only modify the people, family and photos report that was 

created by an Export to Excel operation and import it back into the 

project. Sources, tasks and custom reports cannot be imported by 

Family Tree Builder. 

 

1 In the Edit menu, select Import from Excel. The Select file to import window is 

displayed: 

 

2 Find the CSV file you want to import and click Select. A Family Tree Builder 

message window opens, informing you of the number of items 

(people/families/photos) that were successfully imported. 

3 Click OK to confirm and close the window. Family Tree Builder now includes 

the information from the CSV file. 
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Backing Up a Project 
You can back up a Family Tree Builder project for safe keeping. A project backup 

file can later be used to restore a project in Family Tree Builder. 

It is highly recommended that you back up your projects regularly. 

NOTE Family Tree Builder also automatically creates a backup of your project 

whenever it detects a need to do so, such as when you are making a 

significant change from a previously saved project version or before 

performing a restore operation. 

 

To back up a project: 

1 In the File menu, select Back Up Project to display the following window: 
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2 Select the Back up to file on the disk radio button and click Next to display 

the following window: 

 

3 [Optional] Enter a description for the backup file. 

4 By default, the backup is created in the Backup folder of your project. If you 

want change this location, specify the path where the backup is to be stored. 

5 Check the Include photo files in backup checkbox if you want the project’s 

photos to be part of the backup. If you have many photos, the backup takes 

longer and creates a larger backup file. 
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6 Click Next. The following window opens, displaying the location of the project 

backup: 

 

You can click the Open Folder button to view the folder where the backup was 

saved. 

7 Click the Finish button to complete the backup process. 
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Restoring a Project 
You can restore a project in Family Tree Builder using one of the following 

methods: 

 Restoring from a Project Backup File 

 Restoring from an Online Family Site 
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Restoring from a Project Backup File 

This restore operation restores a project from a backup file created for the project. 

Family Tree Builder automatically creates project backups when appropriate, and 

you can also create a backup manually, as described in Backing Up a Project. 

To restore a project: 

1 In the File menu, select Restore Project to display the following window: 
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2 Select the Restore from a file on the disk site radio button and click Next to 

display the following window: 

 

This window lists all your projects along with the available backup files that 

can be used to restore each project. 

3 Select the project you want to restore in the Project dropdown list. 

4 Select the backup file of this project you want to use in the Backup to restore 

dropdown list. Alternatively, you can click the … button to browse to a backup 

file that is stored outside the standard project's Backup folder. 
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5 Click Next to display the following window: 
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6 If you want to restore the backup into the same project, keep the existing 

name in the New project name field. Otherwise, enter a name for the new 

project. If you keep the same name, the current project is backed up before it 

is restored from the selected backup file. Click Next to display the following 

window: 

 

7 Click Finish to complete the restore process. 
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Restoring from an Online Family Site 

This restore option enables you to import data from your MyHeritage.com family 

site directly into Family Tree Builder. This restore feature is ideal when you get a 

new computer and want to move your family tree to it or when you build a family 

tree online and later want to import it to Family Tree Builder. 

NOTE When you install a new version of Family Tree Builder, the application 

automatically searches for your online family trees that are not on your 

computer. If any are detected, then it recommends that you restore 

them into Family Tree Builder. This recommendation is not mandatory. 

You can always import such family trees to Family Tree Builder at a later 

time. 

 

To import an online family tree to Family Tree Builder: 

1 In the File menu, select Restore Project to display the following window: 
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2 Select the Restore from online family site radio button and click Next. The 

Download Family Trees window is displayed: 

 

This window lists all the online family trees that you manage that were either 

synced from Family Tree Builder or created online in the MyHeritage.com 

website. The following information is shown for each family tree: 

▪ The name of the family tree. 

▪ The family site name. 

▪ The number of people in the family tree. 

▪ The number of photos in the family tree. 

▪ The creation source for the family tree: FTB (Family Tree Builder) or online. 

▪ The number of people invited to participate in the family site. 

▪ The date and time when the family tree was last updated. 

▪ Whether or not the family tree exists on your local computer. Yes indicates 

that the family tree exists in Family Tree Builder on your computer. 
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The Restore from online family site mechanism enables you to download a 

family tree that was initially created online at MyHeritage.com directly to 

Family Tree Builder. After an online tree has been downloaded to Family Tree 

Builder in this manner, it is immediately synced. In this way, both the family 

tree project in Family Tree Builder and the family site can be synced. 

3 Select the checkbox for the family tree you want to import to Family Tree 

Builder and then click the Download Now button. You can select several 

checkboxes to download multiple family trees at once. Click the Select all link 

to select all family trees for downloading. 

A progress bar is displayed once the download process begins. 
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Checking for Deceased People 
Family Tree Builder provides a tool that enables you to check your project for 

people who are deceased, but who are not marked as such in the project. This 

operation uses a sophisticated algorithm to seek out such individuals. Once 

identified, you can change the status of a person to deceased, if appropriate. 

To check for deceased people: 

1 In the Tools menu, select Check for deceased people. The following window 

opens at the end of the search process: 

 

This window displays identifying information for the people found in your 

project who may be deceased, as well as Family Tree Builder’s reason for 

making such a determination. 

2 Check the checkbox the person that you want to mark as deceased in your 

project and click OK. The person’s status is updated accordingly in his/her 

profile. 
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Finding Duplicates in the 

Family Tree 
Family Tree Builder provides a tool that enables you to check your project for 

duplicated people. The search operation searches for all kinds of possible 

duplications of people in the family tree with similar names and dates. Once 

identified, a report is displayed, which you can use to determine the appropriate 

action to take for each of the people found. 

To find duplicates in the family tree: 

1 In the Tools menu, select Check for Duplications to display the following 

window: 

 

This window displays a list of people suspected of being duplicated in your 

project. 
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As Family Tree Builder scans your project, it may find people suspected of 

being duplicated. A progress bar at the top of the window displays the 

progress of the scanning process. You may click Stop to stop the scanning, as 

it may take a long time for a very large project. 

After the scanning completes, the window shows all people suspected of 

being duplicates. 

 

The percent in the middle of each row specifies the certainty Family Tree 

Builder calculated for the duplication. The more that data is the same 

between the two people, the higher the certainty. 

2 Click a person's name to view that person's profile. 

3 Click the Restart button to perform the search operation again. 

4 Click the Save to File button to save the duplications report to a CSV file. 

5 Click Done to exit the window. 
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Privacy Settings 
In Family Tree Builder, you can privatize various types of information in your 

project, such as people, notes and facts. You can mark a specific person with a 

privacy flag, which means that information about this person is not synced to a 

family site. You can also mark certain types of information as private, such as 

notes, facts and citations. Any information marked as Private is not synced to a 

family site. 

When editing a piece of information, you can mark it as private. For example, in 

the More tab of the Edit Person window, you can mark a person as private, in the 

Edit Fact window you can mark a fact as private and in the Edit Note window you 

can mark a note as private. In addition, the Advanced Privacy Settings tool 

provides a centralized place where you can see all the information that is marked 

as private, thus giving you greater control in the project. This tool also enables 

you to define fact types that are private throughout the project, so that this type 

of fact is never synced for anyone who has such a fact of this type. 
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To privatize information in your project: 

1 In the Tools menu, select Advanced Privacy Settings to display the Advanced 

Privacy Settings window: 

 

The Advanced Privacy Settings window provides a summary of all information 

that is marked as private in your project. Each privatized item is listed in a 

separate row, and shows the type of element involved and to what it relates. 

NOTE The Do not sync private information to online family site checkbox 

is checked by default, which means that information marked as 

Private is never published to a Family Site. This setting cannot be 

changed. 
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You can use this window to mark the following types of information as private 

in your project: 

 

NOTE Privacy can also be marked as Private from other places in Family 

Tree Builder, such as notes from the Notes tab of a person’s card, 

citations from the Citations tab of a person’s card and so on. 
 

▪ Person: Click the Add button, select Add person in the dropdown list and 

then select the person to be marked as Private. When the person is 

marked as private, a lock icon is shown in the person’s card, indicating 

that the person’s information is private. 

 

▪ A fact about a person: Click the Add button and select Add person’s fact 

in the dropdown list. In the window that opens, select the person and 

then select the fact to be marked as Private for the person. In this case, 

when syncing, information for the person is synced to the family site, but 

not this fact. 

▪ A note about a person: Click the Add button and select Add person’s note 

in the dropdown list. In the window that opens, select the person and 

then select the note to be marked as Private for the person. In this case, 

when syncing, information for the person is synced to the family site, but 

not this note. 
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▪ A fact about a family: Click the Add button and select Add family’s fact in 

the dropdown list. In the window that opens, select the family and then 

select the fact to be marked as Private for the family. 

▪ A note about a family: Click the Add button and select Add family’s note 

in the dropdown list. In the window that opens, select the family and then 

select the note to be marked as Private for the family. 

▪ A note about a source: Click the Add button and select Add source’s note 

in the dropdown list. In the window that opens, select the source and then 

select the note to be marked as Private for the source. 

▪ A fact that applies to everyone in your project: Click the Add button and 

select Add fact for everyone in the dropdown list. The following window is 

displayed in which you select the fact to mark as Private: 
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Select the fact type and click OK. In the example below, the Will fact was 

marked as private for everyone, so it is never synced to the family site. 

 

NOTE Social Security Number and ID Number are always marked as 

Private. This setting cannot be changed. 
 

2 [Optional] Select the Hide privatized information in charts and reports 

checkbox if you do not want Private information displayed in charts and 

reports. Check this option if you want to create a chart or a report that hides 

private information. 

3 Click the Done button to save your privacy settings and exit the window. 
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Performing Data 

Consistency Checks 
The Family Tree Builder Consistency Wizard enables you to search for and identify 

potential consistency issues in your data, in order to perform a sanity check on 

your data. When the wizard finds an issue, relevant information is provided to aid 

you in correcting the detected inconsistency. You can run the Consistency Wizard 

as many times as needed. The goal is to handle all inconsistencies so that your 

data is clean and error-free. 

For example, consistency checks are performed by the wizard to check for issues 

such as the following: 

 Consistent spelling of names (for places and people). 

 The minimum age difference between parents and children. 

 The minimum age difference between siblings. For example, an age difference 

of less than nine months between siblings shows as a warning. 
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To perform a data consistency check: 

 In the Tools menu, select Tree Consistency Checker. Family Tree Builder 

scans your data for consistency issues, during which a progress window is 

shown. At the end of this process, the following window is displayed: 

 

 

 Each identified consistency issue is shown in a separate row in the window. 

Each row contains an indication of the inconsistency severity (Error, Warning 

or Notice), the type of the check (and number), the logic or reason for 

identifying the issue as a potential problem, the person(s) involved and any 

relevant photos. 

 The severity of an issue can be any of the following: 

▪ Error: Indicates that the issue is obviously incorrect. Errors are shown with 

a red icon. 

▪ Warning: Indicates a problem where data is probably incorrect. 

▪ Notice: Indicates a potential problem that you may want to check further 

to determine the data’s correctness. 

Configuration Links 
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 In the Tree Consistency Checker window, you can perform the following 

actions: 

▪ Fix issue: Click the Fix it link or the icon for each issue in the list to 

open the relevant window in Family Tree Builder, in which you can fix the 

issue that was found. 

▪ Ignore issue: Click the Ignore icon to mark that this issue is not an 

error. Family Tree Builder then asks if you want to ignore this specific 

issue or all issues of this type. 

▪ Configure: Click the Configure link at the top of the window to open the 

Tree Consistency Configuration window, in which you can enable/disable 

the various checks performed during the consistency check. 

 

The Tree Consistency Configuration window lists all the types of checks 

that Family Tree Builder performs on your data. You can uncheck the ones 

that you do not want to perform and then click OK. Click Warning 

Thresholds to configure the threshold for some of the warnings. For 

example, you can set the maximum age difference between spouses. 
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▪ Refresh: Click the Refresh link at the top of the window to run the 

Consistency Wizard again. Use this option after you have made some 

changes to your data. 

▪ Reset ignored issues: Click the Reset ignored issues link at the top of the 

window If you have previously ignored issues and you want to reset then 

to appear in the list: 
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